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Introduction

Installing and upgrading IBM® OpenPages® GRC Platform by using the OpenPages
Administrative Console requires administrators have specific skills. Administrators
must have a background in operating systems administration, application server
management, relational database management, systems security management, and
other aspects of systems management.

Installation and upgrade documentation

The instructions that you use to install or upgrade IBM OpenPages GRC Platform
depends on your environment. Use the following table to find the right installation
information for your installation environment.

Table 1. Installation and upgrade documentation based on installation environments

Operating | Application Installation

System Server Database | Type Document title

AIX® WebSphere® | DB2° New Deploying to WebSphere Application Server
Installation Guide

AIX WebSphere | Oracle New Installation Guide
Installation Guide with Database

AIX WebSphere | Oracle Upgrade Upgrade Guide

Linux WebSphere | DB2 New Deploying to WebSphere Application Server
Installation Guide

Linux WebSphere | Oracle New Deploying to WebSphere Application Server
Installation Guide

Windows WebSphere | DB2 New Deploying to WebSphere Application Server
Installation Guide

Windows WebSphere | Oracle New or Deploying to WebSphere Application Server

Upgrade Installation Guide

Windows | WebLogic Oracle New Installation Guide
Installation Guide with Database

Windows | WebLogic Oracle Upgrade Upgrade Guide

Related documentation

Supplemental documentation is available on the web. Go to the IBM OpenPages
Platform documentation library [[BM OpenPages GRC Platform documentation|
on the IBM support website (http://www.ibm.com/support/

docview.wss?uid=swg27028308).

To find IBM OpenPages product documentation on the web, access the
OpenPages Information Center| (http:/ /pic.dhe.ibm.com/infocenter/op /v6r2m1f0/
index.jsp).

For information about OpenPages phrases and terminology, see the IBM OpenPages
GRC Platform Administrator’s Guide.

For a more detailed explanation of the features and enhancements contained in this
release of IBM OpenPages GRC Platform, see the IBM OpenPages GRC Platform
Release Notes.
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Documentation conventions

To illustrate screen displays, menu items, product displays, information that you
enter, the following typographic conventions are used:

Table 2. Typographic conventions used in this document

Convention Meaning

KEYWORD Keywords of SQL or some other programming languages are
displayed in uppercase letters in a serif font.

italics Variables that represent an object or entity that you replace
with specific information.

<text> Note: To avoid confusion, in some situations, angle brackets
enclose variables.

boldface Names of interface elements (such as icons, menu items, and
buttons) are displayed in boldface.

monospace Information that the product displays and information that you
enter is displayed in a monospace typeface.

> This symbol indicates a menu item. For example, "Choose
Tools > Options" means choose the Options item from the
Tools menu.

The installation directory is the location of product artifacts after a package,
product, or component is installed. The following table lists the conventions that
are used to refer to the installation location of installed components and products.

Important: Directory locations that contain spaces are not supported. Do not
install OpenPages or any software that OpenPages uses into a directory with
spaces. For example, do not install database server, database client, or application
server software into the Program Files directory.

Table 3. Variable notations for installation directories on Windows operating systems

Directory

Meaning

Windows operating system

OP_HOME

The installation directory
where OpenPages GRC
Platform is installed.

C:\OpenPages

Workflow_HOME

The installation location of
Fujitsu Interstage BPM.

C:\Fujitsu\InterstageBPM

ORACLE_HOME

The installation location of
Oracle database software.

ORACLE_BASE\client_software

WebSphere Application
Server is installed.

DB2_HOME The location where the DB2 | C:\IBM\SQLLIB
instance is created.
WAS_HOME The location where the C:\IBM\WebSphere\AppServer

Cognos_HOME

The installation location of
Cognos® Business
Intelligence.

C:\IBM\cognos\cl10_64

JAVA_HOME

The installation location of
your Java™ Runtime
Environment (JRE) or your
Java Development Kit (JDK).

C:\IBM\WebSphere\AppServer\java
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Table 3. Variable notations for installation directories on Windows operating
systems (continued)

Directory Meaning Windows operating system
CC_HOME The installation location of | C:\OpenPages\CommandCenter
OpenPages
CommandCenter.

Table 4. Variable notations for installation directories on AIX and Linux operating systems

Directory

Meaning

AIX and Linux operating systems

OP_HOME

The installation directory
where OpenPages GRC
Platform is installed.

/opt/OpenPages

Workflow_HOME

The installation location of
Fujitsu Interstage BPM.

/opt/Fujitsu/InterstageBPM

ORACLE_HOME

The installation location of
Oracle database software.

/app/oracle/product/11.2.0/db_1

DB2_HOME The location where the DB2 | /home/db2inst1/sql1ib
instance is created.
WAS_HOME The location where the /opt/1BM/WebSphere/AppServer

WebSphere Application
Server is installed.

Cognos_HOME

The installation location of
Cognos Business
Intelligence.

/usr/IBM/cognos/cl0_64

JAVA_HOME

The installation location of
your Java Runtime
Environment (JRE) or your

Java Development Kit (JDK).

/opt/1BM/WebSphere/AppServer/java

CC_HOME

The installation location of
OpenPages
CommandCenter.

/opt/OpenPages/CommandCenter
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Chapter 1. IBM OpenPages GRC Platform components

Use IBM OpenPages GRC Platform to manage risk and regulatory challenges
across the enterprise. OpenPages GRC Platform provides core services and
functional components that span risk and compliance domains. These functional
components include operational risk, policy, and compliance, financial controls
management, IT governance, and internal audit.

The following diagram shows the architectural components for OpenPages GRC
Platform applications. The platform contains the database and key services such as
the security framework and reporting framework, the workflow engine, and
document management. The modules are configurations that sit on top of the
platform.

Solutions L—.R t
Operational General IT Governance Internal Audit eports
Open i Compliance Management HTML/
access Management Management PDF/XSL
web Financial
services Controls Admin ®-e\Veb
AP Management Console clients
Model driven adaptive content platform
o Record types o Reporting and analytics
o Fields o Charts and graphs
Execution engine o Record relationships o Ad-hoc queries
o Field dependencies o Customizable calculations
o Customizable views
Enterprise services I I I I
5 5 Internationalization GPC Repository Workflow Reporting Import
0 J 7
LDAP g 3 Services Export Excel
g § Storage Auditing BPM Cognos Bl
- g ) adapter Engine
- : : XML
Data tier v ) Input /
Output
Document Repository
Repository

Figure 1. OpenPages GRC Platform components

Server topology and installation configurations

Before you install OpenPages GRC Platform, plan the server topology. The number
of computers you use depends on the expected user loads.

A heterogeneous mix of client and server operating systems are supported. For
example, you can install IBM OpenPages GRC Platform applications on a Windows
operating system and install the OpenPages database on Linux or AIX operating



systems. You can also install the OpenPages application server on Linux or AIX
operating systems and install the OpenPages database on a Windows operating
system.

The OpenPages GRC Platform consists of the following components:
* Database server

* Application server

* Reporting server

Use the following guidelines to help you determine your topology:
Two computers

For light user loads, install the OpenPages application and IBM Cognos Business
Intelligence on the same computer as the application server. A second computer
hosts the database server.

This topology is typical in a testing or staging environment. Do not use this setup
in a production environment.

The following diagram shows a test environment that uses two computers for the
OpenPages GRC Platform installation.

Application

client ' and reporting server
IBM OpenPages
GRC Platform

IBM Cognos Business
Intelligence

=
%

Dabase
server

Figure 2. Topology for test environments or light user loads

Three computers

For moderate user loads, use three computers: one database server, one application
server, and one reporting server. Install the OpenPages application on a single
computer with the application server software. The database server software and
Cognos Business Intelligence are each installed on separate computers
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The following diagram shows an installation where the application server,
reporting server and database server are each on separate computers.

client '
d » \
Applicati _
\ sgr?/ga on . Reporting server

IBM OpenPages (IBM Cognos Business
GRC Platform Intelligence

~
x|

A

Dabase
server

Figure 3. Topology for moderate user load

Multiple computers

To scale for heavier user loads, you can scale the OpenPages application vertically
or horizontally. You scale by configuring more nodes. Scaling either vertically or
horizontally requires that you use a load balancer. The load balancer distributes the
incoming requests across the nodes.

To scale vertically, add a node to the same computer. To scale horizontally, add a
node to an extra computer.

The following diagram shows an example of using a web server as a load balancer.
The web server distributes incoming requests to horizontal cluster members.

Chapter 1. IBM OpenPages GRC Platform components 3



Client computer

<=

Load
balancer (web server)

Application Application Application
. server server . server
S S S

~J Server_2: ~J fl Server_1: ~J Server_3:

=

U ‘

Reporting

server Dabase server

Figure 4. Topology for heavy user load

Vertical and horizontal scaling

If required, after the IBM OpenPages GRC Platform installation is complete, you
can add additional OpenPages managed servers. To scale vertically, you can add
an OpenPages application and workflow managed server to an existing cluster. To
scale horizontally, you can add additional OpenPages application and workflow
instances onto an existing OpenPages cluster member.

Load balancing configurations

Load balancing divides the load of incoming client requests across multiple
application servers. The load on each computer is lessened. This configuration
enables the OpenPages application to scale as the number of concurrent users
increases.

The redundancy of the application tier, combined with the redundant hardware,
also provides a path to high-availability for OpenPages.

Clustered OpenPages environments

Server cluster consists of multiple OpenPages application and workflow server
instances that run simultaneously to provide increased scalability.

The server instances that comprise a cluster can run on the same computer or on
different computers. You can add more server instances to the cluster on an
existing computer. You can also add computers to the cluster to host the
incremental server instances.

IBM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide



The OpenPages repository

The OpenPages database is a central source for metadata management, versioned
application data, and access control.

The OpenPages application requires a set of database users and a tablespace, called
the OpenPages database schema. You install these database components
automatically during the OpenPages application installation or manually by using
SQL scripts. Both the scripts and the installation program create and configure all
of the required elements.

Oracle database software

An Oracle database is used for the OpenPages GRC Platform repository. You can
use an Oracle database instance for the OpenPages GRC Platform repository

You must obtain the Oracle database and client software from the vendor. Install
the Oracle database and the Oracle Client and also create a database instance. You
must install the Oracle database before you install the OpenPages application.

DB2 database software
You can use a DB2 database for the OpenPages GRC Platform repository.

Before you install the OpenPages application, you must install the database server
and client software, and create the database instance for the OpenPages repository.

Two DB2 database instances are required. One database instance for the
OpenPages repository with Oracle compatibility enabled and one database instance
for the Cognos content store without Oracle compatibility mode enabled.

Application server software

An application server is required to host the OpenPages applications. The
application server runs the application modules, and includes the definition and
administration of business metadata, UI views, user profiles, and user
authorization.

The application server software must be installed before you install the IBM
OpenPages GRC Platform components.

Use WebSphere Application Server as the application server.

OpenPages workflow server

OpenPages workflow server provides automated workflow capabilities to ensure
consistent execution of business processes. Fujitsu Interstage BPM is installed as
part of the OpenPages application server installation.

OpenPages workflow technology automates GRC processes, enabling companies to
focus their resources on the gray areas of business where critical human decision
making is required. Automation can help optimize the flow of risk and compliance
activities.

Chapter 1. IBM OpenPages GRC Platform components 5



Cognos Business Intelligence

IBM Cognos Business Intelligence provides executive dashboards and reports
designed to accelerate review and approval of governance, risk, and compliance
management (GRCM) information throughout the enterprise.

Business users can browse through complex information easily by clicking
dashboard elements to drill down through detailed reports.

Content store database

The content store is a relational database that contains data, such as report
specifications, published models, and the packages that contain them. The content
store also contains connection information for data sources.

Important: If you use a DB2 database server product, you must use two separate
database instances for the content store and the OpenPages databases.

Note: For the best performance if you use Oracle database server, use two
separate databases for the content store and OpenPages database.

CommandCenter

6

The IBM OpenPages CommandCenter deploys the framework generator, the
OpenPages security provider, creates the OpenPages data sources, and imports the
standard OpenPages report packages.

IBM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide



Chapter 2. Upgrading OpenPages GRC Platform

To take advantage of new features, enhancements or performance improvements,
upgrade existing versions of IBM OpenPages GRC Platform.

Upgrade your system in phases. Follow these basic steps:
1. Prepare the system for upgrade.

Before you upgrade, you must back up the OpenPages database and
application files and directories. Back up configuration files, reports, and the
IBM Cognos BI content store database.

2. Upgrade the database schema.

You can manually upgrade the OpenPages database schema by running SQL
scripts. Otherwise, you use the installer to automatically upgrade the database
schema.

3. Upgrade the OpenPages application and workflow servers.

Run the upgrade installer on all computers in your environment. Upgrade the
administrative server and workflow server, and then all non-administrative
servers. You can choose to automatically update the database schema.

In a horizontal clustered environment, install the upgrade on the administrative
server first, and then on all non-administrative servers.

You can run the upgrade installation multiple times to repair upgrade issues.
4. Complete post installation tasks.

Some post installation tasks are required. Others, such as revoking the FORCE
ANY TRANSACTION privilege, are optional.

Upgrade paths

You can use the upgrade deployment option in the OpenPages Administrative
Console to upgrade from IBM OpenPages GRC Platform version 6.2.0 to version
6.2.1.

The IBM OpenPages GRC Platform upgrade installer verifies the version of
OpenPages that is installed on your system. If the prerequisite version is not
installed, the upgrade installer does not proceed.

When you upgrade the OpenPages software, the same version of Cognos Business
Intelligence is used.

Additional setup is required after you upgrade if you decide to upgrade the
version of WebSphere Application Server. For more information, see the
[Application Server Information Center| (http:/ /pic.dhe.ibm.com/infocenter/
wasinfo/v8r5/index.jsp).

Preparing to upgrade

Before you upgrade, prepare your OpenPages environment.

Ensure that the following conditions are met on all of your servers:
__+ The PATH environment variable contains the location of the javaw.exe file.
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The IBM OpenPages GRC Administrative Console requires a Java Runtime
Environment (JRE).

Tip: You can use the JRE that is associated with WebSphere Application
Server (path\WebSphere\AppServer\java\bin).

e Ensure that there is network access to the server that hosts the Oracle

database by using the TNSPING or SQL*Plus.

* Ensure that the required users and groups exist and that they each have the

appropriate permissions for installing applications.

* On Windows operating systems, enable Data Execution Prevention (DEP) in

Microsoft Windows Server for essential Windows programs and services only.

* Ensure that you have access to the Microsoft Registry Editor (regedit.exe).

* If you use multiple network interfaces, ensure that all of the IP addresses and

host names are listed in the Windows hosts file

* [Review the IBM OpenPages GRC Platform supported software environments|

and other system requirements|

Backing up directories and files for a rollback on the
application server computer

To uninstall the IBM OpenPages GRC Platform upgrade and revert to the previous
level, you must back up directories and files. These directories and files are
required for the uninstallation and rollback process.

Before you begin

If the following services are running, stop them:

* OpenPages application and workflow services (WebSphere Application Server

nodes)

* OpenPages Framework Model Generator service

* IBM Cognos services

Procedure

1.

Create a backup directory in a location that is different from the installation
location.

C:\OpenPagesBackup.

Log on to the application server as a user with administrative privileges and
full access to the local server drives.

Go to the OP_HOME installation directory and copy the following directories to
the backup location:

e applications

* aurora

* bin

* openpagesregistry.xml

To back up the Interstage BPM directory, copy the Workflow_Home installation
directory to the backup location.

The default installation location is C:\Fujitsu\InterstageBPM.

Log on to the reporting server as a user with administrative privileges and full
access to the local server drives.

To back up CommandCenter directories and files, on the reporting server, copy
the following directories and files from the CC_Home to the backup location:

8 1BM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide
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* apache-tomcat

* tools\bin

* openpagesregistry.xml
Related tasks:

(Chapter 11, “Starting and stopping OpenPages servers,” on page 121|

IBM OpenPages GRC Platform runs only if all of the services are started. All of the
services for supporting software, such as the database server and Cognos Business
Intelligence, must also be running.

Backing up the existing OpenPages GRC Platform
environment

Run the OPBackup and OPCCBackup utilities to back up the existing IBM
OpenPages GRC Platform environment.

The OPBackup and OPCCBackup utilities backs up the OpenPages database and
application and the CommandCenter content store and files.

Procedure

Important: For complete information, including prerequisites, about backing up
your environment, see the IBM OpenPages GRC Platform Administrator’s Guide.

1. Run the OPBackup utility.
* If you want to stop the IBM OpenPages services before you back up the

application and environment files and export the OpenPages application
database, run the OPBackup command from 0P_Home\aurora\bin directory.

OPBackup <path-to-backup-location>

Note: The services are restarted when the backup activities are complete.

* If you want the OpenPages application to continue to run during the backup
process, use the nosrvrst option to run the OPBackup command from the
OP_Home\aurora\bin directory.

OPBackup <path-to-backup-location> nosrvrst
The <path-to-backup-location> variable is the full path of the directory where the
backup files are located. If the file path is not specified, the OPBackup
command uses the backup location that is specified by the BACKUP_LOCATION
parameter in the <0P_Home>\aurora\bin\op-backup-restore.env file.
2. If you are running the CommandCenter backup utility (OPCCBackup) for the
first time, configure the Oracle data pump storage directory.

a. Log on to a computer that has the SQL*Plus utility and a connection to the
CommandCenter database instance.

b. Go to the

\WIN64-0P_version\OpenPages\Win64\
OP_version_Non_Embedded WAS_Oracle_DB2_WIN64\

OP_version Configuration\Database\ORACLE\UPGRADE SCRIPTS\
0P620X_T0O_0P6210 directory.

c. From the command line, run the update-datapump-directory.sql script.

sqlplus /nolog @sql-wrapper update-datapump-directory <log file name>
<tns_name_alias> SYSTEM <password> create
<directory location> <user_name>

Use the following table to help replace the variables with values for your
environment.
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Table 5. Descriptions for variables in the update-datapump-directory.sql file

Variable Description

log_file_name The user-defined name of the log file that

the script creates to store information.

tns_name_alias The database Oracle TNS entry that is used

by the CommandCenter database instance
on the reporting server computer.

password The password for the Oracle SYSTEM user
account.

directory_location The full directory path to the location on the
database server where the backup files are
stored.

user_name The user name of the Cognos account for

the CommandCenter database schema
(content store).

3.

Example:

sqlplus /nolog @sql-wrapper update-datapump-directory
C:\temp\update-datapump.log OP SYSTEM sys2Password create
d:\cc_backup cognos

Run the OPCCBackup utility to back up the CommandCenter files and the
content store database.

a. Go to the <CC_Home>\tools\bin directory

b. Run the following command: OPCCBackup <path-to-backup-location>

The <path-to-backup-location> variable is the full path of the directory where the
backup files are located. If the file path is not specified, the OPCCBackup

command uses the backup location that is specified by the BACKUP_LOCATION
parameter in the <CC_Home>\tools\bin\op-cc-backup-restore.env file.

Enabling Data Execution Prevention for essential Windows
programs and services

By default, Windows Server 2008 uses settings that are designed to prevent an
application from running unauthorized programs. However, these settings can
interfere with the IBM OpenPages GRC Platform installations. During the software
installation, configure Data Execution Prevention (DEP) to allow the installers to
work.

Procedure

ook wh -

N

Log on to the server.

Open Windows Explorer.

Right-click Computer > Properties.

In the System Properties window;, click Advanced System Settings.
On the Advanced tab, under the Performance heading, click Settings.

In the Performance Options dialog box, click the Data Execution Prevention
tab, and then select Turn on DEP for essential Windows programs and
services only.

Click OK and then restart your system to enable the change.
Repeat these steps for each server in the installation.
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What to do next

When the installation of all software is complete, you can disable the setting.

Verifying that services are running

All servers must be running during the upgrade installation of the IBM OpenPages
GRC Platform. The upgrade installer validates user input by testing connections.

Procedure

1.
2.

3.

If any administrative or managed servers are stopped, start them.

Verify that all administrative and managed servers are running, including
database and reporting servers.

If the environment is a horizontal clustered installation, verify that all
managed servers are running on all non-administrative servers.

Preparing the OpenPages application servers for upgrade

After you back up directories and files on all servers, some additional setup is
required to prepare the OpenPages application servers for upgrade.

Configuring the default profile to accept the signer certificates
from OpenPages and workflow deployment managers

If WebSphere Application Server global security is enabled, you must configure the
default profile to automatically accept the signer certificates from OpenPages and
workflow deployment managers.

Procedure

1.
2.
3.

Log on to the OpenPages administrative server computer as an administrator.
Open a command prompt window as an administrator.

Go to the WAS_HOME\bin directory and run the following command to list the
WebSphere Application Server profiles.

manageProfiles.bat -TistProfiles

A list of the profiles is displayed. The first profile name is the
Default_Profile_Name.

Note: For example, on an admin server where you deployed two servers, the
following message is displayed:

[OpenPagesDmgr, op-OPNodel, IBPMDmgr, op-IBPMNodel, op-IBPMNode?2]

OpenPagesDmgr is the Default_Profile_Name.

To get the location of the Default_Profile_Name, run the following command:
manageProfiles.bat -getPath -profileName <Default Profile_Name>

The DEFAULT_PROFILE_PATH is displayed.

Go to the DEFAULT_PROFILE_PATH\bin directory and run the following two
commands:

retrieveSigners.bat -autoAcceptBootstrapSigner -host <HOST_NAME> -port
<OP_SOAP_PORT> -username <WAS_ADMIN_USERNAME> -password
<WAS_ADMIN_PASSWORD>

Example: To automatically accept the signer certificate from the OpenPages
deployment manager:
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retrieveSigners.bat -autoAcceptBootstrapSigner -host MY_HOST
-port 8879 -username admin -password mypassword

retrieveSigners.bat -autoAcceptBootstrapSigner -host <HOST_NAME>
-port <WORKFLOW_SOAP_PORT> -username <WAS_ADMIN_USERNAME>
-password <WAS_ADMIN_PASSWORD>

Example: To automatically accept the signer certificate from the workflow
deployment manager:

retrieveSigners.bat -autoAcceptBootstrapSigner -host MY_HOST -port 8880
-username admin -password mypassword

6. To apply the changes, restart all the services.

Saving custom settings in configuration files after the
upgrade

If you manually edited any configuration files, you must reapply the changes.
Keep a record of any customizations to ensure that they can be reapplied after you
upgrade. Also, back up these files so that the original version can be restored if
necessary.

To save and then restore customized settings:

1. Before you upgrade, open the configuration file that has the settings that you
changed manually.

Note the settings that you changed.

Back up the configuration file.

Install the upgrade.

Ensure that the upgrade works.

In the upgrade installation location, open the configuration file.

No oo koD

If necessary, update the configuration file with the changes you made in the
previous product version.

Disabling single signon
To simplify testing the upgrade installation, temporarily disable single signon. You
can test the upgraded environment without logging on to the single signon system.

Procedure

Open the current OpenPages application in a web browser.
Log on as a user with administrative permissions.

Click Action > Configuration > Settings.

Expand OpenPages > Platform > Security > Single Sign On.
Click the OP setting, set the value to false, and click Save.
Click the SOX setting, set the value to false, and click Save.

ook wn =

What to do next

After you test the upgrade, re-enable single signon.

Disabling system admin mode

Before you upgrade, temporarily disable the system admin mode.

To view System Admin Mode in the OpenPages application, you must have
System Administration Mode permission.
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Procedure

1. Log on to the OpenPages application user interface as a user with the System
Administration Mode permission.

2. From the menu bar, click Administration > System Admin Mode > Disable.

3. Log on to the OpenPages application user interface as a user with the System
Administration Mode permission.

4. From the menu bar, click Administration > System Admin Mode > Disable.
5. Click OK.

Modifying the ObjectManager properties file to disable object
force update strings

The ObjectManager.properties file contains a number of settings that control or
limit the scope of exported configuration and related data from the OpenPages
ObjectManager tool.

Procedure

1. Log on to the application server as an administrative user.
2. Go to the OP_HOME/bin directory.

Make a backup copy of the ObjectManager.properties file.

Hw

Open the ObjectManager.properties file in a text editor.

o

Verify that the following two properties are set to false to ensure that custom
strings are not overwritten:

» configuration.manager.force.update.object.strings=false
* configuration.manager.force.update.application.strings=false
6. Save and close the file.

Database schema upgrade

You can manually update the IBM OpenPages GRC Platform database schema by
running SQL scripts included in the media kit. Also, you can use the upgrade
installer program to automatically upgrade the database schema.

If you choose to manually upgrade the database server, you must run the SQL
scripts to upgrade the database server before you upgrade the reporting and
application servers.

Upgrading the database schema manually by using scripts

Run the database-upgrade.sql script to manually upgrade the OpenPages
database schema.

Before you begin

Ensure that the passwords for the Oracle database system, OpenPages, and
workflow user accounts are not expired.

Procedure
1. Stop all OpenPages services.

2. Log on to a computer that has the SQL*Plus utility and access to the database
server.
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3. Extract the installation files from the IBM OpenPages GRC Platform Installer
version for WebSphere Application Server Microsoft Windows Multilingual

DVD.

4. From the \WIN64-0P_version\OpenPages\Win64\

OP_version _Non_Embedded WAS Oracle DB2 WIN64\OP_version Configuration\
Database\ORACLE\UPGRADE_SCRIPTS directory, find the database-upgrade.sql

script.

5. Use the following syntax to run the database-upgrade.sql script:

sqlplus /nolog @sql-wrapper.sql database-upgrade.sql
<log file> <oracle_tns_alias> <dba_user> <dba _password>
<workflow_user> <workflow_password>
<op_user> <op_password>

The following table describes the parameters that are passed to the SQL

wrapper script.

Table 6. Descriptions of parameters that are passed to the SQL wrapper script

Parameter Name

Description

Example

log_file

The name of the log file that
the script creates and writes
information to.

logfile.txt

oracle_tns_alias

The database alias for the
OpenPages database instance,
as set during the Oracle
database installation.

If necessary, you can retrieve
this alias from the
tnsnames.ora file.

op

dba_user

The Oracle system user
name.

If you do not have access to
the system user account, then
use a database user account
with administrative
privileges.

system

dba_password

The password for the Oracle
system account.

openpages

workflow_user

The workflow database user
name.

OpenPages uses this account
to create and access the
workflow database, and to
manage workflow-related
transactions.

opworkflow

workflow_password

The password for the
workflow database user
account.

opworkflow

OpenPages database user
account.

op_user The user name that is used openpages
by OpenPages to create and
access the OpenPages
database instance

op_password The password for the openpages
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Example:

sqlplus /nolog @sql-wrapper.sql database-upgrade.sql
db_upgrade.Tog OP system oppassword opworkflow
oppassword openpages oppassword

Results

After the SQL script finishes, the OpenPages database schema is upgraded. The log
file that you specified as a parameter is created in the directory where you ran the
SQL script.

If you have problems when you run the database-install.sql script, use the
\WIN64-0P_version\OpenPages\Win64\

OP_version Non_Embedded WAS Oracle DB2 _WIN64\OP_version Configuration\
Database\ORACLE\init-db-cleanup.sql script, which removes the database
components that were added. Then, run the database-install.sql script in a clean
database environment.

Example

sqlplus /nolog @sql-wrapper.sql init-db-cleanup.sql log file
oracle_tns_alias dba_user dba_password workflow _user op_user

Note: The init-db-cleanup.sql script drops the database. You must restore the
database from backup before you continue with the database upgrade. After the
database environment is restored from backup, you can run the
database-upgrade.sql wrapper script again.

Related tasks:
[“Upgrading the OpenPages application server”]

You must upgrade all application servers. Run the upgrade installer on all
administrative and managed servers.

Upgrading the OpenPages application server

You must upgrade all application servers. Run the upgrade installer on all
administrative and managed servers.

Before you begin

Ensure that the following conditions are met:
¢ System admin mode is disabled
 Services are running

* JAVA_HOME is set

Restriction: Ensure that the JAVA_HOME environment variable points to
jdk1.6.0_24. Other versions of Java cause issues with Interstage BPM. If you
plan to upgrade the version of Java in your environment, keep the existing Java
jdk1.6.0_24 for OpenPages GRC Platform.

* Ensure that the password for the Oracle database system is not expired.

* If the OpenPages, and workflow database user accounts exist, ensure that the
password for each account is not expired.
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Procedure

1.

10.

11.

12.

Log on to the application server as a user with administrative privileges and
full access to the local server drives.

Extract the installation files from the IBM OpenPages GRC Platform Installer
version for WebSphere Application Server Microsoft Windows Multilingual
DVD to the local system.

From the \WIN64-0P_version\OpenPages\Win64\

OP_version_Non_Embedded WAS_Oracle_DB2_WIN64\
OP_version_Admin_and_Config_Console directory, extract the contents of the
opadminconsole-win32.win32.x86_64.zip file.

To avoid File path too Tong or other extraction errors, use a decompression
utility, such as 7-Zip, Otherwise, extract the files to the root directory or to the
c:\temp directory. The extraction might take a few moments to finish.

From the directory where you extracted the files, go to the opadminconsole
directory and right-click opadminconsole.exe and click Run as administrator.
If the license agreement is displayed, accept the terms to proceed.

In the Select the Installation Option page, select Upgrade WebSphere Server
on Windows with Oracle and click Continue.

From the Select the Installation Option page, click Upgrade WebSphere on
Windows with Oracle.

On the Properties tab, enter the properties that are required to deploy
OpenPages application servers and workflow server.

Use the Repair option if you are installing on top of an existing upgrade
installation.

Tip: A description and online help for each property is displayed in the Help
view when you click the property. If the Help view is not visible, click View >
Help or press F1. For information about using the OpenPages Administrative
Console, in the Help view, click Contents

For the OpenPages Application Server Information group of properties,
choose whether you are installing the OpenPages administrative server or
managed server, and then enter the property values.

You must upgrade the OpenPages administrative server before you upgrade
the managed servers.

If WebSphere Application Server security is enabled, select Enabled on server.

Important: Ensure that you enter the correct information for the WebSphere
Admin Username and Admin Password. These credentials are used to log in
to the WebSphere Administrative Console.

To verity the credentials, log on to the WebSphere Administrative Console
(https:/ /was_host_name:secure_port /ibm/console).

The default secure port number for the OpenPages cell is 9043.

For the Database Information group of properties, select whether you
upgraded the OpenPages database schema.

* Select Upgrade now to automatically upgrade the OpenPages database
schema when OpenPages GRC Platform is deployed to WebSphere
Application Server.

* Select Already installed if the schema is upgraded.

You must upgrade The OpenPages database schema either before or during
the deployment to WebSphere Application Server.

To verify the settings that you entered, click Validate Properties.
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If there are errors, change the settings that require attention.
13. To upgrade OpenPages GRC Platform, click Upgrade.

Monitor the progress of the installation in the Installation Steps or the Log
view.

A message is displayed to indicate whether the installation succeeded. If the
installation fails, the OpenPages Administrative Console rolls back the
installation to the last successful checkpoint.

If you see the following exception in the OP_Home\aurora\logs files, you can
safely ignore the message:

com.ibm.websphere.ce.cm.DuplicateKeyException:
ORA-00001: unique constraint (OPENPAGES.APPPERMISSIONS_UN)
violated.

What to do next

For a complete upgrade, you must upgrade all OpenPages application server and
CommandCenter computers.

Related concepts:

[“Upgrade installation recovery options” on page 19|

When the upgrade installation fails, the installation program does a partial
rollback. The partial rollback backs out selected installation changes to a save
point. To recover from the failed upgrade installation, choose one of the following
options:

Related tasks:

[“Upgrading the database schema manually by using scripts” on page 13|
Run the database-upgrade.sql script to manually upgrade the OpenPages
database schema.

Upgrading the reporting server

You must upgrade CommandCenter on all reporting servers.
Before you begin

Ensure that the following conditions are met:

* IBM Cognos Business Intelligence is installed and running
* All services are running

* JAVA_HOME is set

Restriction: Ensure that the JAVA_HOME environment variable points to
jdk1.6.0_24. Other versions of Java cause issues with Interstage BPM. If you
plan to upgrade the version of Java in your environment, keep the existing Java
jdk1.6.0_24 for OpenPages GRC Platform.

Procedure

1. Log on to the reporting server as a user with administrative privileges and full
access to the local server drives.

2. Extract the installation files from the IBM OpenPages GRC Platform Installer
version for WebSphere Application Server Microsoft Windows Multilingual
DVD to the local system.

3. From the \WIN64-0P_version\OpenPages\Win64\
OP_version Non_Embedded WAS Oracle DB2_ WIN64\
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OP_version_Admin_and_Config_Console directory, extract the contents of the
opadminconsole-win32.win32.x86_64.zip file.

To avoid File path too long or other extraction errors, use a decompression
utility, such as 7-Zip, Otherwise, extract the files to the root directory or to the
c:\temp directory. The extraction might take a few moments to finish.

4. From the directory where you extracted the files, go to the opadminconsole
directory and right-click opadminconsole.exe and click Run as administrator.

5. If the license agreement is displayed, accept the terms to proceed.

6. On the Select the Installation Option page, select Upgrade WebSphere Server
on Windows with Oracle and click Continue.

7. On the Properties tab, enter the properties that are required to deploy
OpenPages application servers and workflow server.

Use the Repair option if you are installing on top of an existing upgrade
installation.

Tip: A description and online help for each property is displayed in the Help
view when you click the property. If the Help view is not visible, click View >
Help or press F1. For information about using the OpenPages Administrative
Console, in the Help view, click Contents

8. To verify the settings that you entered, click Validate Properties.
If there are errors, change the settings that require attention.
9. Click Upgrade.

Monitor the progress of the installation in the Installation Steps or the Log
view. A message is displayed to indicate whether the installation succeeded. If
the installation fails, the OpenPages Administrative Console rolls back the
installation to the last successful checkpoint.

What to do next

For a complete upgrade, you must upgrade all reporting server computers.
Related concepts:

[‘Upgrade installation recovery options” on page 19|

When the upgrade installation fails, the installation program does a partial
rollback. The partial rollback backs out selected installation changes to a save
point. To recover from the failed upgrade installation, choose one of the following
options:

Updating the reporting framework

After you upgrade IBM OpenPages GRC Platform, update the reporting
framework.

Procedure
1. In a web browser, open the OpenPages application:
http://openpages _server:port/openpages
2. Log on to the OpenPages application as a user with administrative privileges.
3. If System Admin Mode is enabled, disable it.

4. From the menu bar, click Administration > Reporting Framework >
Generation.

5. On the Reporting Framework Operations page, click Update.
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6. In the Reporting Framework Generation window, under Framework
Generation, select the Framework Model and Labels and other options you
want for the relational data model.

Restriction: If you are upgrading from OpenPages GRC Platform version 5.x or
earlier, you must generate the Legacy Framework.

For upgraded systems that have the Legacy Reporting Framework setting
enabled, you can generate the relational data model. Under Legacy Framework
Generation, select the Framework Model and Labels options.

For information about enabling the Legacy Framework and enabling computed
fields in the Reporting Framework V6, see the IBM OpenPages GRC Platform
Administrator’s Guide.

7. Click Submit.
8. To view the progress of the update, click Refresh.

The Percent Complete column on the Reporting Framework Operations table
is updated.

Results

Updating the reporting framework process takes approximately 30 minutes or
longer.

Upgrade installation recovery options

When the upgrade installation fails, the installation program does a partial
rollback. The partial rollback backs out selected installation changes to a save
point. To recover from the failed upgrade installation, choose one of the following
options:

* Rerun the upgrade installation in Repair mode and complete the upgrade.

* Manually roll back to the previous version of IBM OpenPages GRC Platform.

Rolling back manually to a previous installation

If the upgrade installation fails, you can manually revert to the successful state of
the previous version of IBM OpenPages GRC Platform.

About this task

Use the following table to replace the script variables with values that are
appropriate for your environment.

Table 7. Variable descriptions for rollback scripts

Variable Description
admin_host_name The host name of the administrative server.
admin_username User name of the WebSphere Application Server

administrator account

admin_password The password of the WebSphere Application Server
administrator account
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Table 7. Variable descriptions for rollback scripts (continued)

Variable

Description

OP_SOAP_port

The port number for the OpenPages Deployment
Manager SOAP listener.

In the OpenPages Administrative Console, this
parameter is the DMgr Manager SOAP Port.

The value of the SOAP_CONNECTOR_ADDRESS setting in
the <0P_Home>\temp\wasconfig\
OpenPagesCell<server_name>-
OPNodelServer<server#>.config.props file

The default port is 8879.

IBPM_SOAP_port

The port number for the workflow Deployment
Manager SOAP listener.

In the OpenPages Administrative Console, this
parameter is the Workflow DMgr SOAP Port.

The value of the SOAP_CONNECTOR_ADDRESS setting in
the <0P_Home>\temp\wasconfig\
IBPMCell<server_name>-
IBPMNode<server#>Server.config.props file

The default port is 8881.

host_name

The name of the computer where you are running
the recovery steps.

Procedure

1. To manually stop the OpenPages services, go to the 0P_Home\bin directory.

 If WebSphere Application Server security is not enabled, run the following

command:
StopAll1Servers.cmd

If WebSphere Application Server security is enabled, run the following
command:

StopAll1Servers.cmd <admin_username> <admin_password>

To start the OpenPages Deployment Manager, go to the OP_Home\profiles\

OpenPagesDmgr\bin directory and run the startManager.bat script.

3. To deploy the OpenPages application by using scripts, open a command
window and go to the OP_Home\upgrade\temp\perlinstall directory.

* If WebSphere Application Server security is not enabled, run the following

command:

<WAS_HOME>\bin\wsadmin.bat -wsadmin_classpath
commons-configuration-1.6.jar;
commons-lang-2.4.jar;commons-collections-3.2.1.jar -lang
jython -conntype soap

-host <admin_host_name> -port

<0P_SOAP_port> -f updateOPApp.py

If WebSphere Application Server security is enabled, run the following
command:
<WAS_HOME>\bin\wsadmin.bat -wsadmin_classpath

commons-configuration-1.6.jar;
commons-lang-2.4.jar;commons-collections-3.2.1.jar
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-user <admin_username> -password <admin_password>

-Tang jython -conntype soap

-host <OP_ADMIN_HOSTNAME> -port

<0P_SOAP_port> -f updateOPApp.py
To start the Fujitsu Interstage BPM Deployment Manager by using scripts, go
to the <worflow_HOME>\profileIBPMDmgr\bin directory and run the
startManager.bat command.

To deploy the workflow applications, open a command window and go to the
OP_Home\upgrade\temp\perlinstall directory.

* If WebSphere Application Server security is not enabled, run the following
command:
<WAS_HOME>\bin\wsadmin.bat -wsadmin_classpath
commons-configuration-1.6.jar;commons-lang-2.4.jar;
commons-collections-3.2.1.jar -lang
Jython -conntype soap -host <admin_host_name>
-port <OP_SOAP_port> -f updateOPApp.py
* If WebSphere Application Server security is enabled, run the following
command:
WAS_HOME>\bin\wsadmin.bat -wsadmin_classpath
commons-configuration-1.6.jar;commons-lang-2.4.jar;
commons-collections-3.2.1.jar
-user <admin_username> -password <admin_password>
-lang jython -conntype soap -host <admin_host_name>
-port <OP_SOAP_port> -f updateOPApp.py
To synchronize the OpenPages nodes, open a command window and go to the
<0P_Home>\profiles\<host_name>\0PNodel\bin directory.

* If WebSphere Application Server security is not enabled, run the following
command:

syncNode.bat <admin_host _name> <OP_SOAP_port>

* If WebSphere Application Server security is enabled, run the following
command:

syncNode.bat <admin_host_name> <OP_SOAP_port>
-user <admin_username> -password <admin_password>

To synchronize the workflow nodes, open a command window and go to each
workflow (Interstage PBM) node directory.

<workflow_Home>\profiles\<host_name>IBPMNode<Node_ Number>\bin

* If WebSphere Application Server security is not enabled, run the following
command:

syncNode.bat <admin_host_name> <IBPM_SOAP port>

* If WebSphere Application Server security is enabled, run the following
command:

syncNode.bat <admin_host_name> <IBPM_SOAP_port>
-user <admin_username> -password <admin_password>

To restore the solutions and services archives in the <OP_Home>\application
directory, copy them into the corresponding locations in the following
directory:

<0P_Home>\profiles\<host name>-0PNodel\installedApps\OpenPagesCell\op-
apps.ear

To restore the files under the <OP_Home>\upgrade\backup\ibpm\profiles
directory, copy them to the <workflow_Home>\profiles directory.

Restore the OpenPages database backup.

For more information about restoring the database backup, see the IBM
OpenPages GRC Platform Administrator’s Guide.
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11. Manually start the OpenPages services.
a. Go to the <0P_Home>\bin directory
b. Run the StartAl1Servers.cmd script.

Post upgrade tasks

After you upgrade IBM OpenPages GRC Platform, some post installation tasks are
required to complete the upgrade.

Starting services after the upgrade

The upgrade installer stops all OpenPages servers on the computer where you are
upgrading. When the upgrade installer is complete, you must manually restart the
servers.

Procedure
1. Start all application and workflow servers.

On Windows operating systems, you must start the OpenPagesAdminServer
service first. Then, start the other services. Otherwise, use start the services
from the Windows Start menu shortcut.

For more information about starting services, see the IBM OpenPages GRC
Platform Administrator’s Guide.

2. Start the IBM Cognos Business Intelligence service.

Upgrade verification tests

After you upgrade IBM OpenPages GRC Platform, verify that the upgrade is
successful and the product works as expected.

Use the following checklist to verify the upgrade.

Table 8. Post-installation verification checklist

Task Guidance

The log files are located in the
Review all installation logs for errors. OP_HOME\bin\1ogs directory.

. . If it does not exist, create a backup of your
Verify that a backup of the system exists |system by running the 0PBackup command from
the OP_HOME\aurora\bin directory.

Verify that a compressed file was created with
the correct timestamp. The file is in the
OP_Home\openpages-backup-restore directory.

For information about using the backup utility,
see the IBM OpenPages GRC Platform
Administrators Guide.

For more information, see ['Updating the]
Confirm that the reporting schema and  |[reporting framework” on page 18]
framework generated successfully.

Log on to the OpenPages application and run

Confirm that base reports are functioning | the A11 Documentation CommandCenter report.
as expected.

Log on to the OpenPages application with an
If single signon (SSO) is enabled, verify |SSO user account.

that user accounts can access the
environment.
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Table 8. Post-installation verification checklist (continued)

Task Guidance

Confirm that you can upload and upload and download a file attachment.
download sample attachments.

Log on to the OpenPages application and

Verify that links in reports reference the |link and confirm that the target object is

correct server address and use the correct | rendered successfully in the OpenPages
web URL parameters. interface.

Run a report that uses OpenPages links. Select a

For clustered environments, verify that Upload and download files from both primary
all servers can upload and download and secondary application servers.
attachments.

For load-balanced environments, confirm |On primary and secondary servers, verify
that backup scheduling works. backup scheduling and process times.

Validate that you can access the Cognos | Type the web URL http://server_name/
portal. ibmcognos from a client system. Confirm that

you can log on to the portal.

Testing IBM Cognos Business Intelligence after the upgrade

Verify that IBM Cognos Business Intelligence works with the IBM OpenPages GRC
Platform environment.

Procedure

1.

Log on to the IBM OpenPages application and verify that you can connect to
the IBM Cognos Business Intelligence portal.

a. In a web browser, log on to the IBM OpenPages application.

b. To test the connection from OpenPages to the IBM Cognos BI portal, click
Reporting > Cognos Connection.

c. Close the session.
On the IBM OpenPages home page, from the Reporting menu, verify that you
can open the Cognos studios.

From the IBM OpenPages application, click Reporting > All Reports, and run
some standard and custom user reports.

Upgrading deployed images and custom query subjects on
the reporting server

Upgrade the deployed OpenPages images and custom query subjects to the current
version of IBM Cognos Business Intelligence.

Procedure

1.

Go to the 01d_Cognos_HOME |webcontent | skins|branding directory.

Old_Cognos_HOME is the installation location of the previous version of
Cognos software.

Copy the contents of the directory, without overwriting existing images, to the
New_Cognos_HOME |webcontent |skins|branding directory.

To back up the custom query subjects, go to the 01d_CC_HOME | framework | conf
directory and copy the files to the New_CC_HOME | framework|conf directory.
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Results

If there are no deployed images or custom query subjects, following this procedure
will copy no files.

Enabling single signon after upgrade
If you disabled single signon, re-enable the settings.

Procedure

Open the current OpenPages application in a web browser.
Log on as a user with administrative permissions.

Click Action > Configuration > Settings.

Expand OpenPages > Platform > Security > Single Sign On.
Click the OP setting, set the value to true, and click Save.
Click the SOX setting, set the value to true, and click Save.

IR

Updating OpenPages Modules reports after an upgrade

If you upgraded OpenPages from versions 6.0 or 6.1, you must manually deploy a
Cognos deployment archive on the reporting server.

Restriction: To move a deployment archive, you need access to the installation
directories on the computer where IBM Cognos Business Intelligence is installed.
This location is set in the configuration tool. The default location is
Cognos_HOME/depTloyment.

Procedure
1. Log on to the reporting server as a user with administrative privileges.
2. From the OpenPages Upgrade Installer DVD, go to the Reports directory.

3. Copy the Dril1UpDril1DownReportsWithUpdatedDrilling.zip and
Dril1UpDrillDownReportsWithFul1Drilling.zip files to the IBM Cognos
deployment directory.

The default location is the Cognos_HOME\deployment directory.
4. From the command prompt, go to the CC_HOME\temp\bin directory.
The default location is the OP_HOME/CommandCenter/temp/bin directory.
5. Type the following command:

importReports.bat -a DrillUpDrillDownReportsWithUpdatedDrilling -s
OpenPagesSecurityRealm -u <username> -p <password>
-g http://<Cognos_server>:<dispatcher_port>/p2pd/serviet/dispatch

Results

You can access the reports in IBM Cognos Connection.

Custom settings in configuration files

If you manually edited any configuration files in the previous version, you must
reapply the changes.

To restore customized settings after you upgrade:
1. Ensure that the upgrade works.
2. Find the backup copy of the configuration file.
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3. In the upgrade installation location, open the new configuration file.

4. Update the configuration file with the changes you made in the previous
product version.

Restoring changes to the application.xml file

If you preserved settings in the application.xml file, such as removing openpages
from the application URL, you can restore the settings.

Procedure
1. If necessary, stop the OpenPages services.

2. Go to the OP_HOME/profiles/OpenPagesDmgr/config/cells/OpenPagesCell/
applications/op-apps.ear/deployments/op-apps/META-INF/application.xml
directory

3. Open the file in a text editor and compare it to the backed up version of the
file.

4. Restore the customized settings.

5. For WebSphere Application Server, restore the setting on all nodes in the
cluster.

Each node has a version of the application.xml file in a location similar to the
following directory: OP_HOME/profiles/node_namel/installedApps/
OpenPagesCel1/op-apps.ear/META-INF/.

6. Restart the services.

Backing up changes to the web.xml file

If you changed settings in the web.xml file, such as changing the HTTP session
timeout for a user in your web application

For more information about the session timeout settings, see the IBM OpenPages
GRC Platform Administrator’s Guide.

Procedure

1. For WebLogic environments, log on to the IBM OpenPages application server
as a user with administrative permissions.

a. If necessary, stop all services.
b. Find the backup copy of the web.xml file and open it in a text editor.
c. Find the session-timeout parameter value (in minutes).

<!--Set the default session timeout (in minutes)-->
<session-config>
<session-timeout>90</session-timeout>
</session-config>

d. In the upgrade location, go to the OP_HOME\applications\op-apps\sosa\WEB-
INF directory\web.xml file and restore the setting.

2. For WebSphere Application Server installations, log on to the IBM WebSphere
Integrated Solutions Console as a server administrator.

http://server_name:port/ibm/console
The default port is 9060.

a. Expand Applications > Application Types and click WebSphere enterprise
applications.

b. On the Enterprise applications page, click the name of the resource you
want to configure

Chapter 2. Upgrading OpenPages GRC Platform 25



C. On the Enterprise Applications IBM OpenPages -resource-name page, click
the Configuration tab.

d. Under the Web Module Properties headingsame, click Session
management.

e. On the Enterprise servers IBM OpenPages -resource-name Session
management page, under General Properties find the Session timeout
pane.

f. Select the Set timeout option, and reset the Set timeout setting to the value
of the backup setting.

g. Exit the console
3. Restart the services.
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Chapter 3. Installation planning

The key to a successful installation is planning. [Review the IBM OpenPages GRCl
IPlatform supported software environments and other system requirements| such as
hardware requirements, on the IBM support website ((http://www.ibm.com/
support/ docview.wss?uid=swg27037756).

Related concepts:

[“Server topology and installation configurations” on page 1|
Before you install OpenPages GRC Platform, plan the server topology. The number
of computers you use depends on the expected user loads.

Software prerequisites

To ensure that your product works properly, apply all minimum required
operating system patches, and use only the supported versions of third-party
software. Review the prerequisite software before installing OpenPages GRC
Platform.

Prerequisite software for all servers

Before you install OpenPages GRC Platform, ensure that the prerequisite software
is installed on each server in your environment.

The following tables list the third-party software that must be installed on all
OpenPages servers before you start the OpenPages installation.

Table 9. Software prerequisites for all Windows computers

Requirement Specification
Operating System Windows

Web browser Internet Explorer
File compression utility For example, WinZip
PDF reader Adobe Acrobat

Table 10. Software prerequisites for all AIX or Linux computers

Requirement Specification

Operating System AIX or Linux

File compression utility For example, GNU compression utility
(gtar)

Prerequisite software for the database server

In addition to the software required for all servers, ensure that the prerequisite
software is installed on the database server.

The server that hosts the OpenPages database must have the required server
software that is installed, including any fix packs, patches, or other service
updates. For more information, see the supported software environments on the
IBM support website.

27


http://www.ibm.com/support/docview.wss?uid=swg27037756
http://www.ibm.com/support/docview.wss?uid=swg27037756
http://www.ibm.com/support/docview.wss?uid=swg27037756

Oracle database server

The Oracle database server that hosts the OpenPages database must have the
required server software installed.

* Oracle Database Server 11g Release 2 (11.2.0.1) Standard with October 2010
Critical Patch Update applied

* Oracle Database Server 11g Release 2 (11.2.0.1) Enterprise Edition with October
2010 Critical Patch Update and p8795792_112010_Generic.zip patch applied. You
must contact Oracle Support and request the p8795792_112010_Generic.zip
patch file.

* Oracle Real Application Clusters 11g Release 2

DB2 database server

The DB2 database server that hosts the OpenPages database must have the
required server software installed. DB2 10.1 Server Fix Pack 1 must be installed

before you install the DB2 Universal Fix Pack.

The following table lists the DB2 software requirements by operating system.

Table 11. Required DB2 10.1.0.1 software for OpenPages

Operating system Universal Fix Pack
Windows 1. DB2 Server Fix Pack 1
2. Universal Fix Pack Special_30205 for
Windows
Linux 1. DB2 Server Fix Pack 1
2. Universal Fix Pack Special_30155 for
Linux-64
AIX 1. DB2 Server Fix Pack 1
2. Universal Fix Pack Special_30070 for
AIX-64

Related concepts:

[“Oracle Database Server installations” on page 61

IBM OpenPages GRC Platform requires a database server. Use the installation
instructions from the vendor to install the Oracle database server on the IBM
OpenPages database server. After you install Oracle Database, some configuration
is required.

[“DB2 server installations” on page 41
To use a DB2 database for the OpenPages repository, review the specific
requirements for your system before you install DB2 products.

Prerequisite software for application servers

Ensure that you install the prerequisite software on all servers that host IBM
OpenPages GRC Platform.

The following tables list the software requirements for application servers.
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Table 12. Software prerequisites for application servers on Windows computers

Requirement Specification

Java Development Kit For WebSphere Application Server Network
Deployment, use the JDK that is available
with the application server.

Application server WebSphere Application Server Network
Deployment and required fix packs.

Application server installation location Restriction: The IBM OpenPages GRC
Platform Installer requires that application
server software is installed to a path with no
spaces.

Important: IBM OpenPages GRC Platform
requires a dedicated Windows-based server
and IBM WebSphere Application Server
environment. Sharing the OpenPages server
with other applications and IBM WebSphere
Application Server environments is not
supported

Database client software Oracle or DB2 database client software
Important: Ensure that you use the same
version of the database client software as the
server software. Apply all required patches,
interim fixes, or services to both the
database server and the database client
software

Table 13. Software prerequisites for application servers on AlX or Linux computers

Requirement Specification

Application server IBM WebSphere Application Server Network
Deployment and required fix packs.

Application server installation location Important: The IBM OpenPages GRC
Platform requires a dedicated AIX LPAR and
IBM WebSphere Application Server
environment. Sharing the OpenPages LPAR
with other applications and IBM WebSphere
Application Server environments is not
supported.

Database client software Oracle or DB2 database client software
Important: Ensure that you use the same
version of the database client software as the
server software. Apply all required patches,
interim fixes, or services to both the
database server and the database client
software

Prerequisite software for reporting servers

Ensure that you install IBM Cognos Business Intelligence and the IBM Cognos
Software Development Kit on reporting servers.

For information about the software prerequisites for IBM Cognos Business
Intelligence, see the IBM Cognos Intelligence Installation and Configuration Guide.
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Prerequisite software for OpenPages client computers

Ensure that prerequisite software is installed on all computers that access the IBM

OpenPages GRC Platform application.

The following table lists the software requirements for client computers.

Table 14. Software prerequisites for client computers

Requirement

Specification

Web browser

Microsoft Internet Explorer

PDF reader

For example, Adobe Reader

Optional: Microsoft Excel

If required, for some reporting functions

Optional: Microsoft .NET Framework

Required on clients where IBMCognos Office
products are installed

VMWare configuration requirements on Windows computers

The VMWare performance on a virtualized system is comparable to hardware. You
can use the hardware guidelines for the database server, application server, or
reporting server for sizing VM requirements.
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Cloning of OpenPages application server VMs is not supported.

Each VM server computer must meet the following software requirements:

e VMWare ESX Server version 4.1 or 5.0

e VMWare Infrastructure Client version 4.0

* Red Hat KVM 6.0
e Microsoft Windows 2008 R2
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Chapter 4. Preparing your system for installation

Before you install OpenPages GRC Platform, some preinstallation tasks are
required.

Procedure

1.

10.

Ensure that the database server software is installed.

For more information about installing Oracle database server, see
[Database Server installations” on page 61|

For more information about installing DB2 database server, see
finstallations” on page 41.|

Ensure that database passwords have not expired.

Ensure that WebSphere Application Server and any required maintenance
updates for it are installed.

For information about supported software environments, [Review the IBM|
OpenPages GRC Platform supported software environments and other system|

requirements| on the IBM Support website.

Ensure that the required users and groups exist and that they each have the
appropriate permissions for installing applications.

For more information about DB2 users and groups, see [“Operating system|
user accounts for OpenPages and Cognos BI installations that use DB2|
databases” on page 42

Ensure that IBM Cognos Intelligence and the IBM Cognos Software
Development Kit are installed.

For Windows installations, [enable Data Execution Prevention (DEP)} and
ensure that you have access to the Microsoft Registry Editor (regedit.exe).

[Ensure that all required ports are available for application use}

If the database server is separate from the OpenPages application servers,
install the database client software on application server computers.

If the database server is separate from the Cognos Business Intelligence server,
install the database client software on reporting servers.

Set the environment variables on OpenPages administration and managed
servers and on reporting servers.

Connection methods for installing on different operating systems

You can run the IBM OpenPages GRC Platform Administrative Console on a
Windows or Linux operating system. For AIX environment, run the OpenPages
Administrative Console on a Windows computer and then connect to the target
computer.

Depending on the operating system of the target installation computer, you can
run the Administrative Console locally or on a Windows computer.

To install on a Windows computer, you run the OpenPages Administrative

Console locally.

To install on an AIX computer, you must run the OpenPages Administrative

Console remotely.

To install on a Linux computer, you can install locally or remotely.
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If your database server is not on the same computer as OpenPages application
server, ensure that you installed the database client software on the OpenPages
Administrative Console computer.

Supported shells for UNIX and Linux installations
You can use the Bourne shell (/bin/sh), Bourne Again Shell, (/bin/bash), the

C-Shell (/bin/sh) and the Korn Shell (/bin/ksh) for OpenPages installations that
use the IBM OpenPages GRC Platform Administrative Console.

The Super Administrator

IBM OpenPages GRC Platform uses the concept of a Super Administrator account.
A Super Administrator is set up as part of the installation process and has
complete access to all objects, folders, role templates, and groups in the OpenPages
system.

In a new installation, the Super Administrator is the only user in the system. You
can change the logon user name and the password or both the user name and
password of the OpenPages Super Administrator account before, during or after
installation. If you use the application interface to change the user account
information, you must manually make corresponding changes to the
CommandCenter Framework Generator property file. For more information, see
the IBM OpenPages GRC Platform Administrator’s Guide.

Users and groups for installations on Windows operating systems

The user account required to install and configure the OpenPages environment
must be members of the power user or administrator groups. Users in either of
these groups can install and configure IBM OpenPages GRC Platform.

Important: The password for this user cannot contain special characters due to
conflicts with OpenPages scripts.

Creating installation users and groups for application servers on AIX
and Linux operating systems

To install WebSphere Application Server and the OpenPages application, you must
create the required users and groups.

Tip: For simplicity, use the same account (opuser) to install WebSphere
Application Server and the OpenPages application server.

Optionally, you can create two separate users:

* One user to install WebSphere Application Server.

* One user to install the OpenPages application.

Both users must both belong to the same primary group. If different users install
OpenPages and WebSphere, after the installation, you must change the permission

of the installation directories and files. To ensure that the group members have
write permission, modify the permissions to 775.

Example: Create an AIX or Linux operating system group named opgroup. This
group contains the user that starts the WebSphere Application Server and the user
that owns the IBM OpenPages application server files. Install WebSphere
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Application Server and the OpenPages application. Ensure that the installation files
and directories are writeable for the owner and member of the same group as the
owner (chmod 775 command)

Procedure

1.
2.

Log on to the application server as root and open a shell.
Optional: To create a group, such as opgroup, enter the following command:
* On AIX operating systems:
mkgroup -A opgroup
* On Linux operating systems:
groupadd opgroup
Do one of the following steps:
* If you created an opgroup group, add the opuser and wasuser users to the
primary group (opgroup group).
useradd -G opgroup opuser
useradd -G opgroup wasuser

* If the same user account installs both WebSphere Application Server and the
OpenPages application server, create a user, such as opuser.

useradd -m opuser

Change the password for the OpenPages application user by using the
following command:

passwd opuser

Optional: To install WebSphere Application Server, create a user, such as
wasuser.

useradd -m wasuser

Change the password for the OpenPages application user by using the
following command:

passwd wasuser

On AIX and Linux operating systems, grant read, write, and execute
permissions to the home directory of the OpenPages installation user.

chmod 755 /home/opuser

To install the Fujitsu IBPM software successfully, you must grant read, write,
and execute permissions to the home directory of the user who is installing the
OpenPages application.

For local installations on Linux operating systems, the OpenPages installation
user is the user who runs the OpenPages Administrative Console.

For remote installations on AIX and Linux operating systems, the OpenPages
installation user is the user who connects to the remote server.

What to do next

After you install WebSphere Application Server and OpenPages application server,
ensure that installation directories and files have the write permission for the

group.
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Enabling Data Execution Prevention for essential Windows programs

and services

By default, Windows Server 2008 uses settings that are designed to prevent an
application from running unauthorized programs. However, these settings can
interfere with the IBM OpenPages GRC Platform installations. During the software
installation, configure Data Execution Prevention (DEP) to allow the installers to
work.

Procedure

1. Log on to the server.

Open Windows Explorer.

Right-click Computer > Properties.

In the System Properties window, click Advanced System Settings.
On the Advanced tab, under the Performance heading, click Settings.

o ok wDN

In the Performance Options dialog box, click the Data Execution Prevention
tab, and then select Turn on DEP for essential Windows programs and
services only.

7. Click OK and then restart your system to enable the change.
8. Repeat these steps for each server in the installation.

What to do next

When the installation of all software is complete, you can disable the setting.

WebSphere Application Server installations

IBM OpenPages GRC Platform, WebSphere Application Server must be installed
and running on each computer where you plan to install the OpenPages
application software.

Installation restrictions

Review the following restrictions before you install WebSphere Application Server.

Supported WebSphere Application Server software environments
Ensure that you are using a supported version of WebSphere Application
Server. The IBM OpenPages GRC Platform installation program verifies the
version. For more information about the supported software environments,
see jsupported software environments| on the IBM website.

Note: IBM product fixes and updates are available from [[BM Fix Centrall
(http:/ /www-933.ibm.com/support/fixcentral /).

* The minimum requirement for WebSphere Application Server Network
Deployment version 7.0 is version 7.0.0.13.

Two interim fixes are required for WebSphere Application Server
Network Deployment version 7.0.0.13 in Linux environments. For more
information, see the fnotice on the IBM web site] (http:/ /www.ibm.com/
support/docview.wss?uid=swg21462019).

¢ The minimum requirement for WebSphere Application Server Network
Deployment version 8.0 is version 8.0.0.5 and an interim fix
8.0.0.0-WS-WAS-IFPM80935.
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¢ The minimum requirement for WebSphere Application Server Network
Deployment version 8.5 is version 8.5.0.1.

Installation path cannot contain spaces.

The installation path for WebSphere Application Server cannot contain
spaces. The default location is path\WebSphere\AppServer. For Windows
installations, if WebSphere Application Server is installed in a directory
with spaces, you can enter the short file name convention. For example, for
C:\Program Files\IBM\WebSphere\AppServer, enter C:\PROGRA~1\IBM\
WebSphere\AppServer.

Installing WebSphere Application Server Network Deployment
Version 8.5

Use IBM Installation Manager to install WebSphere Application Server and the
required fix packs. You must install Installation Manager before you install
WebSphere Application Server.

For horizontal cluster configurations, install WebSphere Application Server on the
cluster administrator and cluster member servers.

The WebSphere Application Server version on the non-admin server must be the
same as the WebSphere Application Server version on the admin server.

Procedure
1. Install Installation Manager.

For more information about installing Installation Manager, see the
[Manager Information Center] (http:/ /pic.dhe.ibm.com/infocenter /install/v1r5/
index.jsp).

2. Use Installation Manager to install WebSphere Application Server from the
product repositories on the media.

For more information, see the[installation options that documented in the]
[WebSphere Application Server Information Centerjhttp:/ /pic.dhe.ibm.com/
infocenter /wasinfo/v8r5/index.jsp?topic=
%2Fcom.ibm.websphere.installation.nd.doc%2Fae
%2Ftins_installation_dist_gui.html).

Restriction: Do not install into a directory that contains spaces or non-ASCII
characters.

A repository contains the product package.

Example: Adding a repository connection in Installation Manager
a. Start Installation Manager

b. On the Start page of Installation Manager, click File > Preferences, and then
click Repositories.

c. On the Repositories page, click Add Repository.

d. In the Add repository window, type the URL of the repository location or
browse to it and set a file path.

If you extracted the WebSphere Application Server installation files to the
local system, browse to the repository.config file.

e. Click OK.
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If you provided an HTTPS or restricted FTP repository location, then you
are prompted to enter a user ID and password. The new or changed
repository location is listed. If the repository is not accessible, a red x is
displayed in the Accessible column.

3. Use Installation Manager to install the required fix packs for WebSphere
Application Server from the fix pack repositories on the media.

4. When the installation process completes, select whether to create a profile and
then click Finish.

* For OpenPages administrative servers, select None.

* For OpenPages non-administrative servers, select Profile Management Tool
to create a profile.

Important: At least one WebSphere Application Server profile is required on
the non-admin server computers to validate the connection from the
OpenPages non-administrative server to the OpenPages administrative
server.

Multicasting in the OpenPages environment

The Fujitsu Interstage BPM software that is installed by IBM OpenPages GRC
Platform requires a multicast IP address. Fujitsu Interstage BPM uses the multicast
IP address to communicate with itself and with other components in the
OpenPages environment.

In a clustered OpenPages environment with multiple Fujitsu Interstage BPM
instances, Fujitsu Interstage BPM requires the multicast IP address to communicate
with each instance.

In a single OpenPages environment with a single Fujitsu Interstage BPM instance,
Fujitsu Interstage BPM requires the multicast IP address to communicate with itself

There are multiple Fujitsu Interstage BPM servers in a single environment and the
multicast IP is used for JMS synchronization in the workflow.

You must obtain a multicast address before installing the OpenPages application.
* The multicast IP address must be unique within the network address space.

* When installing on a secondary server in a horizontal environment, use the
same multicast IP address on all servers.

VMWare configuration requirements on Windows computers

The VMWare performance on a virtualized system is comparable to hardware. You
can use the hardware guidelines for the database server, application server, or
reporting server for sizing VM requirements.

Cloning of OpenPages application server VMs is not supported.

Each VM server computer must meet the following software requirements:
* VMWare ESX Server version 4.1 or 5.0

e VMWare Infrastructure Client version 4.0

* Red Hat KVM 6.0

* Microsoft Windows 2008 R2
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Port assignments

Both dedicated ports and ports that are dynamically assigned for each installation
are used for IBM OpenPages GRC Platform deployments. These default ports can
be changed after installation.

You can change some port settings during the installation. You can also change the
default port settings after installation. For information about changing the ports
after installation, see the IBM OpenPages GRC Platform Administrator’s Guide.
Fixed ports

The following table lists the fixed default ports.

Table 15. Default fixed port assignments

Description Ports
Oracle database server console application port 1158
OpenPages database instance 1521
OpenPages admin server 9060
OpenPages admin server (SSL) 9043
Workflow admin server 9061
Workflow admin server (SSL) 9044
OpenPages application server 10108
OpenPages application server (SSL) 10111
Workflow application server 20108
Workflow application server (SSL) 20111
Cognos Business Intelligence gateway 80
Framework Generator port 8080
Cognos Business Intelligence dispatcher URI 9300

On Windows computers, more OpenPages installations increment by two. For
example, the HTTP ports are 7009, 7011, 7013. The HTTPS ports are 7002, 7004,
7006.

On Windows, more workflow installations also increment by two.

Files containing port numbers

The following tables list property files on the OpenPages admin server that contain
port numbers.

This file contains the HTTP and HTTPS ports for all OpenPages application

instances that are associated with the current admin server. Or, see the individual
server_name-OpenPagesServer#-server.properties files.
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Table 16. Files that contain default port numbers. The file name, port and parameter name

that stores the port information.

File name

Port

Parameter Name

OP_Home/temp/wasconfig/
OpenPagesCell.dmgr.
config.props

OpenPages admin
server port

OpenPages admin
server SSL port

WC_adminhost
WC_adminhost_secure

OP_Home/temp/wasconfig
/OpenPagesCell.

.config.props

OpenPages
application port

WC_defaulthost

server_name-0PNode#Server#

OpenPages
application SSL port

WC_defaulthost_secure

OP_Home/temp/wasconfig/
IBPMCel1.dmgr.
config.props

Workflow admin
server port

Workflow admin
server SSL port

WC_adminhost
WC_adminhost_secure

0P_Home/temp/wasconfig/
IBPMCel1.server_name
-OPNode#
Server.config.props

Workflow application
port

Workflow application
SSL port

WC_defaulthost
WC_defaulthost_secure

Oracle_Home/NETWORK/ADMIN/
tnsnames.ora

Oracle database
instance port

OP_Home/aurora/conf/
aurora.properties

Framework
Generator port

CommandCenter port

Cognos Dispatcher
URI

cognos. framework

cognos.server
cognos.computation.server

Dynamically assigned ports

Port numbers for OpenPages servers that are not listed, such as OpenPages
managed servers, are assigned dynamically during the installation.

OpenPages application and workflow managed server port numbers start at the
following values and increment by 1 for each additional managed server in the

installation:

* OpenPages application managed servers: 9080.

* OpenPages workflow managed servers: 49951.

After installation, you can view all port assignments in OpenPages property files.
There are multiple OpenPages property files, each with a .props extension

ome/temp/wasconfig/*.props).
(OP_Home / temp/ fig/ )

The OpenPages application server and workflow server port information are in:

e OpenPagesCell.dmgr.config.props

* OpenPagesCell.server_name-0PNode#;Server#;.config.props

e IBPMCell.dmgr.config.props

» IBPMCell.server_name-1BPMNode#Server.config.props
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On a cluster system, the OpenPagesCell.server_name-OPNodelServerl.config.props
file and IBPMCel1.server_name-1BPMNodelServer.config.props file contain port
information for that managed server only. If there is a second managed server
within the same computer (vertical cluster), the port information is displayed in
OpenPagesCell.server_name-0PNodelServer2.config.props and
IBPMCel1.server_name-I1BPMNode2Server.config.props.

In a horizontal cluster, the numbering for the managed servers in the .props file
restarts at 1 for each cluster member computer.
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Chapter 5. DB2 client and server setup for OpenPages
installations

To create a DB2 database instance for the OpenPages database, some setup on the
database server and database client computers is required.

Restriction: Two DB2 database instances are required for the IBM OpenPages GRC
Platform installation. One database instance hosts the OpenPages database and one

database instance hosts the Cognos content store database. The requirements for
each database instance are different. For more information, see |“Installing IBM

ICognos Business Intelligence” on page 74/

A heterogeneous mix of client and server operating systems are supported. For
example, you can install IBM OpenPages GRC Platform applications on a Windows
operating system and install the OpenPages database on Linux or AIX operating
systems. You can also install the OpenPages application server on Linux or AIX
operating systems and install the OpenPages database on a Windows operating
system.

Before you install DB2 database products, ensure that your system meets the
required system requirements. For more information about the supported software
environments for OpenPages, see lsupported software environments on the IBM
support website (http://www.ibm.com/support/docview.wss?uid=swg27037756)

For more information about DB2 system requirements, see the|DB2 for Linux|

[UNIX, and Windows system requirements|in the DB2 Information Center.

DB2 server installations

To use a DB2 database for the OpenPages repository, review the specific
requirements for your system before you install DB2 products.

Ensure that your system meets the required system requirements. [Review the IBM|
OpenPages GRC Platform supported software environments and other system|

requirements| on the IBM Support website.

Review the following tasks
___* Install DB2 database server.

The DB2 database server that hosts the OpenPages database must have the
required server software installed. DB2 10.1 Fix Pack 1 must be installed
before you install the DB2 Universal Fix Pack.

The following table lists the DB2 software requirements by operating system.

Table 17. Required DB2 10.1.0.1 software for OpenPages

Operating system Universal Fix Pack
Windows 1. DB2 Server Fix Pack 1
2. Universal Fix Pack Special_30205 for
Windows
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Table 17. Required DB2 10.1.0.1 software for OpenPages (continued)

Operating system Universal Fix Pack

Linux 1. DB2 Server Fix Pack 1

2. Universal Fix Pack Special_30155 for
Linux-64

AIX

1. DB2 Server Fix Pack 1

2. Universal Fix Pack Special_30070 for
AIX-64

Restriction: The OpenPages installation program does not support
installations of DB2 server products or DB2 client software in directories that
contain spaces. To use DB2 software that is installed in a directory with
spaces, you can enter the short file name convention in the OpenPages
Administrative Console. For example, for C:\Program Files\IBM\DB2\SQLLIB ,
use C:\PROGRA~I\IBM\DB2\SQLLIB.

Important: DB2 Text Search component is required.

DB2 Text Search component is an optional installable component. To install it,
you must select the custom installation type and the DB2 Text Search
component. For more information, see the [Installing and configuring DB2 Tex{]
in the DB2 Information Center.

If DB2 database server is installed on your computer, use the DB2 setup
program to add the DB2 Text Search function to your existing DB2 copy.

To determine whether text search is installed, run the db2ts command to start
or stop the text search. If the command fails, text search is not installed. For
more information about running the command, see [the DB2 search commands|
in the DB2 Information Center.

Set up the required users and groups}

Set up the DB2 database instance for the OpenPages repositoryl

Related concepts:

[“Prerequisite software for the database server” on page 27|

In addition to the software required for all servers, ensure that the prerequisite
software is installed on the database server.

“Operating system user accounts for OpenPages and Cognos BI installations that|

use DB2 databases’]

Operating system user accounts affect the procedures that are used to create the
OpenPages database and Cognos Business Intelligence content store.

Operating system user accounts for OpenPages and Cognos Bl
installations that use DB2 databases

Operating system user accounts affect the procedures that are used to create the
OpenPages database and Cognos Business Intelligence content store.
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DB2 instance owner

The DB2 instance owner controls all DB2 processes and owns all file
systems and devices that are used by the databases within the database
instance. For Windows operating systems, the default user is db2admin, For
Linux and AIX operating systems, the default user is db2inst1.
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The user account for the DB2 instance owner is created as a prerequisite
step to installing DB2 software and instance.

DB2 administration server (DAS) user
The user ID for the DB2 administration server user. For Windows
operating systems, the default user is db2admin, For Linux and AIX
operating systems, the default user is dasusrl.

Important: To simplify user administration, when you install the DB2
database instance, ensure that you assign the DB2 instance owner as the
DAS user.

OpenPages installation user
The OpenPages installation user installs IBM OpenPages GRC Platform.
The user account can choose to create the OpenPages database
automatically by using the OpenPages Administrative Console installation
program or manually by running scripts.

Restriction: On Windows operating systems, if the OpenPages installation
user is not the same as the DB2 instance owner, the OpenPages installation
user must run the dba-grant.sql script. The script explicitly grants control
on SYSTOOLS schema objects to DB2 database instance owner. Running
the script is documented in the list of tasks to manually create the
OpenPages database. If you use the OpenPages Administrative Console to
create the OpenPagesdatabase, running the script is documented as a post
installation task.

Database schema owners

The following three database user accounts must exist before you install IBM
OpenPages GRC Platform and Cognos Business Intelligence:

* OpenPages database user account.

* Workflow database user account

* Cognos content store user account

Restriction: On Linux and AIX operating systems, the user name for the
OpenPages and workflow database user accounts must not be the same as the

group name. For example, opuser:opuser is not allowed.

DB2 guidelines for creating users

Follow the [DB2 guidelines for creating user names|in the DB2 Information Center
(http:/ /pic.dhe.ibm.com/infocenter/db2luw /v10rl/index.jsp?topic=
%2Fcom.ibm.db2.luw.admin.dbobj.doc%2Fdoc%2Fc0007248.html).

* On UNIX and Linux operating systems, user names can contain 1-8 characters.

* On Windows operating systems, user names can contain 1-20 characters.
¢ Group and instances names can contain 1-8 characters.

* Names cannot begin with a number or underscore (_) characters.

Enabling users other than DB2 database instance owner to
create the OpenPages repository

Users other than those users who installed the DB2 database instance can create
the OpenPages and workflow schemas.
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For example, the user who runs the IBM OpenPages GRC Platform Administrative
Console can create the schemas. The user who creates the OpenPages repository in
DB2 must have privileges to create a database, a tablespace, tables, and indexes.

Procedure
1. Identify the DB2 administrators group.
The group is created when you install the DB2 instance.

For Windows installations, the default administrators group name is
DB2ADMNS.

For Linux or AIX installations the default group name is db2iadml.
2. Invoke the DB2 Command Line Processor (CLP).
* On Windows computers, start the DB2 CLP from the Start menu by clicking

All Programs > IBM DB2 > DB2COPY1, or typing db2cmd from the
command line,

* On Linux and AIX installation systems, open the command line of the DB2
instance.
3. From the command-line, type the following commands:

db2 update dbm cfg using SYSADM_GROUP <DB2 admin_group>
db2 update dbm cfg using SYSCTRL_GROUP <DBZ_admin_group>
db2stop
db2start

4. Add the user who is not the DB2 instance owner to the <DB2_admin_group>.

* For DB2 installations on Windows computers, add the user to the
DB2ADMNS group.

¢ For DB2 installations on AIX or Linux computers, add the user to the
db2iadml group.

5. Log on to the DB2 client computer or DB2 server computer as the user you
added to the <DB2_admin_group>.

Related tasks:

[“Manually creating database objects in the OpenPages database” on page 52|
You can run scripts to manually create the required database objects in DB2 for the
OpenPages repository.

Preparing the DB2 database instance for OpenPages on the database
server

You must prepare the DB2 database instance that is used for the OpenPages
repository.
__* Enable the Oracle compatibility mode.

Important: Oracle compatibility mode must be enabled for DB2 database
instance that is used for the OpenPages and workflow schemas. Oracle
compatibility mode must not be enabled for the separate DB2 database
instance that is used for content store.

* Update the database manager configuration for the OpenPages database
instance.

* Copy the Java routine class files to the DB2 server from the OpenPages
installation files.

* Enable and configure DB2 text search.

For more information, see thelBM OpenPages GRC Platform Administrator’s
Guide.
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Before you begin

Ensure that you installed a supported version of the DB2 database server software
by checking |the supported software environments on the IBM support|
websitesupported version of DB2 database server software on the IBM support|
web site| (http:/ /www.ibm.com/support/docview.wss?uid=swg27037756).

To verify the current version and service level of the installed DB2 product, use the
db21evel command. By default, output from the command goes to the console.

Examples:

On Windows operating systems, the db2level command must show a supported
version and service level.

DB21085I This instance or install (instance name, where applicable: "DB2_01")
uses "64" bits and DB2 code release "SQL10011" with level identifier

"0202010E".

Informational tokens are "DB2 v10.1.100.148", "special_30069", "IP23379_30069",
and Fix Pack "1".

Product is installed at "C:\SQLLIB" with DB2 Copy Name "DB2COPY1".

On Linux operating systems, the db2level command must show a supported
version and service level.

DB210851 This instance or install (instance name, where applicable:
"db2inst4") uses "64" bits and DB2 code release "SQL10011" with Tevel
identifier "0202010E".

Informational tokens are "DB2 v10.1.0.1", "special_30155", "IP23384 30155", and
Fix Pack "1".

Product is installed at "/opt/ibm/V10.1_03".

On AIX operating systems, the db21evel command must show a supported version
and service level.

DB210851 This instance or install (instance name, where applicable:

"db2inst4") uses "64" bits and DB2 code release "SQL10011" with Tevel

identifier "0202010E".

Informational tokens are "DB2 v10.1.0.1", "special _30070", "IP23384 30070", and

Fix Pack "1".

Product is installed at "/opt/ibm/V10.1_03".

Procedure
1. Log on to the DB2 database server as the DB2 instance owner.

2. Go to the location where you extracted the installation files from the IBM
OpenPages GRC Platform Installer version for WebSphere Application Server
DVD.
¢ On Windows operating system, go the following directory:

\WIN64-0P_version\OpenPages\Win64\
OP_version _Non_Embedded WAS Oracle DB2 WIN64\OP_version Configuration\
Database\DB2\INSTALL_SCRIPTS

* On AIX operating systems, go the following directory:

/AIX64-0P_version/OpenPages/AIX64/0P_version_Non_Embedded DB2_AIX64/
OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS

¢ On Linux operating systems, go to the following directory:

\Linux64-0Pversion/OpenPages/Linux64/0P_version_Non_Embedded_ LINUX64/
OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS

3. On Linux and AIX computers, ensure that DB2 instance owner has execute
permission on the scripts in the INSTALL_SCRIPTS directory.
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* If the DB2 instance owner owns the directory, type the following command:
chmod -R 755 /path/INSTALL_SCRIPTS

e If the DB2 instance owner belongs to the same group as the user who owns
the directory, type the following command:

chmod -R 775 /path/INSTALL_SCRIPTS
* If the DB2 instance owner is part of others, type the following command:
chmod -R 777 /path/INSTALL_SCRIPTS
4. To enable Oracle compatibility mode, type the following command:

* On Windows operating systems, from the Start menu, click All Programs >
IBM DB2 > DB2COPY1 > Command Window - Administrator and type:
enable-ora-compatibility.bat

Note: If you have multiple instances of DB2, server, ensure that you choose
the DB2COPY of the OpenPages database instance.

* On AIX or Linux operating systems, type: ./enable-ora-compatibility.sh

Restriction: DB2 compatibility features are enabled at the database level and
cannot be disabled. Keep the selected compatibility level for the life of the
OpenPages database.

To confirm that Oracle compatibility mode is set, type db2set -all. One of the
DB2 profile variables that are listed is DB2_COMPATIBILITY_VECTOR=0ORA

5. Copy the Java routine class files (UDFs) for OpenPages to the DB2 server.

a. Go to the /0P_version Configuration/Database/DB2/INSTALL SCRIPTS
directory.

b. Copy the following files to the DB2_HOME\FUNCTION directory:
* opconvert.class
* regexp.class

On Windows operating systems, the default installation location is
path\ibm\SQLLIB\FUNCTION.

On AIX or Linux operating systems, the default location is
/home/db2_instance_owner/sql1ib. Type the following commands:

cp opconvert.class $DB2 _HOME/function
cp regexp.class $0B2_HOME/function

6. Update the database manager configuration for the OpenPages database
instance.

a. At the command prompt, on Window operating systems, type db2cmd to
initialize the DB2 command line processor (CLP)

b. In the DB2 CLP, run the opx-dbm-cfg script.
* On Windows operating systems, type the following command:
opx-dbm-cfg.bat
* On AIX or Linux operating systems, type the following command:
./opx-dbm-cfg.sh

7. [Enable and configure text search.|

What to do next

Create the database schema manually for OpenPages on the database server or on
a database client computer. You can also create the database schema automatically
during the installation by selecting Install Now for the Schema option in the
OpenPages Administrative Console
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DB2 database client installations

You must install an appropriate DB2 database client to enable connections between
the OpenPages application servers and remote DB2 databases.

Use the following checklist to guide you through the required setup:

Install the DB2 client software.

Use the DB2 Setup wizard to install the IBM Data Server Client.

For information about the panels in the DB2 Setup wizard, see
[wizard installation walkthrough|

For information about the installation methods for IBM data server clients in
AIX and Linux environments, see [Installing IBM data server clients (Linux|

fnd ONDX]

Create a DB2 database client instance on the client computer (AIX and Linux
only).

Configure the DB2 client and server connection.
Test the connection between the database server and the client.

Creating and configuring a DB2 client instance in AIX and
Linux environments

If the OpenPages application server is on a separate Linux or AIX computer than
the database server, you must create a DB2 client instance on .

In Windows environments, the client instance is created by default when the client
software is installed.

For more information, see the |[db2icrt - Create instance command]topic in the DB2
Information Center.

Procedure

1.
2.

Log on to the client computer as a root user.
Go to the DB2DIR/instance/ directory.
DB2DIR is installation location of the DB2 client software.

* On AIX operating systems, the default DB2 installation directory is
/opt/1BM/db2/version/instance.

* On Linux operating systems, the default installation directory is
/opt/ibm/db2/version/instance.

To create an instance for a client, type the following command:
db2icrt -s client <instname>

-5 option is used when you create an instance other than the default instance
that is associated with the installed product from which you run the db2icrt
command.

instname is the login name of the instance owner.

Example: db2icrt -s client db2inst2

The default location for the DB2 instance is in the /home/db2inst2/sql1ib
directory.
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Manually creating the OpenPages database locally on the DB2 server
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IBM OpenPages GRC Platform requires an OpenPages database. One option is to
manually create the OpenPages database locally on the server.

If you want to automatically create the database during the installation, you can
select the Install now option in the Administrative Console installation program.

Procedure

1.

Log on to the DB2 database server computer as the DB2 database instance
owner.

Go to the /0P_version_Configuration/Database/DB2/INSTALL_SCRIPTS directory.

Edit the sql-wrapper.sql file to ensure that the variables are set correctly for
your environment and save the changes.

Restriction: Do not change the following properties:
e define super_admin_username='0OpenPagesAdministrator’
* define super_admin_password='0OpenPagesAdministrator'

To change these settings, from the INSTALL_SCRIPTS directory, open the
op-app-global-env.sql file in a text editor.

If the DB2 instance owner does not have write permission on the
sql-wrapper.sql file, switch users, or change the permission on the file by
using the chmod command.

¢ On Windows operating systems, if required, modify the following properties
to suit your environment.
define opx_base_currency_iso_code="USD'
define opx_dflt_stor_srv_root='c:\OpenPages\openpages-storage
define opx_op_admin_name="'OpenPagesAdministrator'
define opx_op_admin_pwd="'0penPagesAdministrator'
* On AIX or Linux operating systems, if required, modify the following
properties to suit your environment.
define opx_base currency iso_code='USD'
define opx_df1t_stor_srv_root='opt/openpages-storage/
define opx_op_admin_name="'0OpenPagesAdministrator'
define opx_op_admin_pwd="'0OpenPagesAdministrator'
From the INSTALL_SCRIPTS directory, open the op-app-global-env.sql script in
a text editor and if required, modify the following values for the Super
Administrator.
define super_admin_username='0OpenPagesAdministrator'
define super_admin_password='0OpenPagesAdministrator'
On Windows, start the DB2 command line processor (CLP) from the Start
menu, by clicking All Programs > IBM DB2 > DB2COPY1 > Command
Window - Administrator

To create the database for OpenPages, run the create-opx-db-srv script from
the command line.

Use the following table to replace the variables in the command-line options
with values that are suitable for your environment.

Table 18. Options for the create-opx-db-srv script.

Variable Description
database-name The name of the OpenPages database
path The location of the database on the server
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Table 18. Options for the create-opx-db-srv script. (continued)

Variable Description

catalog_path The location of the database alias on the
local server

On Windows operating systems, the
catolog_path is the drive letter (C: or E:). On
Linux or AIX operating systems, catolog_path
is the absolute path (/db2data

¢ On Windows operating systems, type the following command:
create-opx-db-srv.bat <database-name> <path> <catalog_path>

Example: A database named 0Pdb621 is created. The database and database
alias are on the D: drive.

create-opx-db-srv.bat OPdb621 D: D:
* On AIX or Linux operating systems, type the following command:
./create-opx-db-srv.sh <database-name> <path> <catalog path>

Tip: Ensure that you grant execute permission on the create-opx-db-srv.sh
script file before you run it: chmod u+x opx-dbm-cfg.sh

Example: A database named 0Pdb621 is created. The database and database
alias are in the /db2data directory.
./create-opx-db-srv.sh OPdb621 /db2data /db2data
7. If the database server is on a Windows operating system and the OpenPages
installation user is not the DB2 database instance owner, run the following
script.

clpplus -nw <username>/<password>@<hostname>:<portnumber>/<database-name>
@sql-wrapper dba-grant.sql dba-grant.log <instance.owner.username>

* username variable is the user name of the OpenPages installation user (the
user that is logged in to the system).

* password variable is the password of the OpenPages installation user.
* instance.owner.username variable is the DB2 database instance owner (the user
who creates the database instance).

If the OpenPages installation user is the same as the DB2 database instance
owner, no action is required. The script explicitly grants control on the
SYSTOOLS schema objects to DB2 database instance owner.

8. If the database server is on a Windows-based computer, the OpenPages
installation user is not the DB2 database instance owner, and the DB2 database
instance owner is not the DB2 administration server (DAS) user, run the
following script.

clpplus -nw <username>/<password>@<hostname>:<portnumber>/<database-name>
@sql-wrapper dba-grant.sql dba-grant.log <das_user_name>

* username variable is the user name of the OpenPages installation user (the
user that is logged in to the system).

* password is the password of the OpenPages installation user.
* das_user_name is the DB2 Administration server (DAS) user account.

The script explicitly grants control on the SYSTOOLS schema objects to DAS
user.
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What to do next

Run the scripts from the database server or from the OpenPages application server
to create the database objects.

Creating the OpenPages database remotely from the OpenPages
application server

If your OpenPages application server is not on the same computer as your
OpenPages database server, you can create the OpenPages database remotely.

Before you begin

Ensure that you set up the DB2 database instance on the server computer:
* Enable the Oracle compatibility mode.

¢ Update the database manager configuration for the OpenPages database
instance.

* Copy the Java routine class files to the DB2 server from the OpenPages
installation files.

* Enable and configure DB2 text search.

Procedure
1. Log on to the OpenPages application server computer as the DB2 administrator.
2. Start the DB2 command line processor.

On Windows operating systems, from the command prompt, type db2cmd, or
from the Start menu, click All Programs > DB2COPY1 > Command Window -
Administrator.

3. Go to the /OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS directory.
4. To catalog the node, run the following script:

* On Windows operating systems, type db2-catalog-node.bat <node_name>
<hostname> <port>.

* On AIX or Linux operating systems, type ./db2-catalog-node.sh
<node_name> <hostname> <port>.

Table 19. Command-line variables for the script to catalog a node

Variable name Description
node_name The node name of the database partition
server.

The node name represents a local nickname
that you can set for the computer that
contains the database you want to catalog.

hostname The host name or the IP address of the node
where the target database is installed.

port The port that the database server uses.

The default port is 50000.

Example: On Windows operating systems:
db2-catalog-node.bat OPNode OPAdmin 50000

Example: On AIX or Linux operating systems:

50 1BM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide



db2-catalog-node.sh OPNode OPAdmin 50000
5. To create the database for OpenPages, run the create-opx-db-c1t script.
Replace the variables with your system values:
* database-name is the name of the OpenPages database.
* path is the location to create the database on the server.
* catalog_path is the location of the database alias on the local computer.
* node_name is the cataloged node name.
* instance.owner.usrname is the user name of the DB2 account that owns the
instance on the remote computer.

* instance.owner.password is the password for the account that owns the
database instance.

¢ On Windows operating systems, type the following command:

create-opx-db-clt.bat <database-name>
<path> <catalog_path>

<node_name> <instance.owner.username>
<instance.owner.password>

Example: Create a remote database on AIX or Linux operating systems from
a Windows-based computer. The DB2 database instance owner on the remote
computer is db2instl.

create-opx-db-clt.bat OPdb621 /usr /usr
OPNode db2instl Db2_1234

* On AIX or Linux operating systems, type the following command:

create-opx-db-srv.sh <database_name> <path>
<catalog_path>

Example: Create a remote database on a Linux operating from an AIX-based
computer. The DB2 database instance owner on the remote computer is
db2instl
create-opx-db-clt.sh 0Pdb621 /usr /usr
OPNode db2instl Db2_1234
6. If the database server is on a Windows operating system and the OpenPages
installation user is not the DB2 database instance owner, run the following
script.
clpplus -nw <username>/<password>@<hostname>:<portnumber>/<database-name>
@sql-wrapper dba-grant.sql dba-grant.log <instance.owner.username>
* username variable is the user name of the OpenPages installation user (the
user that is logged in to the system).

* password variable is the password of the OpenPages installation user.

* instance.owner.username variable is the DB2 database instance owner (the user
who creates the database instance).

If the OpenPages installation user is the same as the DB2 database instance
owner, no action is required. The script explicitly grants control on the
SYSTOOLS schema objects to DB2 database instance owner.

7. If the database server is on a Windows-based computer, the OpenPages
installation user is not the DB2 database instance owner, and the DB2 database
instance owner is not the DB2 administration server (DAS) user, run the
following script.

clpplus -nw <username>/<password>@<hostname>:<portnumber>/<database-name>
@sql-wrapper dba-grant.sql dba-grant.log <das_user_name>

* username variable is the user name of the OpenPages installation user (the
user that is logged in to the system).
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* password is the password of the OpenPages installation user.
* das_user_name is the DB2 Administration server (DAS) user account.

The script explicitly grants control on the SYSTOOLS schema objects to DAS
user.

Results

If you have problems when you run the scripts to create the database objects, you
can remove the database objects and start again. The following table lists the
scripts to help you drop the database and to uncatalog the node.

Table 20. . Scripts to drop the database and to uncatalog the node.

Description | Script

Drop the drop-opx-db-clt. (bat|sh) <database-name>
database <node-name> <instance.owner.username>
<instance.owner.password>

Uncatalog | db2-uncatalog-node. (bat|sh)
the node <node-name>

Related tasks:

[‘Manually creating database objects in the OpenPages database”]

You can run scripts to manually create the required database objects in DB2 for the
OpenPages repository.

Manually creating database objects in the OpenPages database
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You can run scripts to manually create the required database objects in DB2 for the
OpenPages repository.

Procedure

1. Log on to the DB2 database server computer as a user who plans to install
OpenPages GRC Platform.

2. Go to the /OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS directory.
¢ On Windows operating systems, go the following directory:

\WIN64-0P_version\OpenPages\Win64\
OP_version Non_Embedded WAS Oracle DB2 WIN64\OP_version Configuration\
Database\DB2\INSTALL_SCRIPTS

* On AIX operating systems, go the following directory:

/AIX64-0P_version/OpenPages/AIX64/0P_version Non_Embedded DB2 AIX64/
OP_version Configuration/Database/DB2/INSTALL SCRIPTS

* For Linux operating systems, go the following directory:

\Linux64-0Pversion/OpenPages/Linux64/0P_version_Non_Embedded_LINUX64/
OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS

3. On Windows operating systems, start the DB2 command line processor (CLP).

4. For Windows operating systems, use the following table to run the required
scripts in order.:
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Table 21. Scripts to create the OpenPages database in DB2 on Windows-based computers

Script description

Windows-based computers

Create the clpplus -nw <instance.owner.usrname>/<instance.owner.password>
bufferpool and @<hostname>:<port-number>/<database-name>
tablespaces @sql-wrapper create-opx-tablespaces.sql
create-opx-tablespaces.log
Replace the variables with your system values:
* instance.owner.usrname is the user name of the DB2 account that
owns the instance.
* instance.owner.password is the password for the account that owns
the database instance.
* hostname is the database server computer name. database-name is the
name of the OpenPages database.
* port-number is the port that the database instance uses.
* database name is the name of the OpenPages database.
* -nw specifies that the CLPPlus session is started in the current
command-line window.
Example: The instance owner is db2admin. The database instance is on
a server named OP and uses the default DB2 port, 50000.
clpplus -nw DB2ADMIN/Db2_1234@0P:50000/0Pdb621
@sql-wrapper create-opx-tablespaces.sql
create-opx-tablespaces.log
Grant clpplus -nw <instance.owner.usrname>/<instance.owner.password>

authorizations and
create schema

@<hostname>:<port-number>/<database-name>
@sql-wrapper create-opx-schema-owner.sql
create-opx-schema-owner.log
<openpages.db.username>

openpages.db.username is the user name that belongs to the user
account that owns the OpenPages database schema.

Example: The openpages user owns the database schema for
OpenPages.

clpplus -nw DB2ADMIN/Db2_1234@0P:50000/0Pdb621
@sql-wrapper create-opx-schema-owner.sql
create-opx-schema-owner.log openpages

Create tables,
sequences, and
indexes

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper AuroraDBCreate.sql AuroraDBCreate.log

Example: The openpages user account logs in to the 0Pdb621 to create
database objects.

clpplus -nw openpages/openpages123@0P:50000/0Pdb621
@sql-wrapper AuroraDBCreate.sql AuroraDBCreate.log

Create views

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name>
@sqTl-wrapper AuroraDbViews.sql AuroraDbViews.log

Example: The openpages user account logs in to the 0Pdb621 to create
database views.

clpplus -nw openpages/openpages123@0P:50000/0Pdb621
@sql-wrapper AuroraDbViews.sql AuroraDbViews.log
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Table 21. Scripts to create the OpenPages database in DB2 on Windows-based
computers (continued)

Script description

Windows-based computers

Load PL/SQL
(Procedural
Language/
Structured Query
Language)

AuroraProcCreate.bat <database-name>
<openpages.db.username> <openpages.db.password>

Example: The openpages user account runs the script to load PL and
SQL files.

AuroraProcCreate.bat OPdb621 openpages openpagesl23

The load might take awhile to complete.

Revalidate PL/SQL

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name>

@sql-wrapper revalidate.sql revalidate.log
<openpages.db.username>

Example: Revalidate OPdb621 packages

clpplus -nw openpages/openpages123@0P:50000/0Pdb621
@sql-wrapper revalidate.sql revalidate.log openpages

Rebind all
packages

db2rbind <database-name> -1 oprbind.Tog -u
<openpages.db.username> -p <openpages.db.password>
-r any

Example: Rebind 0Pdb621 packages

db2rbind OPdb621 -1 oprbind.log -u openpages
-p openpagesl23 -r any

Load bootstrap
data

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name >

@sql-wrapper AuroraDblLoad.sql AuroraDbload.log

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name>

@sql-wrapper Toad_OP_APP_DATA.sql load_OP_APP_DATA.log

Example: The openpages user account runs the script to load data
into the OPdb621 database.

clpplus -nw openpages/openpages123@0P:50000/0Pdb621
@sql-wrapper AuroraDblLoad.sql AuroraDbLoad.log

Note: The scripts take awhile to complete.

clpplus -nw openpages/openpages123@0P:50000/0Pdb621
@sql-wrapper Toad_OP_APP_DATA.sql load_OP_APP_DATA.Tog

Create the
workflow schema
and tablespaces

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname>:<port-number>/<database-name >

@sql-wrapper ibpm-create-ts-schema-owner.sql
ibpm-create-ts-schema-owner.log

<opworkflow.db.username>

opworkflow.db.username is the owner of the workflow schema in the
OpenPages database.

Example: The opworkflow user owns the workflow database schema.
Ensure that the user belongs to the DB2ADMINS group on the
operating system.

clpplus -nw db2admin/Db2_1234@0P:50000/0Pdb621

@sql-wrapper ibpm-create-ts-schema-owner.sql
ibpm-create-ts-schema-owner.log opworkflow

IBM OpenPages GRC Platform Version 6.2.1:

Deploying to WebSphere Application Server Installation Guide




Table 21. Scripts to create the OpenPages database in DB2 on Windows-based
computers (continued)

Script description

Windows-based computers

Create workflow
tables

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-create-tables.sql ibpm-create-tables.log

Example: The opworkflow user connects to the OpenPages database to
create tables.

clpplus -nw opworkflow/opworkflowl23@0P:50000/0Pdb621
@sql-wrapper ibpm-create-tables.sql ibpm-create-tables.log

Create workflow
views

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-create-views.sql ibpm-create-views.log

Example: The opworkflow user connects to the OpenPages database to
create views.

clpplus -nw opworkflow/opworkflowl23@0P:50000/0Pdb621
@sql-wrapper ibpm-create-views.sql

ibpm-create-views.log

Load workflow
procedures

ibpm-proc-create.bat <database-name>
<opworkflow.db.username> <opworkflow.db.password>

Example: The opworkflow user runs the script to load workflow
procedures into the 0Pdb621 OpenPages database

ibpm-proc-create.bat OPdb621 opworklfow opworkflowl23 -ni

Load workflow
bootstrap data

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-data-Toad.sql ibpm-data-Toad.log

Example: The opworkflow connects to the 0Pdb621 OpenPages
database to load the workflow bootstrap data.

clpplus -nw opworkflow/opworkflowl23@0P:50000/0Pdb621
@sql-wrapper ibpm-data-Toad.sql ibpm-data-load.log

Create synonyms
for database objects
in workflow
schema into
OpenPages schema

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname>:<port-number>/<database-name >

@sql-wrapper dba_integrate_iflow.sql dba_integrate_iflow.log
<openpages.db.username>

<opworkflow.db.username>

Example: The db2admin user connects to the OPdb621 database to
create synonyms.
clpplus -nw db2admin/Db2_1234@0P:50000/0Pdb621

@sql-wrapper dba_integrate_iflow.sql
dba_integrate_iflow.Tog openpages opworkflow

5. For Linux or AIX installations, use the following table to run the required

scripts in order.
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Table 22. Scripts to create the OpenPages database in DB2 on AIX or Linux operating

systems

Script description

Windows-based computers

Create the
bufferpool and
tablespaces

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname> <port-number>/<database-name>

@sql-wrapper create-opx-tablespaces.sql
create-opx-tablespaces.log

Replace the variables with your system values:

* instance.owner.usrname is the user name of the DB2 account that
owns the instance.

* instance.owner.password is the password for the account that owns
the database instance.

* hostname is the database server computer name. database-name is the
name of the OpenPages database.

* port-number is the port that the database instance uses.

* database name is the name of the OpenPages database.

e -nw runs the script without being prompted.

Example: The instance owner is db2instl. The database instance is on
a server named OP and uses the default DB2 port, 50000.

clpplus -nw db2inst1/Db2_1234@0P:50000/0Pdb621
@sql-wrapper create-opx-tablespaces.sql
create-opx-tablespaces.log

Grant
authorizations and
create schema

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname>:<port-number>/<database-name>

@sql-wrapper create-opx-schema-owner.sql
create-opx-schema-owner.1og

<openpages.db.username>

openpages.db.username is the user name that belongs to the user
account that owns the OpenPages database schema.

Example: The opuser user owns the database schema for
OpenPages.Ensure that the user name is less than 8 characters.
clpplus -nw db2inst1/Db2_1234@0P:50000/0Pdb621

@sql-wrapper create-opx-schema-owner.sql
create-opx-schema-owner.log opuser

Create tables,
sequences, and
indexes

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper AuroraDBCreate.sql AuroraDBCreate.log

Example: The opuser user account logs in to the 0Pdb621 to create
database objects.

clpplus -nw opuser/opuserl23@0P:50000/0Pdb621
@sql-wrapper AuroraDBCreate.sql AuroraDBCreate.log

Create views

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper AuroraDbViews.sql AuroraDbViews.log

Example: The opuser user account logs in to the 0Pdb621 to create
database views.

clpplus -nw opuser/opuserl23@0P:50000/0Pdb621
@sql-wrapper AuroraDbViews.sql AuroraDbViews.log
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Table 22. Scripts to create the OpenPages database in DB2 on AlX or Linux operating

systems (continued)

Script description

Windows-based computers

Load PL/SQL
(Procedural
Language/
Structured Query
Language)

./AuroraProcCreate.sh <database-name>
<openpages.db.username> <openpages.db.password>

Example: The opuser user account runs the script to load PL and SQL
files.

./AuroraProcCreate.sh 0OPdb621 opuser opuserl23

Revalidate PL/SQL

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name>
<openpages.db.username>

@sql-wrapper revalidate.sql revalidate.log
<openpages.db.username>

Example: Revalidate OPdb621 packages

clpplus -nw opuser/opuserl23@0P:50000/0Pdb621
@sql-wrapper revalidate.sql revalidate.log opuser

Rebind all
packages

db2rbind <database-name> -1 oprbind.Tog -u
<openpages.db.username>
-p <openpages.db.password> -r any

Example: Rebind 0Pdb621 packages

db2rbind 0Pdb621 -1 oprbind.log -u opuser
-p opuserl23 -r any

Load bootstrap
data

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper AuroraDblLoad.sql AuroraDblLoad.log

clpplus -nw <openpages.db.username>/<openpages.db.password>
@<hostname>:<port-number>/<database-name>
@sql-wrapper Toad_OP_APP_DATA.sql load_OP_APP_DATA.Tog

Example: The opuser user account runs the script to load data into
the OPdb621 database.

clpplus -nw opuser/opuser123@0P:50000/0Pdb621
@sql-wrapper AuroraDblLoad.sql AuroraDblLoad.log

Note: The scripts take awhile to complete.

clpplus -nw opuser/opuserl23@0P:50000/0Pdb621
@sql-wrapper load_OP_APP_DATA.sql load_OP_APP_DATA.Tog

Create the
workflow schema
and tablespaces

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname>:<port-number>/<database-name >

@sqT-wrapper ibpm-create-ts-schema-owner.sql
ibpm-create-ts-schema-owner.log

<opworkflow.db.username>

opworkflow.db.username is the owner of the workflow schema in the
OpenPages database.

Example: The opwork user owns the workflow database schema.
Ensure that the user name is 8 or less characters

clpplus -nw db2inst1/Db2_1234@0P:50000/0Pdb621

@sql-wrapper ibpm-create-ts-schema-owner.sql
ibpm-create-ts-schema-owner.log opwork
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Table 22. Scripts to create the OpenPages database in DB2 on AIX or Linux operating

systems (continued)

Script description

Windows-based computers

Create workflow
tables

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-create-tables.sql ibpm-create-tables.log

Example: The opwork user connects to the OpenPages database to
create tables.

clpplus -nw opwork/opwork123@0P:50000/0Pdb621
@sql-wrapper ibpm-create-tables.sql ibpm-create-tables.log

Create workflow
views

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-create-views.sql ibpm-create-views.log

Example: The opwork user connects to the OpenPages database to
create views.

clpplus -nw opwork/opwork123@0P:50000/0Pdb621

@sql-wrapper ibpm-create-views.sql

ibpm-create-views.log

Load workflow
procedures

ibpm-proc-create.sh <database-name>
<opworkflow.db.username> <opworkflow.db.password>

Example: The opwork user runs the script to load workflow
procedures into the 0Pdb621 OpenPages database

./ibpm-proc-create.sh 0Pdb621 opwork opworkl23

Load workflow
bootstrap data

clpplus -nw <opworkflow.db.username>/<opworkflow.db.password>
@<hostname>:<port-number>/<database-name >
@sql-wrapper ibpm-data-Toad.sql ibpm-data-load.log

Example: The opworkflow connects to the 0Pdb621 OpenPages
database to load the workflow bootstrap data.

clpplus -nw opwork/opwork123@0P:50000/0Pdb621
@sql-wrapper ibpm-data-Toad.sql ibpm-data-load.log

Create synonyms
for database objects
in workflow
schema into
OpenPages schema

clpplus -nw <instance.owner.usrname>/<instance.owner.password>
@<hostname>:<port-number>/<database-name >

@sql-wrapper dba_integrate_iflow.sql dba_integrate_iflow.log
<openpages.db.username>

<opworkflow.db.username>

Example: The db2admin user connects to the 0Pdb621 database to
create synonyms.

clpplus -nw db2inst1/Db2_1234@0P:50000/0Pdb621
@sql-wrapper dba_integrate_iflow.sql
dba_integrate_iflow.Tog opuser opwork
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Related tasks:

“Enabling users other than DB2 database instance owner to create the OpenPages|
repository” on page 43

Users other than those users who installed the DB2 database instance can create
the OpenPages and workflow schemas.

Testing the connection between the DB2 client and server

If the OpenPages Application Server is not on the same computer as the database
server, test the connection. Ensure that you can connect to the DB2 server from the
OpenPages Application server computer.

Before you begin

You must have System Administrative (SYSADM) or System Controller (SYSCTRL)
authority. Otherwise, ensure that the catalog_noauth option is set to ON. You
cannot use root authority when you catalog a node.

Procedure
1. Log on to the OpenPages Application Server as a DB2 user.
2. Start the DB2 command line processor.

On Windows computers, from the command prompt, type db2cmd, or from the
Start menu, click All Programs > DB2COPY1 > Command Window -
Administrator.

3. Test the connection from the client to the database.
a. Start the DB2 command line processor.

On Windows computers, from the command prompt, issue the db2cmd
command.

On UNIX computers, from the command prompt, issue db2 commands.

b. To verify that the node was created, issue the following command to list the
contents of the node directory:

db2 Tist node directory show detail
A list of the nodes that you created is displayed.
Node Directory

Number of entries in the directory =1

Node 1 entry:

Node name = OPNode_Name

Comment =

Directory entry type = LDAP

Protocol = TCPIP

Hostname = database_server_name
Service name = 50000

c. To verify that the node was created, issue the following command to list the
contents of the node directory:

db2 Tist database directory
A list of the databases are displayed.

d. To connect to the remote database from the client, type the following
command

db2 => connect to database_alias user userid

Example: connect to opdb user opuser
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If the connection is successful, a message similar to the following is
displayed:

Database Connection Information
Database server = DB2 10.2.0
SQL authorization ID = opuser
opdb

Local database alias
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Chapter 6. Oracle database server setup for OpenPages
installations

Install and configure database server software to use with IBM OpenPages GRC
Platform.

A heterogeneous mix of client and server operating systems are supported. For
example, you can install IBM OpenPages GRC Platform applications on a Windows
operating system and install the OpenPages database on Linux or AIX operating
systems. You can also install the OpenPages application server on Linux or AIX
operating systems and install the OpenPages database on a Windows operating
system.

Install the database client software on all computers where OpenPages application
and Cognos Business Intelligence reporting servers are installed.

Oracle Database Server installations

IBM OpenPages GRC Platform requires a database server. Use the installation
instructions from the vendor to install the Oracle database server on the IBM
OpenPages database server. After you install Oracle Database, some configuration
is required.

Restriction: Do not install Oracle database server or Oracle client software into a
directory that contains spaces.

Important: The password for database users (such as SYSTEM, SYS, DBSNMP,
SYSMAN) cannot contain special characters due to database requirements and
conflicts with OpenPages scripts.

After installing the Oracle Database server, you must install an Oracle Client on all
application server computers.

Creating users and groups on the Oracle database server for Linux
operating systems

For Linux installations, create and configure the oinstall, dba, and opuser groups
and the oracle user on the server that hosts the Oracle database.

The users and groups must be created and configured by a user with SYSADMIN
privileges and access to root.

For more information, see the Oracle documentation.

If you are installing a cluster environment, you must create these users on the
cluster administrator server and on each cluster member.

About this task

Use the following table to help you create the required users and user groups for
the database server.
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Table 23. Required users and groups for Oracle database servers

User Assign to Groups |Permissions Reason
oracle oinstall; dba Read, write, execute Required by Oracle database
permission to the Oracle |installation program.
oinstall is the client installation Important: The password for
primary group for | directory. this user cannot contain special
this user. characters due to conflicts with
OpenPages scripts

Procedure
1. Log on to the database server as root.

2. To create a group that is called oinstall, open an Linux shell and type the
following command:

groupadd -A oinstall
groupadd -A dba

This group is the primary group for the oracle user. This group is the
inventory group.

Note: The Oracle database requires these names.

3. Create a user that is called oracle, assign the initial login group (oinstall), and
add the user to the dba group.

a. Go to the /usr/sbin/ directory
b. Type the following command:
/usr/sbhin/useradd -m -g oinstall -G dba oracle
4. Change the password for the oracle user by using the following command:
passwd oracle
5. At the New Password prompt, enter a new password.
Related tasks:
“Setting the file descriptor limit for OpenPages users on Linux operating systems”]

on page 89|

You must set the soft and hard limits for the file descriptor and update system files
to allocate sufficient resources to the OpenPages users.

Oracle package dependencies

To function correctly, the OpenPages Oracle packages must have access to the
standard Oracle objects.

If objects are deleted, or access to an object is removed from the PUBLIC group,
the OpenPages application user must be granted explicit permissions to them.

Also, you must create private synonyms within the OpenPages Database Schema.

Each package object requires the EXECUTE permission. All other objects require
the SELECT permission.

The following table lists the standard Oracle objects that include the base object,
the object name, and the public synonym for Oracle database objects.
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Table 24. Base objects for the package object type

Base Object Object Name Public Synonym
SYS.DBMS_RANDOM DBMS_RANDOM PUBLIC.DBMS
_RANDOM
SYS.DBMS_SQL DBMS_SQL PUBLIC.DBMS_SQL
SYS.DBMS_]JOB DBMS_JOB PUBLIC.DBMS_JOB
SYS.DBMS_OUTPUT DBMS_OUTPUT PUBLIC.DBMS
_OUTPUT
SYS.DBMS_SESSION DBMS_SESSION PUBLIC.DBMS
_SESSION
SYS.DBMS_UTILITY DBMS_UTILITY PUBLIC.DBMS
_UTILITY
SYS.DBMS_SNAPSHOT DBMS_MVIEW PUBLIC.DBMS
_MVIEW
SYS.DBMS_STATS DBMS_STATS PUBLIC.DBMS
_STATS
SYS.STANDARD N/A N/A
SYS.DBMS_STANDARD N/A PUBLIC.ODCICONST
SYS.ODCICONST ODCICONST N/A
SYS.PLITBLM N/A PUBLIC.DUAL

Table 25. Base objects for the

view object type

Base Object

Object Name

Public Synonym

SYS.ALL.PROCEDURES ALL_PROCEDURES PUBLIC.ALL
_PROCEDURES
SYS.ALL_TAB_PRIVS ALL_TAB_PRIVS PUBLIC.ALL
_TAB_PRIVS
SYS.NLS_SESSION_ NLS_SESSION PUBLIC.NLS
_PARAMETERS _SESSION
PARAMETERS _PARAMETERS
SYS.PRODUCT PRODUCT_COMPONENT | PUBLIC.PRODUCT_
_COMPONENT_ _VERSION COMPONENT
_VERSION
VERSION
SYS.USER_CONS USER_CONS_COLUMNS PUBLIC.USER
_COLUMNS _CONS_
COLUMNS
SYS.USER USER_CONSTRAINTS PUBLIC.USER_
_CONSTRAINTS CONSTRAINTS
SYS.USER_DB_LINKS USER_DB_LINKS PUBLIC.USER
_DB_LINKS
SYS.USER_IND USER_IND_COLUMNS PUBLIC.USER_IND_
_COLUMNS COLUMNS
SYS.USER_INDEXES USER_INDEXES PUBLIC.USER
_INDEXES
SYS.USER_OBJECTS USER_OBJECTS PUBLIC.USER
_OBJECTS
SYS.USER_SEGMENTS USER_SEGMENTS PUBLIC.USER
_SEGMENTS
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Table 25. Base objects for the view object type (continued)

Base Object Object Name Public Synonym
SYS.USER_SEQUENCES USER_SEQUENCES PUBLIC.USER__
SEQUENCES
SYS.USER_SOURCE USER_SOURCE PUBLIC.USER
_SOURCE
SYS.USER_TAB_COLS USER_TAB_COLS PUBLIC.USER
_TAB_COLS
SYS.USER_TAB USER_TAB_COLUMNS PUBLIC.USER_TAB_
_COLUMNS COLUMNS
SYS.USER_TABLES USER_TABLES PUBLIC.USER
_TABLES
SYS.USER USER_TABLESPACES PUBLIC.USER _
_TABLESPACES TABLESPACES
SYS.USER_TRIGGERS USER_TRIGGERS PUBLIC.USER
_TRIGGERS

Adding an Oracle listener for the OpenPages database
You must manually add an Oracle database listener for the OpenPages database.
Procedure

1. Log on to your database server as a user with administrative privileges.
2. Start the Net Configuration Assistant by using one of the following methods:

If you purchased
Oracle from... Then...

IBM 1. Open a Command Prompt window.

2. Go to openpages_data\repository\serverll2 x64\software\
bin directory.

3. To start the Net Configuration Assistant, type the following
command: netca.

Vendor other than IBM | 4 Open a Command Prompt window.

2. Go to the Oracle_Home\bin directory.

3. To start the Net Configuration Assistant, type the following
command: netca.

3. On the Welcome page, select the Listener configuration option and click
Next.

4. On the Listener Configuration, Listener page, select Add and click Next.

5. On the Listener Configuration, Listener Name page, type a name for the new
listener and click Next.

Each listener name must be unique in the current Oracle Home.

6. On the Listener Configuration, Select Protocols page, select TCP for the
protocol and click Next.

7. On the TCP/IP Protocol page, choose a port and click Next.

e If this instance is the only Oracle database instance installed on your
computer, select the Use standard port number of 1521 option.
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10.

1.

* If you have other instances of Oracle installed, choose another port number.
This port number cannot be used by any other services that are running on
your computer.

On the More Listeners page, select No and click Next.

On the Listener Configuration Select Listener page, select the listener you
created and click Next to start the listener service.

On the Listener Configuration Done page, click Next to return to the
Welcome page.

On the Welcome page, click Finish.

Creating an Oracle database instance for the OpenPages repository

You must create an Oracle database instance for OpenPages to use.

Procedure

1.
2.

Log on to your database server as a user with administrative privileges.

Start the Database Configuration Assistant by using one of the following
methods:

If you purchased Oracle from... Then...

IBM

1. As a user with Administrative privileges,
open a Command Prompt window.

2. Go to the openpages_data\repository\
serverll?2 se x64\software\bin
directory.

3. To start the Database Configuration
Assistant, type the following command:
dbca.

a vendor other than IBM 1

. As a user with Administrative privileges,
open a Command Prompt window.

2. Go to the Oracle_Home\bin directory.

3. To start the Database Configuration
Assistant, type the following command:
dbca.

ook~ w

On the Welcome page, click Next to begin the database configuration.
On the Operations page, select Create a Database and then click Next.
On the Database Templates page, select Custom Database and click Next

On the Database Identification page type the Global Database Identifier and
click Next

On the Management Options page, select Configure Enterprise Manager.
a. Select Configure Database Control for local management.

b. If required, enable E-mail Notifications and Daily Backups and click
Next.

On the Database Credentials page, set the passwords for the default Oracle
accounts and click Next.

On the Database File Locations page, select the following options:
a. Select File System for the Storage Type.
b. Select the location for the database files.
* If you want to use the same drive that the Oracle Home directory is
located, select Use Database File Locations from Template
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 If you want to place the files on a different drive or in another location,
Use Common Location for All Database Files, and then type the
desired location for the database files

c. Optionally, click File Location Variables to show the current settings for
the database template you chose, and click OK.

d. Click Next.
10. On the Recovery Configuration page, clear all options and click Next.

11. On the Database Content page, clear all check boxes except Enterprise
Manager Repository.

a. Click Standard Database Components.
b. Clear all options.

Note: An Oracle message displays when you clear the Oracle DB XML
component. You can click YES and ignore this message. The Oracle
components affected by clearing this option are not used by the
OpenPages environment.

c. Click OK to close the dialog.
d. Click Next.
12. On the Initialization Parameters page, change the settings.

a. On the Memory tab, click Custom and then set the following options:
* Memory Management to Automatic Shared Memory Management.
* SGA Size field to 1024.
* PGA Size field to 768.

b. On the Sizing tab, set the following options:
* Block Size to 8192.
* Processes to 250.

c. On the Character Sets tab, select Use Unicode (AL32UTF8) and set the
National Character Set option to AL16UTF16 - Unicode UTF-16 Universal
character set

Note: You must create your database with the AL32UTEFS8 character set.
d. On the Connection Mode tab, select Dedicated Server Mode.
13. Click All Initialization Parameters > Show Advanced Parameters.
a. Enter the following custom settings:

Table 26. Initialization parameter values for Oracle database instance

Parameter Name Value Default
compatible 11.2.0.0
nls_length_semantics CHAR BYTE
Note: CHAR is required for
globalization.
open_cursors 300
optimizer_index_caching 100 0
optimizer_index_cost_adj 1 100
optimizer_mode FIRST_ROWS ALL_ROWS
optimizer_secure_view_merging false
processes 250
sessions 280
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b. Click Close and click Next.

14. On the Database Storage page, if required, modify the database storage
parameters and click Next.

15. On the Creation Options page, select Create Database and click Finish.

16. On the Configuration page, review the settings and click Finish to begin the
database creation process and then click OK.

Adding a local

net service name for the OpenPages database

If you did not purchase Oracle database software from IBM OpenPages, you must
add a net service name on all servers that run the OpenPages application. The
database client uses the net service name to connect to the database.

Procedure

1. To start the Net Configuration Assistant, do one of the following steps:

If you purchased
Oracle from... Then...

IBM 1. Open a Command Prompt window.

2. Go to the OpenPages_data\repository\serverll2 x64\
software\bin directory.

3. To start the Net Configuration Assistant, type the following
command: netca.

a vendor other than 1

. Open a Command Prompt window.
IBM

2. Go to the Oracle_Home\bin directory.
3. To start the Net Configuration Assistant, type the following

command: netca.

2. On the Welcome page, select Local Net Service Name configuration and click
Next.

3. On the Net Service Name Configuration page, select Add and click Next.

4. On the Service Name page, type the global database name for the Oracle
instance and click Next

For example, use OP for the service name.
5. On the Select Protocols page, choose the TCP protocol and click Next.

6. On the TCP/IP Protocol page, type the name of the server in for the Host
Name field, use the standard port number, and then click Next.
If you changed the port number when you created the listener for the
database instance, type the new value instead.

7. On the Test page, select Yes, perform a test to confirm the connection.
The test fails if you changed the password for the SYSTEM user during the
database creation procedure. In this case, click Change Login after the test
failure. Overwrite the SYSTEM password with the value you entered during

the database creation procedure (Oracle Server installation), click OK, and
then click Next.

8. On the Net Service Name page, modify default Net Service Name if necessary
and click Next.

By default, the value matches the Service Name you entered at the beginning
of the procedure.

9. On the Another Net Service Name? page, select No and click Next.
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10. On the Net Service Name Configuration Done page, click Next to return to
the Welcome page.

11. Click Finish to exit the Net Configuration Assistant.

Scripts to manually create the OpenPages database schema in Oracle
before installation

To create the OpenPages schema before you install, use the SQL wrapper scripts
that are included in the media kit.

The IBM OpenPages GRC Platform requires that you create an OpenPages
database schema, a set of database users, and a tablespace. During the OpenPages
GRC Platform installation, you can choose to automatically create the schema.
Optionally, you can manually create the OpenPages database schema before you
install OpenPages application servers.

Scripts used to create the database schema

To create the OpenPages application tablespace and users, run a SQL wrapper
script. The SQL wrapper script calls other scripts.

sql-wrapper.sql
The script runs other required SQL scripts in the correct order. Use this
script to manually install the database.

database-install.sql
The wrapper script contains default definition values that you can modify.
Change settings in the script file and not the command-line interface.
Default values include the OpenPages administrator user account, base
currency denomination, and the location of the OpenPages storage folder.

The base currency must match the base currency that is set in any previous
installations. You cannot change the base currency after installation.

op-app-global-env.sql
The script is called by the wrapper script and defines the Super
Administrator user account. You must verify the user account values in
this script.

Changing the database object names for Oracle Automatic Storage
Management

The IBMOpenPages GRC Platform includes coded names and locations of table
spaces, data directories, and data files in the OpenPages database. To prevent a
conflict with internal systems, practices, or IT policies, you must modify some
scripted values.

For example, the installation program creates the aurora.dbf data file that stores
all OpenPages data. Use Oracle Automatic Storage Management to change the
name of this data file.

To change the name of the data file in the OpenPages database, a database
administrator must update the following scripts before you run the
sql-wrapper.sql script.

create-opx-tablespaces.sql
Creates table spaces for OpenPages database application tables
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ibpm-ts-and-schema-owner.sql
Creates table spaces for IBPM application tables.

Procedure

1. Log on to a system as a user with administrator privileges.

Tip: You can use any system that has access to SQL*Plus and that can connect
to the database server.

2. Go to the OP_version_Configuration\Database\Oracle directory and copy the
/0P_version_Configuration/Database/ORACLE/INSTALL_SCRIPTS directory.

3. Open the create-opx-tablespaces.sql script in a text editor.

a. As appropriate for your environment, modify the SQL script under --
permanent storage, protected by Togging, -- dedicated temporary
tablespace and --temporary storage, no logging protection:

CREATE TABLESPACE iflowdb DATAFILE '&dbf_Tlocation/&tablespace_name.dbf'
SIZE 25M REUSE AUTOEXTEND ON NEXT 25M MAXSIZE
UNLIMITED ONLINE EXTENT MANAGEMENT LOCAL UNIFORM SIZE 256K';

b. Save and close the file.
4. Open the ibpm-ts-and-schema-owner.sql script in a text editor.

a. Use the following syntax to modify the SQL script under ReCreate the
tablespace and RECREATE THE USER:

CREATE TABLESPACE iflowdb DATAFILE '&dbf Tocation/&tablespace_name.dbf'
SIZE 25M REUSE AUTOEXTEND ON NEXT 25M MAXSIZE
UNLIMITED ONLINE EXTENT MANAGEMENT LOCAL UNIFORM SIZE 256K';

b. Save and close the file.
For example, the following SQL Syntax creates a table space with a data file

called OPdatafile in the Oracle data home location. The table space is managed
locally.

CREATE TABLESPACE iflowdb DATAFILE '&&10/0Pdatafile.dbf’
SIZE 25M REUSE AUTOEXTEND ON NEXT 25M MAXSIZE
UNLIMITED ONLINE EXTENT MANAGEMENT LOCAL UNIFORM SIZE 256K';

Where 8810 uses the datafile_storage_location parameter that you entered in
the database-install.sql command for the data file location. OPdatafile.dbf
is the name of the data file.

The following SQL syntax creates a temporary table space with a data file in
disk_group_1. The table space is managed locally.

CREATE TEMPORARY TABLESPACE OPDATA_TEMP TEMPFILE '+disk_group_l1' SIZE 2G
EXTENT MANAGEMENT LOCAL;

5. To verify the default definition values, open the sql-wrapper.sql wrapper
script in a text editor and modify the values as required for the following
definitions.

* define opx_base_currency iso_code='USD'
 define opx_dflt_stor_ srv_root='C:\openpages-storage'

For example, by default, the base currency is set to USD. If you use Euros as
your base currency, change the default ISO currency code from USD to EUR.

define opx_base currency iso_code='EUR'

6. From the INSTALL_SCRIPTS directory, open the custom environment script
op-app-global-env.sql in a text editor.

a. Modify the following default values for the Super Administrator.
e define super_admin_username='0OpenPagesAdministrator'
* define super_admin_password='OpenPagesAdministrator'
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b. Save and close the file.

7. Use the following syntax to run the database-install.sql wrapper script that
creates the database components:

sqlplus /nolog @database-install.sql database-install.sql log_file
oracle_tns_alias dba_user dba_password workflow user
workflow_password op_user op_password
datafile_storage_location

The following table provides a list of parameters that are passed to the SQL

wrapper script.

Table 27. Examples of SQL wrapper script parameters and descriptions

Parameter Name

Description

Example

log_file

The log file name that the
script creates and writes
information to.

logfile.txt

oracle_tns_alias

The database alias for the
OpenPages database
instance, as set during the
Oracle database
installation. If necessary,
you can retrieve this alias
from the tnsnames.ora
file.

OP

dba_user

The Oracle system user
name.

If you do not have access
to the system user
account, then use a
database user account
with administrative
privileges.

system

dba_password

The password for the
Oracle system account.

openpages

workflow_user

The workflow database
user name.

OpenPages uses this
account to create and
access the workflow
database, and to manage
workflow-related
transactions.

opworkflow

workflow_password

The password for the
workflow database user
account.

opworkflow

op_user

The user name that is
used by OpenPages to
create and access the
OpenPages database
instance

openpages

op_password

The password for the
OpenPages database user
account.

openpages
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Table 27. Examples of SQL wrapper script parameters and descriptions (continued)

Parameter Name Description Example

datafile_storage_location | The location of the Oracle |. ¢.\gracle\orall2\oradata\OP
data directory on the

database server. The * C:\openpages_data\

. o repository\
¥ocat10n O.f this directory databasell?2 se x64\oradata\
is set during the Oracle op - =

installation process.

The following sample code shows the SQL*Plus command line with example
values from the table from the preceding step as the variables.
sqlplus /nolog @sql-wrapper.sql database-install logfile.txt OP
system openpages opworkflow opworkflow openpages openpages
C:\oracle\orall2\oradata\OP
C:\openpages_data\repository\

databasell2_se_x64\oradata\OP
After the SQL script finishes, the OpenPages database schema is created. A log
file is created in the directory where you ran the SQL script. The name of the
log file matches the value of the Tog_file parameter you entered.

Results

If you have problems when you run the database-install.sql script, you can use
the OP_version_Configuration\Database\Oracle\init-db-cleanup.sql script. The
init-db-cleanup.sql removes the database components that were added. Then,
you can run the database-install.sql script in a clean database environment.

Example

sqlplus /nolog @sql-wrapper.sql init-db-cleanup.sql log file
oracle_tns_alias dba_user dba_password workflow_user op_user

Starting and stopping the database server in a Windows environment

Use Windows services to start or stop the Oracle database instance.

Procedure
1. Log on to the database server as a user with administrative privileges.
2. Click the Windows Start > All Programs > Administrative Tools > Services.

3. Start the Oracle Database listener service, which connects the user to the Oracle
Database instance

4. To start the Oracle Database instance, right-click the service name
(OracleServiceSID) and select Start.

Testing the connections to the database server and the OpenPages

repository

Test whether the SQL*Net connect string can connect to the database listener by
using the TNSPING utility in the ORACLE HOME/bin directory. The TNSPING utility
tests if the listener is available. It does not test whether the databases behind the
listener are working.

To test that the OpenPages repository is created, use SQL*Plus to log on to the
OpenPages Oracle database schema.
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Procedure

1. To test whether you can log on to Oracle Enterprise Manager Database Control,
the web-based interface that is used to administer an Oracle database, type the
following command:

https://oracle_server_name:port/em
In a default installation, the port number is 1158.

2. To test whether a SQL*Net connect string can connect to the listener, type the
following command:

tnsping database_instance_name

The utility requests acknowledgement that the service name is valid and that
the listener is configured to handle requests for that service name.

If the configuration is correct, a message is displayed that shows the return
time.

If the configuration is not correct, the utility returns an error message. Ensure
that you use the correct service name and that the listener is started on the
server computer.

3. To test that OpenPages repository is created, type the following command:
sqlplus username/password@service name
For example, sqlplus system/openpages@op
The system connects you to an Oracle Database instance.

4. To exit SQL*Plus, type exit.
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Chapter 7. Cognos Business Intelligence installations

IBM Cognos Business Intelligence is installed on the same server as the OpenPages
CommandCenter. This server is referred to as the reporting server.

Reporting server distribution options

For light user loads, with fewer than 50 concurrent users, Cognos BI and
CommandCenter can be installed on the same server as the OpenPages application.

For heavier user loads, install Cognos Bl and CommandCenter on separate from
OpenPages application servers. IBM OpenPages GRC Platform operates at peak
performance when components are installed on multiple servers: a database server,
an application server, and a reporting server.

Requirements for installing Cognos Bl in a Linux environment

Cognos Business Intelligence requires specific Linux packages. For more
information, see the [Linux operating system requirements on the Cognos|
lsupported environments web site| (www.ibm.com/ support/
docview.wss?uid=swg27036131#linux).

The Cognos BI installation program and requires the following 32-bit and 64-bit
libraries.

32-bit libraries

* gtk2-2.18.9-6.€16.1686.rpm

* glib2-2.22.5-6.e16.1686.rpm

* 1ibXtst-1.0.99.2-3.e16.1686.rpm

e compat-1ibstdc++-33-3.2.3-69.e16.1686.rpm
* pam-1.1.1-10.e16.1686.rpm

e openmotif22-2.2.3-19.e16.1686.rpm

* 1ibXp-1.0.0-15.1.e16.7686.rpm

e ibXmu-1.0.5-1.e16.1686.rpm

64-bit libraries

* gtk2-2.18.9-6.e16.x86_64.rpm

* glib2-2.22.5-6.e16.x86_64.rpm

e 1ibXtst-1.0.99.2-3.e16.x86_64.rpm

e compat-libstdc++-33-3.2.3-69.e16.x86_64.rpm
e openmotif22-2.2.3-19.e16.x86_64.rpm

e pam-1.1.1-10.e16.x86_64.rpm

* 1ibXp-1.0.0-15.1.e16.x86_64.rpm

* 1ibXmu-1.0.5-1.e16.x86_64.rpm

* compat-glibc-headers-2.3.4-2.26.x86_64.rpm
e compat-glibc-2.3.4-2.26.x86_64.rpm
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DB2 database server requirements

Two separate DB2 database instances are required for the IBM OpenPages GRC
Platform installation. The DB2 database instance that hosts the Cognos content
store must not be the same DB2 database instance that hosts the OpenPages
database. Each DB2 database instance has different requirements.

Installing IBM Cognos Business Intelligence

Before you install OpenPages GRC Platform components, ensure that IBM Cognos
Business Intelligence and the IBM Cognos Software Development Kit are installed
and running in your environment.

Restriction: Do not install Cognos BI into a directory that contains spaces.

For more information about upgrading to IBM Cognos BI, see the IBM Cogrnos
Business Intelligence Installation and Configuration Guide.

Important: In the 64-bit installations, the report server component in Cognos BI is
provided in both 32-bit and 64-bit versions. Selecting which version you use is
done in IBM Cognos Configuration after installation. By default, the report server
component is set to use the 32-bit mode, even on a 64-bit computer. With the 32-bit
mode, you run reports from all packages. If you configure the 64-bit mode, you
can run only reports that are created from packages that use dynamic query mode.
For OpenPages applications, you must use the default 32-bit report server.

For light user loads, with fewer than 50 concurrent users, Cognos BI and
CommandCenter can be installed on the same server as the OpenPages application.

For heavier user loads, install Cognos Bl and CommandCenter on separate from
OpenPages application servers. IBM OpenPages GRC Platform operates at peak
performance when components are installed on multiple servers: a database server,
an application server, and a reporting server.

Note: The IBM Cognos Business Intelligence Installation and Configuration Guide is
available in the [BM Cognos documentation library|

Before you begin

If the OpenPages database is remote from the Cognos Bl server, ensure that the
database client software is installed on the Cognos BI server. The database client
that Cognos BI uses to connect to the OpenPages database must be a 32-bit client.

Restriction: Do not install the database client software into a directory with
spaces.

On Linux operating systems, ensure that the dependent 32-bit and 64-bit libraries
are installed.

Important: The 64-bit DB2 database installations includes libraries for both 32-Bit
and 64-bit systems. On Linux and AIX operating systems, ensure that the library
path points to the 32-bit libraries. Use the following table to add the path to the
DB2 32-bit server libraries.
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Table 28. DB2 database path environment variables for Cognos installations (
DB2DIR=/home/db2inst1/sqllib)

Operating

system Environment variable Example

Linux LD_LIBRARY_PATH LD_LIBRARY_PATH=$DB2DIR/1ib32:
$LD_LIBRARY_PATH

AIX LIBPATH LIBPATH=$DB2DIR /1ib32: $LIBPATH

Procedure

1. Ensure that a web server, such as Microsoft IIS or IBM HTTP Server is
installed.

A web server is required so that users can view content in the IBM Cognos BI
portal.

2. On the reporting server, install the new version of Cognos Business Intelligence,
IBM Cognos Software Development Kit, and optionally Framework Manager.

a. Install Cognos BI Server.

Restriction: In the installation wizard, accept the default components that
are selected. Do not select Cognos Content Database. Install Cognos BI into
a directory that contains only ASCII characters in the path name.

After the installation is complete, ensure that the IBM Cognos Configuration
check box is clear. Before you configure Cognos BI Server, you must do
other tasks to set up your environment.

For information about installing Cognos BI Server on Windows operating
systems, see [[nstalling server components on Windows operating systems in
the IBM Cognos BI Information Center.

For information about installing Cognos BI Server on AIX or Linux
operating systems, see |Insta11ing server components on UNIX or Linux|
[operating systems|in the IBM Cognos BI Information Center.

b. Install Cognos Software Development Kit in the same installation location
as Cognos BI Server.

In the installation wizard, accept the default components that are selected.

For more information about installing IBM Cognos Software Development
Kit on Windows-based computers, see [[nstalling and configuring the
[Software Development Kiff in the IBM Cognos BI Information Center.

c. Optional: Install Framework Manager.

Framework Manager is not required in production environments.
Framework Manager is the modeling tool for creating and managing
business-related metadata.

Restriction: If you need Framework Manager in your development
environment, you must install the 64-bit Cognos BI server and the 32-bit
Framework Manager to different directories. The default installation
locations for 32 and 64-bit Cognos components are different. For more
information about installing Framework Manager, see [[nstalling Framework]

in the IBM Cognos BI Information Center.
3. Copy the JDBC database driver to the Cognos_Home\webapps\p2pd\Web-Inf\1ib
directory.

e If the content store is an Oracle database, copy the ojdbc5. jar file from the
Oracle installation.
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¢ If the content store is a DB2 database, copy the db2jcc.jar and
db2jcc_Ticense_cu.jar files from the DB2 installation.

4. Append the Cognos_HOME/bin64 directory to the library path environment
variable.

* On Linux operating systems, update the LD_LIBRARY_PATH environment
variable

Example: export LD _LIBRARY_PATH=$LD_LIBRARY_PATH:/opt/ibm/cognos/
c10_64/bin64

* For AIX operating systems, update the LIBPATH environment variable.

Example: export LIBPATH=$LIBPATH:/opt/ibm/cognos/c10_64/bin64
5. Append the Cognos_HOME/bin64 directory to the PATH environment variable.
Related tasks:
“Manually creating the reporting tablespace and user for Oracle databases” onl

page 158

After you create the Cognos content store, you can manually create the content
store user and the content store tablespace. This user must be able to create, alter,
and drop tables, triggers, views, procedures, and sequences, and have the
CONNECT and RESOURCE roles.

Creating users and groups on the reporting servers for the Oracle
client on Linux operating systems

76

To install the Oracle client and IBM Cognos Business Intelligence create two users
and one group.

About this task

To install the Oracle client, create and configure the oinstall group and the oracle
user on the server that hosts the OpenPages application.

Use the following table to help you create the users and groups

Table 29. Required users for reporting servers

User Assign to Groups |Permissions Reason

oracle oinstall Read, write, execute oinstall is required by Oracle
permission to Oracle client installation program
client installation
directory
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Table 29. Required users for reporting servers (continued)

User Assign to Groups |Permissions Reason
opuser staff Read, write, execute . staff
L h
permission to the. . A standard, default group to
cron following directories: .
) which most users have as the
security * Oracle client primary group..
installation directory | cron
audit * WebSph
e P N re . Optionally, add the user to
installation directory 3 .
bin this group to allow this user
* Cognos installation to run cron jobs.
staff is the direCtory . Secur'ity
primary group for |+ Java JDK or JRE Add the user to this group to
this user. installation directory group
allow the user to set user
* Apache Web Server attributes.
installation directory | audit
t be able t
User muf ¢ ableto Add the user to this group to
run SQL*Plus .
allow the user to be audited
commands. .
or to audit.
* bin
Add the user to this group to
allow access to tools in the
bin directory, such as gunzip.
Procedure

1. Log on to the application server as root user and open an AIX shell.

2. To create a group called oinstall, enter the following command.

groupadd -A oinstall

This group is the primary group for the oracle user.

3. To create a user called oracle and assign the user to the oinstall group, go to
the /usr/sbin/ directory and enter the following command.

usr/sbin/useradd -m -g oinstall oracle

This user is used to install Oracle client.

Note: The Oracle Client installer requires that this user is named oracle.

4. Use the following command to change the password for the oracle user.

passwd oracle.

5. Enter a new password at the New Password prompt.

Restriction: The password for this user cannot contain special characters due
to conflicts with OpenPages scripts

6. To install the OpenPages application, create a user, such as opuser user.

useradd -m name.

7. To limit the size of a file the user can create, configure the opuser user.

chuser fsize=# name

Use a negative number for unlimited.

8. Add the OpenPages user to the bin, security, and audit Oracle groups.

usermod -g staff -G bin,security,cron,audit opuser

Optionally, you can add the user to the cron group.

9. Use the following command to change the password for the OpenPages user.
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passwd name.
10. Enter a new password at the New Password prompt.

Web server configuration options for Cognos Bl

You must configure your Web server before users can connect to the IBM Cognos
BI portal.

For more information, see the [Configuring a web server|in the IBM Cognos
Business Intelligence Information Center, which contains details on the following:

Enable the 64-bit web gateway]

If you want to use the 64-bit version of the IBM Cognos BI gateway, you must
manually move the 64-bit gateway files in your installation directory.

* |[Use compiled gateways for production systems|

For production systems, you can improve performance by changing the gateway
from the default CGI gateway.

+ |[Use CGI gateways|

You can use the CGI gateway on IBM HTTP Server, Apache Web Server, or
Microsoft Internet Information Services (IIS) Server.

+ |Configuring WebDAV to view and browse images|

To view and browse images in the Report Studio, configure Web Distributed
Authoring and Versioning (WebDAV) on your web server. Report authors can
browse for images to include in reports in a way that is similar to browsing a
file system.

Configuring IIS 7.0 Web Server

Before you can view reporting data on Windows computers, you must configure a
web server. If your web server is a Windows Server 2008 with IIS 7.0, configure
ISAPI and CCI to allow CommandCenter pages to load.

About this task

IIS 7.0 on a Windows Server 2008 server has security features that, by default,
prohibit files with web service extensions (cgi) from executing. As a result, Cognos
files that have these web service extensions are unable to run. To modify 1IS 7.0
security features so that Cognos files with Web Service extensions can execute
properly, you must enable IIS to allow CGIL.

The following instructions are specific to Windows Server 2008 with IIS 7.0.

For more information, see (Configuring the web server|in the IBM Cognos Business
Intelligence Information Center.

Procedure
1. Log on to the reporting server as a user with administrative privileges.

2. Open the Windows Internet Information Services Manager from the Start
menu, by clicking Administrative Tools > Internet Information Services
Manager.

3. In Internet Information Services Manager, select the application server that
you want to configure.

4. In the Features view, locate the ISAPI and CGI Restrictions icon.
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10.
11.
12.
13.

14.

* If the ISAPI and CGI Restrictions icon is not displayed, enable ISAPI and
CGI extensions as described in the step 5.

¢ If the ISAPI and CGI Restrictions exists, skip the following step, and
continue to step 6.

To enable ISAPI and CGI extensions, create a role in the Windows Server
Manager.

a. In Internet Information Services Manage, right-click Roles and select Add
Roles.

b. On the Before You Begin page in the Add Role Services wizard, click
Next.

C. On the Select Server Roles page, select WebServer (IIS) and click Next.

d. In the Add Server Roles page, under Application Development, select
CGI, ISAPI Extensions, and ISAPI filters, and click Next.

e. On the Confirm Installation Selections page, click Install, and when the
installation is complete, click Close.

In the Features view of the Internet Information Services Manager,
double-click the ISAPI and CGI Restrictions icon.

In the Actions pane, select Add.
In the Add ISAPI or CGI Restriction dialog box, click browse.

In the ISAPI and CGI Restrictions box, change the File Type filter from .d11
to A1l Files.

Enter the path to the cognos.cgi file in the Cognos_HOME\cgi-bin directory.
Enter a description for the restriction, such as Cognos-CGI.
Select Allow extension path to execute and click OK.

Add the module mapping to the web.config or the applicationhost.config
file or both.

a. Find the applicationHost.config file.
C:\Windows\System32\inetsrv\config\applicationHost.config.
If the appTicationHost.config does not exist, continue to step 14.

b. Open the applicationHost.config in a text editor and find the following
entry:

<add name="Cognos-CGI" path= "cognos.cgi" verb="+" modules="CgiModule"
resourceType="Unspecified" />

c. Add allowPathInfo="true" to the end of the line:

<add name="Cognos-CGI" path= "cognos.cgi" verb="*" modules="CgiModule"
resourceType="Unspecified" allowPathInfo="true" />

d. Save and close the file.

Go to the Cognos_HOME\cgi-bin directory and open the web.config file in a
text editor.

a. Find the following entry:

<add name="Cognos-CGI" path= "*.cgi" verb="*" modules="CgiModule"
resourceType="Unspecified" />

b. Add allowPathInfo='true' to end of the line:

<add name="Cognos-CGI" path= "*.cgi" verb="="
modules="CgiModule" resourceType="Unspecified" allowPathInfo="true" />

c. Save and close the file.
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Configuring virtual directories in IIS

You must configure a virtual directory or alias that is used by the Microsoft
Internet Information Services to map to a physical location.

Procedure

1. From the Internet Services Manager, expand the tree for the server that you
want to configure, and then expand Default Web Site.

2. Right-click Default Web Site and select Add Virtual Directory from the
menu.

3. On the Add Virtual Directory page, create the ibmcognos virtual directory.
a. In the Alias field, type ibmcognos.

b. In the Physical Path field, enter the path to the webcontent directory
under Cognos_HOME

c. Click OK.

4. Right-click the ibmcognos virtual directory that you created and select Add
Virtual Directory.

5. On the Add Virtual Directory screen, create a cgi-bin virtual subdirectory.
a. In the Alias field, type cgi-bin.

b. In the Physical Path field, enter the path to the cgi-bin directory under
Cognos_HOME.

c. Click OK.

6. In the Connections pane, select the cgi-bin virtual director, and double-click
Handler Mappings.

7. In the Actions pane click Add Module Mapping, and in the Request Path
field, enter *.cgi..

8. In the Module list, select CgiModule and enter a name, such as Cognos-CGI.
9. Click OK.
10. Internet Information Services Manager.

Configuring the Apache Web Server on a Windows operating
system

You must configure your web server before users can connect to the IBM Cognos
Business Intelligence portal.

Procedure
1. Log on to the web server as a user with administrative privileges.
2. From the command prompt, go to the Apache_Home\conf\ directory.

3. Make a backup copy of the httpd.conf file and rename the file to:
httpd.conf.original.

4. Open the httpd.conf file in a text editor.

5. Configure the virtual directories by adding the following lines to the end of the
httpd.conf file:

ScriptAlias /ibmcognos/cgi-bin "<Cognos_HOME>\cgi-bin"
<Directory "<Cognos HOME>\cgi-bin">

Options FollowSymLinks

AllowOverride Filelnfo

Order Allow,Deny

AlTow from A1l

</Directory>

Alias /ibmcognos "<Cognos HOME>\webcontent"
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<Directory "<Cognos HOME>\webcontent">
Options FollowSymLinks

AllowOverride FilelInfo

Order Allow,Deny

Allow from A1l

</Directory>

Restart the web server service though the Window Services or by using the
Window Start menu.

Configuring the Apache Web Server on AIX or Linux operating

systems

You must configure your web server before users can connect to the IBM Cognos
Business Intelligence portal.

Procedure

1.
2.
3.

6.

Log on to web server as a non-root user with administrative privileges.
Go to the Apache_HOME/conf directory.

Make a backup copy of the httpd.conf file and rename the file to:
httpd.conf.original.

Open the httpd.conf file in a text editor.

Configure the virtual directories by adding the following lines to the end of the
httpd.conf file:

ScriptAlias /ibmcognos/cgi-bin "<Cognos_HOME>/cgi-bin"
<Directory "<Cognos HOME>\cgi-bin">

Options FollowSymLinks

AllowOverride FileInfo

Order Allow,Deny

Allow from ATl

</Directory>

Alias /ibmcognos "<Cognos_ HOME>/webcontent"
<Directory "<Cognos_HOME>\webcontent">
Options FollowSymLinks

AllowOverride Filelnfo

Order Allow,Deny

Allow from A1l

</Directory>

Use the following commands to restart the Apache Web Server:
¢ On AIX operating systems:

Apache HOME/bin/apachectl stop

Apache _HOME/bin/apachectl start
* On Linux operating systems:

/etc/init.d/httpd start

/etc/init.d/httpd stop

Configuring a connection to the content store for Oracle database

After you install IBM Cognos Business Intelligence and the IBM Cognos Software
Development Kit, configure a connection to the content store database.

Before you begin

Ensure that you copied the JDBC database driver, ojdbcb. jar, file to the
c10_location\webapps\p2pd\Web-Inf\1ib directory.
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Procedure
1. Start Cognos Configuration.

¢ On Windows computers, from the Start menu, click All Programs > IBM
Cognos 10 > IBM Cognos Configuration.

* ON AIX computers, go to the Cognos_HOME/c10_64/bin64 directory, and type
the following command:

./cogconfig.sh

2. In Cognos Configuration, configure the database connection to the content
store.

a. In the Explorer pane, under Data Access > Content Manager,, right-click
Content Store > Delete.

Right-click Content Manager > New Resource > Database.

In the New Database dialog box, for the Name field, enter a descriptive
name for the connection.

Note: The name is not required to match the database identifier.

d. For the Type, select Oracle Database (Advanced) for Oracle RAC databases,
or Oracle Database if you are not using an Oracle RAC database.

e. Click OK.

f. In the Explorer panel, select the new connection, and in the Properties
panel, use the following tables to enter the property settings.

Table 30. Content store property settings for Oracle database

Property name Property value

Database server and port number The name of the database server and the
listener port that is used for the database
instance.

User ID and Password Click the value field and then click the

pencil icon.

In the Value - User ID and password field,
enter the appropriate values for the Cognos
user you created for the content store
database.

If you used the IBM OpenPages GRC
Platform Installer for Cognos, the default
user is cognos.

Service name Enter the SID for the database instance.

Table 31. Content store property settings for Oracle database (Advanced) (Oracle RAC

database)

Property name Property value

Database server and port number The name of the database server and the listener
port that is used for the database instance.
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Table 31. Content store property settings for Oracle database (Advanced) (Oracle RAC
database) (continued)

Property name Property value
User ID and Password Click the value field and then click the pencil
icon.

In the Value - User ID and password field, enter
the appropriate values for the Cognos user you
created for the content store database.

If you used the IBM OpenPages GRC Platform
Installer for Cognos, the default user is cognos.

Database specifier Enter a database specifier string in the following
format with no carriage returns:

(description=(address=
(host=<server_name>)
(protocol=tcp) (port=<port>)
(connect_data(service_name=
<service_name>)))

3. To test that the database connection to the content store database is successful,
in the Explorer pane, right-click the content store database connection and click
Test.

4. To start the Cognos services, click Actions > Start.

Note: If you chose to upgrade your content store database by creating a
backup and restoring it, you are prompted to upgrade your reports. Do not
select the option to upgrade your reporting content. Upgrade your reports later
by using the New Report Upgrade wizard in IBM Cognos Administration.

Configuring a connection to the content store for DB2 database

After you install IBM Cognos Business Intelligence and the IBM Cognos Software
Development Kit, configure a connection to the content store database.

Important: The content store database must be in a separate database instance
than the OpenPages database. Oracle compatibility mode must not be enabled for
DB2 database instance that is used for content store.

Before you begin

Ensure that you copied the following files from the DB2_installation\sqllib\java
directory to the Cognos_HOME\webapps\p2pd\WEB-INF\1ib directory:

e db2jcc.jar
e db2jcc_license cu.jar

Procedure
1. Log on to the reporting server as a user with administrator privileges.

Note: For Windows installations, the user must belong to the DB2ADMINS group.
For Linux or AIX installations, the user must belong to the db2iadm group.

2. Start Cognos Configuration.

* On Windows computers, from the Start menu, click All Programs > IBM
Cognos 10 > IBM Cognos Configuration.
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* ON AIX computers, go to the Congos_HOME/c10_64/bin64 directory, and type
the following command:

./cogconfig.sh

. In Cognos Configuration, configure the database connection to the content

store.

a. In the Explorer pane, under Data Access > Content Manager,, click Content
Store.

b. In Database server and port number field, enter the name of the computer
and the port number on which DB2 is running.

Tocalhost:50000 is the default setting. 50000 is the default port number that
is used by DB2. Replace localhost with the DB2 server name. If you are
using a different port number, replace the default port with the port that
you are using.

c. Click the Value field next to the User ID and password property, click the
edit icon, and type the appropriate values for the Cognos user that you
created for the content store database, and click OK.

d. In the Properties window, for the Database name property, type the name
for your content store database.

Restriction: Do not use a name longer than eight characters and use only
letters, numbers, underscores, and hyphens in the name.

. Right-click Content Store, and click Generate DDL.
. In the message box, click Details to record the location of the DDL file that is

generated.

The createDb.sql file is created in the Cognos HOME\configuration\schemas\
content\db2 directory.

. To save your settings in Cognos Configuration, click File > Save.
. To run the script that creates the database, log in a user who has permissions to

create a database.

a. For Windows installations, at the command prompt, type db2cmd.
b. From the command line, type db2 -tvf createDb.sql.

c. On Windows computers, close the CLP.

. In Cognos Configuration, in the Explorer pane, right-click the content store

database connection and click Test.

. To start the Cognos services, click Actions > Start.
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Chapter 8. OpenPages application server installations

Install the OpenPages application software on either an administrative server or
managed server.

The OpenPages application installation program installs the following components:
* OpenPages application

* OpenPages workflow server and notification components

* OpenPages database schema (optional)

Your installation tasks depend on the server role. Use the following table to
determine the type of application server installation.

Table 32. Server roles and installation type

Installation type Server role

Administrative server

installation Used as the administrative server for the OpenPages
environment.

In a clustered environment, there is one administrative
server and all other application servers are managed
servers

Important: If you use LDAP authentication, you must
include LDAP connection information in a configured
tnsnames.ora file on the application server to ensure that
OpenPages can connect to the database.

Managed server installation Used as an extra server in a cluster environment (not
intended for administration).

Restriction: You must install the OpenPages application
on the administrative server before you can install the
managed servers in your configuration. The installation
path must be the same on the administrative server and
on all managed servers.

Prerequisite tasks for the OpenPages application installations that use
Oracle database

Before you install the IBM OpenPages application, ensure that the Oracle database
client is installed on the OpenPages application server.

Oracle environment variable settings

After you install the Oracle database, ensure that you set the Oracle environment
variables on Linux and AIX operating systems.

Some of the values are set during the Oracle installation. Ensure that the following
environment variables are set on the OpenPages application server computer.
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Table 33. Oracle environment variables and descriptions

Environment variables

Description

ORACLE_SID

Specifies the database service name.

Restriction: The SID is case-sensitive in AIX and Linux
environments.

ORACLE_HOME Specifies the installation location or top-level directory structure

for the database installation.

NLS_LANG Specifies the database character set that is configured during the
database installation. The default value is
AMERICAN_AMERICA.AL32UTF8

Note: To display non-English characters for Japanese locales, set
the variable to the following

value:NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

TNS_ADMIN Specifies the location of the tnsnames.ora file. The default

location is the Oracle_Home\network\admin directory.

Example: Use the syntax and delimiters that are appropriate for the shell that you
are using.

export ORACLE_SID=0P

export ORACLE_HOME=/home/oracle/app/oracle/product/11.2.0/client_2

export NLS_LANG=AMERICAN_AMERICA.AL32UTF8

export TNS_ADMIN=/home/oracle/app/oracle/product/11.2.0/client_2/network/admin

Creating users and groups for application servers on Linux
operating systems that use Oracle databases

To install the Oracle Client, WebSphere Application Server, and the OpenPages
application, you must create two users and one group. You can create a separate
user and group to install WebSphere Application Server.

About this task

To install the Oracle client, create and configure the oinstall group and the oracle
user on the server that hosts the OpenPages application.

Table 34. Required users and groups for application servers

User Assign to Groups |Permissions Reason
oracle oinstall Read, write, execute Required by Oracle client
permission to the Oracle |installation program.
client installation
directory.
wasuser IBM WebSphere Read, write, execute You can create a non-root user
Application Server | permission to the to install the WebSphere
installation WebSphere Application | Application Server software.
Server installation You can create a separate user
directory. and group or use the opuser
user.
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Table 34. Required users and groups for application servers (continued)

User Assign to Groups |Permissions Reason

opuser staff Read, write, execute o staff

permission to the

security following directories: gl;feaz’;ilférgoﬁ);f:}:;a;:)z?dard,

audit * Oracle client users have as the primary
installation directory group.

bin * IBM WebSphere e cron

Application Server

installation directory Optionally, add the user to

cron (optional)
the cron group to allow this

WebSphere * Java JDK or JRE user to run cron jobs.
Application server installation directory | security
installation group | Cognos Bl installation

director Add the user to the security
For this user, y group to allow the user to

staff is the User must be able to run | Set user attributes.

primary group. SQL*Plus commands. e audit
Add the user to the audit
group to allow the user to be
audited or to audit.

* bin
Add the user to the bin
group to allow access to
tools in the bin directory,
such as gunzip.

Procedure

1.
2.

Log on to the application server as the root user and open a shell.
To create a group called oinstall, enter the following command:
groupadd oinstall

This group is the primary group for the oracle user.

Restriction: The Oracle Client installer requires that this group is named
oinstall.

To create a user called oracle and assign the user to the oinstall group, go to
the /usr/sbin/ directory and enter the following command:

/usr/shin/useradd -m -g oinstall oracle
This user is used to install Oracle client.

Restriction: The Oracle Client installer requires that this user must be named
oracle.

Use the following command to change the password for the oracle user:
passwd oracle

Enter a new password at the New Password prompt.

To install the OpenPages application, create a user, such as opuser.
useradd -m name

Change the password for the OpenPages user by using the following
command:

passwd name
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Restriction: The password cannot contain spaces or special characters.
Otherwise, the OPBackup script will fail.

8. At the New Password prompt, enter a new password.

Related tasks:

“Setting the file descriptor limit for OpenPages users on Linux operating systems’]

on page 89|

You must set the soft and hard limits for the file descriptor and update system files
to allocate sufficient resources to the OpenPages users.

Users and groups for application servers on Linux or AIX
operating systems that use DB2 databases

To install the DB2 database client, WebSphere Application Server, and the
OpenPages application, you must create two users and one group. You can create a
separate user and group to install WebSphere Application Server.

To install the DB2 database client, create and configure the required users and

groups.

Table 35. Required users and groups for application servers

User Assign to Groups

Permissions

Reason

db2user | The group is
assigned during
the installation of
the DB2 client.

Read, write, execute
permission to the DB2
client installation
directory.

Required by DB2 database client
installation program.

wasuser  |IBM WebSphere
Application Server
installation.

Read, write, execute
permission to the
WebSphere Application
Server installation
directory.

You can create a non-root user
to install the WebSphere
Application Server software. You
can create a separate user or use
opuser.

If the wasuser and opuser are
separate users, they must belong
to the same primary group.

opuser

Read, write, execute
permission to the
following directories:
* DB2 database client
installation directory.
* IBM WebSphere
Application Server
installation directory.
e Java JDK or JRE
installation directory.
* Cognos BI installation
directory.

The user account that installs
IBM OpenPages GRC Platform.
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Related concepts:

“Operating system user accounts for OpenPages and Cognos BI installations that|
use DB2 databases” on page 42|

Operating system user accounts affect the procedures that are used to create the
OpenPages database and Cognos Business Intelligence content store.

Related tasks:
[“Setting the file descriptor limit for OpenPages users on Linux operating systems’]

You must set the soft and hard limits for the file descriptor and update system files
to allocate sufficient resources to the OpenPages users.

Setting the file descriptor limit for OpenPages users on Linux
operating systems

You must set the soft and hard limits for the file descriptor and update system files
to allocate sufficient resources to the OpenPages users.

Procedure
1. Log on to the application server as root user.

2. Verify that the /etc/pam.d/system-auth file contains the correct settings by
typing the following commands:

 cat /etc/pam.d/system-auth | grep session | grep pam unix.so
The system response: session required pam_unix.so

 cat /etc/pam.d/system-auth | grep session | grep pam limits.so
The system response: session required pam_limits.so

Both commands must return a session line.

3. To determine the current value of the fs.file-max property that is set in the
/etc/sysctl.conf file, type the following command:

cat /etc/sysctl.conf | grep fs.file-max

 If the fs.file-max setting does not exist, add it to the /etc/sysctl.conf file
by typing the following commands:

echo "# Added to increase system open files" >> /etc/sysctl.conf
echo "fs.file-max=500000" >> /etc/sysctl.conf

 If the fs.file-max setting exists, but it is set to less than 500000, change the
fs.file-max setting to 500000.

4. Change the file descriptor limits in the /etc/security/Timits.conf file by
adding the following text to the end of the file before the #End of file text.

* soft nofile 100000
* hard nofile 200000

* soft stack 10240

5. To determine the startup limits for the number of processors, type the following
command:

1s /etc/security/limits.d/90-nproc.conf

* If this 90-nproc.conf file exists, then modify the number of processes to
4096.

* If the file does not exist, add the following lines to the end of the
/etc/security/Timits.conf file:

* soft nproc 4096
* hard nproc 5120
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The soft lift provides a specific limit that can be exceeded, for a short period,
up to the system hard limit.

6. Restart the system and then verify the settings that you changed by typing the
following command:

ulimit -a command.

64-bit Oracle Client software installations on OpenPages
application servers
Depending on your environment, you must install Oracle Client software on
multiple OpenPages GRC Platform application server computers to connect to

Oracle database. Use the Oracle Client driver files, networking components, and
tools to remotely administer the Oracle database.

Setting the ORACLE_HOME environment variable on
OpenPages admin and managed servers

Set up the ORACLE_HOME environment variable to point to the directory where
the Oracle database client software is installed. Set the variable on all admin and
managed servers.

Procedure

1. Log on to the application server as a user with administrative privileges and
full access to the local server drives.

Note: For AIX operating systems, log in as a non-root user, such as the opuser
user that you created for the OpenPages installation.

2. Set the ORACLE_HOME environment variable to point to the Oracle Client
installation directory.

set ORACLE_HOME=0RACLE BASE\client_software

3. Add the location of the Oracle client installation to the PATH environment
variable.

Custom OpenPages Database Schema installations

Instead of loading the default OpenPages database schema, you can load your own
custom configuration data. You can install the OpenPages application before you
load your custom data. However, you must load your data before you run the
OpenPages application.

Creating the OpenPages directories for AIX or Linux operating
systems

Create the installation directories for OpenPages and change the ownership of the
directory to the installation user.

Procedure
1. Log on to the database server as the root user.

2. From the shell prompt, if the installation directory for OpenPages and Fujitsu
IBPM do not exist, create them by typing the following command:

Restriction: Install OpenPages and Fujitsu Interstage BPM software, into a
directory that contains only ASCII characters in the path name.

mkdir -p <directory>
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mkdir -p /OpenPages
mkdir -p /Fujitsu
3. Change the ownership of the directories to the installation user.

Tip: For simplicity, use the same account (opuser) to install WebSphere
Application Server and the OpenPages application server.

Optionally, you can create two separate users:

* One user to install WebSphere Application Server.

* One user to install the OpenPages application.

Both users must both belong to the same primary group. If different users
install OpenPages and WebSphere, after the installation, you must change the

permission of the installation directories and files. To ensure that the group
members have write permission, modify the permissions to 775.

chown -R opuser /OpenPages
chown -R opuser /Fujitsu

Extracting the installation files for deploying OpenPages to
WebSphere Application Server

To improve performance, copy the installation kit files from the IBM OpenPages
GRC Platform media pack to the local system. Then, use an extraction utility to
uncompress the IBM OpenPages GRC Platform Administrative Console installation
files.

Procedure

1. Log on to the OpenPages application server as a user with administrative
privileges.

2. Extract the OpenPages Administrative Console installation files from the IBM
OpenPages GRC Platform Installer version for WebSphere Application Server
DVD or the IBM OpenPages GRC Platform Installer version for WebSphere
Application Server Linux x86-64 Multilingual DVD.

¢ If the source computer is on the Windows operating systems, go to the
\WIN64-0P_version\OpenPages\Win64\
OP_version_Non_Embedded WAS_Oracle_DB2_WIN64\
OP_version_Admin_and_Config_Console directory and extract the
opadminconsole-win32.win32.x86_64.zip file.

* If the source computer is on a Linux operating systems, go to the
Linux64/0P_version_Non_Embedded_LINUX64/
OP_version_Admin_and_Config_Console directory and extract the contents of
the opadminconsole-Tinux.gtk.x86_64.zip file.

Restriction: To avoid File path too Tong or other extraction errors, use a
compression utility, such as 7-Zip. Otherwise, extract the files to the root
directory or to the c:\temp or /tmp directory.

The extraction might take a few moments to finish.

3. To start the OpenPages Administrative Console installation program, go to the
path\opadminconsole directory and run the opadminconsole script.
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Related concepts:

“"File path too long” error or other errors when extracting installation files” on|

page 164_J{

When you extract compressed files from the installation media, you might see a
Error 0x80010135: File path too long error.

Installation options for deploying OpenPages to WebSphere
Application Server

Several deployment options are available for installing IBM OpenPages GRC
Platform. Use the Select the Installation Option dialog box to select the IBM
OpenPages GRC Platform component and the installation environment.

Deploying to WebSphere Application Server with DB2
database

To install and deploy IBM OpenPages GRC Platform to WebSphere Application
Server and to use a DB2 database for the OpenPages database, select the
deployment option in the Select the Installation Option page.

Before you begin

To deploy OpenPages GRC Platform to WebSphere Application Server and use a
DB2 database for the OpenPages schema, ensure that the following conditions are
met:

* Oracle compatibility mode is set for the DB2 database instance for the
OpenPages repository.
To check whether Oracle compatibility mode is set, run the following command
as a DB2 user:
db2set DB2_COMPATIBILITY_VECTOR ORA
If Oracle compatibility mode s not set, the following message is displayed:
db2set DB2_COMPATIBILITY_VECTOR DBI1303W Variable not set.

* The DB2 client software is installed.

* WebSphere Application Server is installed. and at least one profile is created.

Restriction: At least one WebSphere Application Server profile is required on
the OpenPages non-administrative server. If there is at least one profile on the
non-administrative server, you are not required to create one. If there is no
profile, you must create one. For more information about creating a profile by
using the Profile Management Tool or the manageprofiles command line tool,
see the [WebSphere Application Server Information Center (http://
pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp)

¢ The OpenPages Administrative Console files are extracted to the target
installation computer or to the source computer on the Windows operating
system.

Important: DB2 Text Search component is required.

DB2 Text Search component is an optional installable component. To install it, you
must select the custom installation type and the DB2 Text Search component. For
more information, see the [Installing and configuring DB2 Text Search|in the DB2
Information Center.
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If DB2 database server is installed on your computer, use the DB2 setup program
to add the DB2 Text Search function to your existing DB2 copy.

To determine whether text search is installed, run the db2ts command to start or
stop the text search. If the command fails, text search is not installed. For more
information about running the command, see jthe DB2 search commands|in the
DB2 Information Center.

Procedure

1.

For AIX and Linux operating systems, ensure that DB2_HOME/bin directory is in
the PATH environment variable .profile file of the OpenPages installation
user.

export DB2_HOME=<DB2_HOME>
. $DB2_HOME/db2profile

Log on to the source computer as a user with administrative privileges.

* For Windows operating systems, you must run the IBM GRC Platform
Administrative Console on the target Windows-based computer.

* For Linux operating systems, you can run the IBM GRC Platform
Administrative Console on the target Linux-based computer or on a
Windows-based computer.

* For AIX operating systems, you must run the IBM GRC Platform
Administrative Console from a Windows-based computer.

Go to the location where you extracted the installation files and run the
opadminconsole file.

* If you extracted the files to a Windows-based computer, go to the
path\opadminconsole-win32.win32.x86_64\opadminconsole directory,
right-click opadminconsole.exe, and click Run as administrator.

* If you extracted files to a Linux-based computer, go to the
path/opadminconsole-1inux.gtk.x86_64/opadminconsole directory, and run
the opadminconsole script file.

If the license agreement is displayed, accept the terms and click OK.

From the Select the Installation Option page, click the deployment option
that represents your target installation environment.

On the Properties panel, enter the properties that are required to deploy
OpenPages application servers and workflow server.

Tip: A description and online help for each property is displayed in the Help
view when you click the property. If the Help view is not visible, click View >
Help or press F1. For information about using the Administrative Console, in
the Help view, click Contents

If required, enter Connection Information.

To connect from the Windows-based computer to an AIX-based or
Linux-based computer, for the Connection Information, enter the host name
and user account information.

Important: For AIX and Linux operating systems, ensure that the WebSphere
Application Server installation user account has read, write, and execute
permissions for the IBM OpenPages GRC Platform installation files. For
simplicity, use the WebSphere Application Server user account to install and
run the OpenPages application server installation.
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8. For the OpenPages Application Server Information group of properties,
choose whether you are installing the OpenPages administrative server or
managed server, and then enter the property values.

In a clustered environment, there is only one administrative server and all
other application servers are managed servers.

You must install the OpenPages administrative server before you install the
managed servers.

Restriction: Install OpenPages and Fujitsu Interstage BPM software into a
directory that contains only ASCII characters in the path name.

Important: The installation path must be the same on the administrative
server and on all managed servers.

9. For AIX installations, ensure that the 32 bit JRE directory property points to
the location of a 32-bit Java Runtime Environment (JRE).

The 32-bit JRE is used during the installation Fujitsu Interstage Business
Process Management software (OpenPages workflow server). After the
workflow server is installed, OpenPages does not use the JRE.

Tip: To check the version of the Java Runtime Environment (JRE)
* Ensure that JAVA_HOME is not set.
* Go to the JRE_HOME/bin directory.
¢ Type the following command: java -version
The results display version information.

10. Select the appropriate option for Do you want to load the OpenPages
configuration data.

* Select Yes under most circumstances.
* Select No, if you already loaded the configuration data.

Example: In test environments that have multiple installations of
IBMOpenPages, the configuration data might already loaded.

If you select No, and the default configuration is not already loaded, you
must manually load the level-0 schema. Otherwise, you see garbled text
when you are in the OpenPages application. For more information see,
“Manually loading the configuration data after a new installation” on page|

i61]

11. For the CommandCenter Report Information group of properties, enter the
settings for IBM Cognos Business Intelligence and choose Command Center®
installation settings.

To check Cognos BI configuration settings, you can open IBM Cognos
Configuration and review the Environment properties.

12. For the WebSphere Application Server Information group of properties,
enter the settings.

Restriction: For Windows operating system, if you installed WebSphere
Application Server into a directory with spaces, you can enter the short file
name convention.

For C:\Program Files\IBM\WebSphere\AppServer, enter C:\PROGRAVI\IBM\
WebSphere\AppServer.

13. For the Database Information group of properties, select whether you
installed the OpenPages database schema manually.

94 1BM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide



* Select Install now to automatically install the OpenPages database schema
when OpenPages GRC Platform is deployed to WebSphere Application
Server.

* Select Already installed if the schema is installed.

The OpenPages database schema must exist before you deploy to
WebSphere Application Server. You can manually create the schema before
installation.

14. For the Database Information group of properties, enter the information for
the DB2 database instance that hosts the OpenPages database.

* For the Home Directory, enter the installation location of the DB2 database
instance for the OpenPages database.

Example: On Linux or AIX operating systems, /home/db2inst1/sq11ib or
on Windows operating systems, C:\ibm\SQLLIB

* Ensure that the installation user has write access to the locations that you
specify for the Database Path and Catalog Path properties.

* On AIX and Linux operating systems, the user accounts for the OpenPages
JDBC User Name and the Workflow JDBC User Name must exist.

15. To verify the settings that you entered, click Validate Properties.
If there are errors, change the settings that require attention.

Example: For Windows operating systems, if you enter an incorrect UNC
path for a property, you might see a "BasicConfigOperation" error during the
validation phase. Correct the path, and validate the properties again.

16. To install OpenPages GRC Platform, click Deploy.

Monitor the progress of the installation in the Deployment Steps or the Log
view. A message is displayed to indicate whether the installation succeeded. If
the installation fails, the OpenPages Administrative Console rolls back the
installation to the last successful checkpoint.

Results

If the installation completes with errors, examine the Log view in the user interface
for errors. Errors are displayed in red text. You can also review the log files that
are created during the installation by exporting them from the user interface or by
reviewing them in the path\opadminconsole\workspace\.metadata\.plugins\
com.ibm.openpages.config.install.ui\sessions directory.

For errors related to ObjectManager, review the ObjectManager.log file in the
OP_HOME/bin/1ogs directory and the <Host_Name>-0PNodelServerl-aurora.log in
the OP_HOME/aurora/logs directory. After you fix the errors, you can manually load
the configuration data. For more information, see [“Manually loading the|
lconfiguration data after a new installation” on page 161

What to do next

Some post-installation tasks are required, such as adding OpenPages application
servers to the Cognos Application Firewall safe list. You must also install
CommandCenter on the reporting server.
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Related tasks:

“Granting control on SYSTOOLS schema obijects to the DB2 database instance]
owner on the Windows operating system” on page 99|

After you install IBM OpenPages GRC Platform on Windows operating systems, if
the OpenPages installation user is not the same as the DB2 instance owner, the
OpenPages installation user must run the dba-grant.sql script. The script
explicitly grants control on SYSTOOLS schema objects to DB2 database instance
owner.

Deploying to WebSphere Application Server with Oracle
database

Use the OpenPages Administrative Console to deploy OpenPages application
server to WebSphere Application Server with an Oracle database for the
OpenPages database.

Before you begin

Ensure that the following conditions are met:

* The Oracle database instance for the OpenPages repository is created.

* Ensure that the Oracle database password for the system user account is not
expired.

* If the OpenPages and workflow database user accounts exist, ensure that the
Oracle database password for each of these accounts is not expired.

* IBM Cognos Business Intelligence is installed and running.

e The Oracle client software is installed.

* WebSphere Application Server is installed.

Restriction: At least one WebSphere Application Server profile is required on
the OpenPages non-administrative server. If there is at least one profile on the
non-administrative server, you are not required to create one. If there is no
profile, you must create one. For more information about creating a profile by
using the Profile Management Tool or the manageprofiles command line tool,
see the WebSphere Application Server Information Center| (http://
pic.dhe.ibm.com/infocenter/wasinfo/v8r5/index.jsp)

* The OpenPages Administrative Console files are extracted to the target
installation computer or to the source Windows-based computer.

Procedure
1. Log on to the source computer as a user with administrative privileges.

* For Windows operating systems, you must run the IBM GRC Platform
Administrative Console on the target Windows-based computer.

* For Linux operating systems, you can run the IBM GRC Platform
Administrative Console on the target Linux-based computer or on a
Windows-based computer.

2. Go to the location where you extracted the installation files and run the
opadminconsole file.

* If you extracted the files to a Windows-based computer, go to the
path\opadminconsole-win32.win32.x86_64\opadminconsole directory,
right-click opadminconsole.exe, and click Run as administrator.

 If you extracted files to a Linux-based computer, go to the
path/opadminconsole-1inux.gtk.x86_64/opadminconsole directory, and run
the opadminconsole file.
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10.

If the license agreement is displayed, accept the terms and click OK.

On the Select the Installation Option page, under OpenPages, double-click
the deployment option that represents your target installation environment.

On the Properties panel, enter the properties that are required to deploy
OpenPages application servers and workflow server.

Tip: A description and online help for each property is displayed in the Help
view when you click the property. If the Help view is not visible, click View >
Help or press F1. For information about using the Administrative Console, in
the Help view, click Contents.

To connect from the Windows-based computer to the Linux-based computer,
for the Connection Information, enter the host name and user account
information.

Restriction: Ensure that the WebSphere Application Server installation user
account has read, write, and execute permissions for the IBM OpenPages GRC
Platform installation files.

Important: For simplicity, use the WebSphere Application Server user account
to install and run the OpenPages application server installation.

For the OpenPages Application Server Information group of properties,
choose whether you are installing the OpenPages administrative server or
managed server, and then enter the property values.

In a clustered environment, there is only one administrative server and all
other application servers are managed servers.

You must install the OpenPages administrative server before you install the
managed servers.

Restriction: Install OpenPages and Fujitsu Interstage BPM software into a
directory that contains only ASCII characters in the path name.

Important: The installation path must be the same on the administrative
server and on all managed servers.

Select the appropriate option for Do you want to load the OpenPages
configuration data.

* Select Yes under most circumstances.
* Select No, if you already loaded the configuration data.

Example: In test environments where you have multiple installations of
IBMOpenPages and you already loaded the configuration data.

If you select No, and the default configuration is not already loaded, you
must manually load the level-0 schema. Otherwise, you see garbled text
when you are in the OpenPages application. For more information see,
“Manually loading the configuration data after a new installation” on page

o]

For the CommandCenter Report Information group of properties, enter the
settings for IBM Cognos Business Intelligence and choose Command Center
installation settings.

To check Cognos BI configuration settings, you can open IBM Cognos
Configuration and review the Environment properties.

For the WebSphere Application Server Information group of properties,
enter the settings.
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11.

12.

13.

Restriction: For Windows operating systems, if you installed WebSphere
Application Server into a directory with spaces, you can enter the short file
name convention.

For C:\Program Files\IBM\WebSphere\AppServer, enter C:\PROGRA~1\IBM\
WebSphere\AppServer.

For the Database Information group of properties, select whether you
installed the OpenPages database schema manually, and then enter the
settings.

* Select Install now to automatically install the OpenPages database schema
when OpenPages GRC Platform is deployed to WebSphere Application
Server.

* Select Already installed if the schema is installed.
The OpenPages database schema must exist before you deploy to

WebSphere Application Server. You can manually create the schema before
installation.

Restriction: The database passwords for all users, including the System
User Name, Sys User Name, OpenPages JDBC User Name, and Workflow
JDEBC User Name cannot contain spaces or special characters. Otherwise,
some OpenPages scripts, such as the OPBackup command might fail.

To verify the settings that you entered, click Validate Properties.
If there are errors, change the settings that require attention.
To install OpenPages GRC Platform, click Deploy.

Monitor the progress of the installation in the Deployment Steps or the Log
view. A message is displayed to indicate whether the installation succeeded. If
the installation fails, the Administrative Console rolls back the installation to
the last successful checkpoint.

Results

If the installation completes with errors, examine the Log view in the user interface
for errors. Errors are displayed in red text. You can also review the log files that

are created during the installation by exporting them from the user interface or by

reviewing them in the path\opadminconsole\workspace\.metadata\.plugins\

com.ibm.openpages.config.install.ui\sessions directory.

For errors related to ObjectManager, review the ObjectManager.Tog file in the
OP_HOME/bin/1ogs directory and the <Host_Name>-0PNodelServerl-aurora.log in
the OP_HOME/aurora/logs directory. After you fix the errors, you can manually load
the configuration data. For more information, see [“Manually loading the]

lconfiguration data after a new installation” on page 161]

What to do next

Some post-installation tasks are required, such as adding OpenPages application
servers to the Cognos Application Firewall safe list. You must also install
CommandCenter on the reporting server.
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Granting control on SYSTOOLS schema objects to the DB2 database
instance owner on the Windows operating system

After you install IBM OpenPages GRC Platform on Windows operating systems, if
the OpenPages installation user is not the same as the DB2 instance owner, the
OpenPages installation user must run the dba-grant.sql script. The script
explicitly grants control on SYSTOOLS schema objects to DB2 database instance
owner.

Procedure
1. Log on to the OpenPages application server as the OpenPages installation user.

The OpenPages installation user is the user account that runs the OpenPages
Administrative Console.

2. Start the DB2 command line processor.

On Windows operating systems, from the command prompt, type db2cmd, or
from the Start menu, click All Programs > DB2COPY1 > Command Window -
Administrator.

3. Go to the /OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS directory.
4. Run the dba-grant.sql script

clpplus -nw <username>/<password>@<hostname>:<portnumber>/<database-name>
@sql-wrapper dba-grant.sql dba-grant.log <instance.owner.username>

* username variable is the user name of the OpenPages installation user (the
user that is logged in to the system).

* password variable is the password of the OpenPages installation user.

* instance.owner.username variable is the DB2 database instance owner (the user
who creates the database instance).

If the OpenPages installation user is the same as the DB2 database instance
owner, no action is required. The script explicitly grants control on the
SYSTOOLS schema objects to DB2 database instance owner.

Testing the connections to the database server and the OpenPages

repository

Test whether the SQL*Net connect string can connect to the database listener by
using the TNSPING utility in the ORACLE HOME/bin directory. The TNSPING utility
tests if the listener is available. It does not test whether the databases behind the
listener are working.

To test that the OpenPages repository is created, use SQL*Plus to log on to the
OpenPages Oracle database schema.

Procedure

1. To test whether you can log on to Oracle Enterprise Manager Database Control,
the web-based interface that is used to administer an Oracle database, type the
following command:

https://oracle_server_name:port/em
In a default installation, the port number is 1158.

2. To test whether a SQL*Net connect string can connect to the listener, type the
following command:

tnsping database_instance_name
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The utility requests acknowledgement that the service name is valid and that
the listener is configured to handle requests for that service name.

If the configuration is correct, a message is displayed that shows the return
time.

If the configuration is not correct, the utility returns an error message. Ensure
that you use the correct service name and that the listener is started on the
server computer.

To test that OpenPages repository is created, type the following command:
sqlplus username/password@service name

For example, sqlplus system/openpages@op

The system connects you to an Oracle Database instance.

4. To exit SQL*Plus, type exit.
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Chapter 9. OpenPages CommandCenter installations

The OpenPages CommandCenter component integrates the OpenPages application
with IBM Cognos Business Intelligence. When you install the CommandCenter, the
IBM OpenPages Reporting Framework Generator is installed.

You can generate reports that use the hierarchy of OpenPages compliance objects.
You can also report on the metadata that is attached to those objects.

Prerequisite tasks for CommandCenter installations

Some prerequisite tasks are required before you install CommandCenter on the
reporting server.

Setting database environment variables for reporting servers
on Windows operating systems

You must set some system environment variables on the reporting server.

Procedure
1. Log on to the reporting server as a user with administrative privileges.

2. Set the following environment variables.

Table 36. Environment variable settings on the reporting server on Windows operating

systems

Environment variable Setting

JAVA_HOME Specifies the installation location of your Java Runtime
Environment (JRE).

COGNOS_HOME Specifies the location of IBM Cognos Business
Intelligence bin directory.

3. Append the JAVA_HOME to the PATH environment variable.

Example: Add %JAVA_HOME%/bin to the PATH environment variable.
4. If you are using an Oracle database for the OpenPages repository, set the
following environment variables.

Table 37. Oracle environment variable settings on the reporting server on Windows
operating systems

Environment variable Setting

ORACLE_HOME The default location is a subdirectory of
ORACLE_BASE, such as ORACLE_BASE=C:\app\
product\11.2.0

If you installed the OpenPages application and IBM
Cognos Business Intelligence on the same server, enter
the location for the 32-bit Oracle Client.

Example: ORACLE_HOME=C:\app\product\11.2.0\
client_32bit
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Table 37. Oracle environment variable settings on the reporting server on Windows

operating systems (continued)

Environment variable

Setting

TNS_ADMIN Specifies the location of the tnsnames.ora file
The default location is the Oracle_Home\network\admin
directory

NLS_LANG Specifies the database character set configured during

the database installation. By default, set it to
AMERICAN_AMERICA.AL32UTF8

To display non-English characters for Japanese locales,
set the NLS_LANG property:
NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

5. Append the ORACLE_HOME to the PATH environment variable.

Example: Add %0RACLE_HOME%/bin to the PATH environment variable.

Setting Oracle database environment variables for the
reporting server on AIX and Linux operating systems

If you use an Oracle database for the OpenPages repository, you must set some
system environment variables on the reporting server.

Procedure

1. Log on to the reporting server as a non-root user with administrative

privileges.

2. To determine the version of Java that is in the PATH variable, enter the

following command:
java -version

If you get the following error, Java is not in the PATH variable.

Command not found

3. Set the following environment variables.

Table 38. Environment variable settings on the reporting server on Linux or AlIX operating

systems

Environment variable

Example settings

JAVA_HOME

Specifies the installation location of your Java Runtime
Environment (JRE).

/opt/local/jdk1.6.0/bin

COGNOS_HOME

Specifies the installation location of IBM Cognos
Business Intelligence.

/opt/I1BM/cognos/c10

4. Append the JAVA_HOME to the PATH variable.

Example: PATH=$JAVA HOME/bin:$PATH
5. If you use an Oracle database for the OpenPages repository, set the following

environment variables.
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Table 39. Oracle database environment variable settings on the reporting server on Linux or
AlX operating systems

Environment variable Example settings

ORACLE_HOME The default location is /opt/oracle/openpages_data/
repository/clientll2_ac_x64/software

If you installed the OpenPages application and
CommandCenter on the same server, enter the location
to the 32-bit Oracle Client.

TNS_ADMIN Specifies the location of the tnsnames.ora file
The default location is the $0racle_Home\network\admin
directory

NLS_LANG Specifies the database character set configured during

the database installation. By default, set to
AMERICAN_AMERICA.AL32UTF8

Important: To display non-English characters for
Japanese locales, set
NLS_LANG=JAPANESE_JAPAN.JA16SJISTILDE

6. Append the ORACLE_HOME to the PATH variable.

Example: PATH=$0RACLE_HOME/bin:$PATH
7. Refresh the profile.

Enabling the connection to a remote DB2 database from the
CommandCenter computer

If the OpenPages database is on a DB2 server that is remote from the reporting
server, you must catalog the node and the database.

Cataloging a TCP/IP node adds an entry to the Data Server Client node directory
that describes the remote node. This entry specifies the chosen alias, the host name
or IP address, and the service name (or the port number) that the client uses to
access the remote host.

Before a client application can access a remote database, the database must be
cataloged on the client. When you create a database, the database is automatically
cataloged on the server with a database alias. The database alias is the same as the
database name, unless a different database alias is specified.

Tip: If the application server and database server on the same computer, you can
ensure that the Cognos installation user has access to the OpenPages data source
by cataloging the OpenPages repository node and database.

Before you begin
Ensure that DB2 client software is installed on the OpenPages reporting server.

Procedure
1. Log on to the reporting server with a valid DB2 user ID.
2. Start the DB2 command line processor.

* On Windows operating systems, issue the db2ecmd command from a command
prompt.
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* On Linux or UNIX operating systems, issue the db2 command from a
command prompt.

3. Catalog the node by entering the following commands in the command line
processor:
db2 catalog tcpip node <node_name> <remote hostname|ip_address>
<server service_name|port_number>

db2 terminate

Example:

db2 catalog tcpip node OPNODE remote mycomputer.domain.com server 50000

db2 terminate

4. Catalog the database by entering the following commands in the command line
processor:

db2 catalog database <database_name> as <database_alias> at
node <node_name> [ authentication <auth value> ]

Example:
catalog database OPX at node OPNODE authentication server

db2 terminate

5. To list the node directory, type the following command:
db2 Tist node directory show detail

6. To list the database directory, type the following command:
db2 1ist database directory

Creating the installation directory for CommandCenter on AIX
and Linux operating systems

Create the installation directory for the CommandCenter installation and change
the ownership of the directory to the installation user.

Procedure
1. Log on to the reporting server as a root user.
2. Open a shell.

3. If the CommandCenter installation directory does not exist, create it by typing
the following command:

Restriction: Install CommandCenter, into a directory that contains only ASCII
characters in the path name.
mkdir -p <CC_HOME>
4. To change ownership of the directory, type the following command:
chown -R <user>:<group> <CC_HOME>

Important: Different users install CommandCenter and Cognos. However, both
users must belong to same primary group. Ensure that the installation
directories and files have the correct permission. To ensure that the group
members have WRITE permission to the files, change the directory and file
permissions to 775.
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Extracting the installation files for deploying CommandCenter

To improve performance, copy the installation kit files from the IBM OpenPages
GRC Platform media pack to the local system. Then, use a compression utility to
extract the OpenPagesAdministrative Console installation files.

Procedure

1.

Log on to the OpenPages reporting server as a user with administrative
privileges.

Extract the OpenPages Administrative Console installation files from the IBM
OpenPages GRC Platform Installer version for WebSphere Application Server

DVD or the IBM OpenPages GRC Platform Installer version for WebSphere
Application Server Linux x86-64 Multilingual DVD.

¢ If the source computer is on the Windows operating systems, go to the
\WIN64-0P_version\OpenPages\Win64\
OP_version Non_Embedded WAS Oracle DB2 WIN64\
OP_version_Admin_and_Config_Console directory and extract the
opadminconsole-win32.win32.x86_64.zip file.

¢ If the source computer is on a Linux operating systems, go to the
Linux64/0P_version Non_Embedded LINUX64/

OP_version_Admin_and_Config_Console directory and extract the contents of

the opadminconsole-Tinux.gtk.x86_64.zip file.

Restriction: To avoid File path too Tong or other extraction errors, use a
compression utility, such as 7-Zip. Otherwise, extract the files to the root
directory or to the c:\temp or /tmp directory.

The extraction might take a few moments to finish.

To open the OpenPages Administrative Console installation program, go to
path\opadminconsole directory.

4. Run the opadminconsole file.

* If the source computer is on a Windows operating system, right-click
opadminconsole.exe and click Run as Administrator.

* If the source computer is on a Linux operating system, double-click
opadminconsole, or from the command line, type ./opadminconsole.

Deploying CommandCenter on the reporting server

In the OpenPages GRC Platform Administrative Console, select one of the options
to deploy CommandCenter.

Before you begin

For CommandCenter installations, ensure that the following conditions are met

OpenPages application server is installed and running.

IBM Cognos Business Intelligence is installed and the Cognos services are
running.

IBM Cognos Configuration is closed
Database client software is installed.

JAVA_HOME and the content store database environment variables are set.

Procedure

. Log on to the reporting server as a user with administrative privileges.
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10.

* For local installations on the Windows or Linux operating systems, log on
to the computer where IBM Cognos Business Intelligence is installed.

* For remote installations on the UNIX or Linux operating systems, log on to
the computer where you extracted the installation files.

Log on as a non-root user, such as the opuser user.

Go to the location where you extracted the installation files and run the
opadminconsole file.

* If you extracted the files on a Windows operating system, go to the
path\opadminconsole-win32.win32.x86_64\opadminconsole directory,
right-click opadminconsole.exe, and click Run as administrator.

 If you extracted files on a Linux operating system, go to the
path/opadminconsole-Tinux.gtk.x86_64/opadminconsole directory, and run
the opadminconsole file.

If the license agreement is displayed, accept the terms and click OK.

From the Select the Installation Option page, click the deployment option
that represents your target installation environment.

Specify the settings that will be applied when you install CommandCenter.

Tip: A description and online help for each property is displayed in the Help
view when you click the property. For information about using the OpenPages
Administrative Console, in the Help view, click Contents

For target Linux or AIX operating systems, choose the Connection Method.

Depending on the operating system of the target installation computer, you
connect to the local or remote target computer

* To install on an AIX operating system, choose Remote (SSH).

* To install on a Linux operating system, you can choose Connect to Local
Machine or Remote (SSH).

For the CommandCenter Report Information group of properties, enter the
settings for IBM Cognos Business Intelligence and choose CommandCenter
installation settings.

To check Cognos BI configuration settings, you can open IBM Cognos
Configuration and review the Environment properties.

Restriction: Install CommandCenter into a directory that contains only ASCII
characters in the path name.

In the Database Information group of properties, enter the installation
location of the DB2 database instance for the Cognos content store in the
Database Home property.

To check the content store settings, you can open IBM Cognos Configuration
and review the Data Access > Content Manager > Content Store properties.

You can use the same Oracle database instance for the content store schema
and the OpenPages schema.

Restriction: You must use separate DB2 database instances for the content
store database and the OpenPages database.

For the OpenPages Application Server Information group of properties, enter
the configuration settings for the OpenPages administrative server

To verify the settings that you entered, click Validate Properties.

If there are errors, change the settings that require attention.
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Example: If you enter an incorrect UNC path for a property, you might see a
BasicConfigOperation error during the validation phase. Correct the path, and
validate the properties again.

11. To install CommandCenter, click Deploy.
Monitor the progress of the installation in the Deployment Steps or the Log
view. A message is displayed to indicate whether the installation succeeded. If
the installation fails, the OpenPages Administrative Console rolls back the
installation to the last successful checkpoint.

12. Close the OpenPages Administrative Console.
Results

If the installation completes with errors, examine the Log view in the user interface
for errors. Errors are displayed in red text. You can also review the log files that
are created during the installation by exporting them from the user interface or by
reviewing them in the path\opadminconsole\workspace\.metadata\.plugins\
com.ibm.openpages.config.install.ui\sessions directory.

What to do next

Some post-installation tasks are required, such as adding OpenPages application
servers to the Cognos Application Firewall safe list.

CommandCenter post installation tasks

After you install CommandCenter, some post installation tasks are required. You
must update CommandCenter configuration files to ensure that OpenPages
components can communicate with each other.

Copying the IBM Global Security Kit files to the DB2 server
installations on Windows operating systems

On Windows operating systems, you must copy the 32-bit version of the IBM
Global Security Kit (GSK) files to the DB2 server instance location. You must copy
the files before you generate the reporting framework.

Procedure
1. Log on to the database server computer.

2. Go to the DB2_HOME\bin directory for the OpenPages database instance and
create a folder named icc.

3. Copy the contents of the C:\Program Files (x86)\IBM\gsk8\1ib directory to
the DB2_HOME\bin\icc directory.

Creating the reporting schema and framework

To see the default OpenPages reports, you must create a reporting schema and
update the reporting framework.

Procedure
1. In a web browser, open the OpenPages application:
http://openpages _server:port/openpages
2. Log on to the OpenPages application as a user with administrative privileges.
For System Admin Mode, switch from Disabled to Enabled.
4. From the menu bar, click Administration and select Reporting Schema.

w
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5. Click Create.

6. After the create operation finishes, click System Admin Mode to switch from
Enabled to Disabled.

7. From the menu bar, click Administration > Reporting Framework >
Generation.

8. On the Reporting Framework Operations page, click Update.

9. In the Reporting Framework Generation window, under Framework
Generation, select the Framework Model and Labels and other options you
want for the relational data model.

10. Click Submit.
11. To view the progress of the update, click Refresh.

The Percent Complete column on the Reporting Framework Operations table
updates the percentage of completion.

Results

Updating the reporting framework process takes approximately 30 minutes or
longer.

What to do next

You must drop the reporting schema before you install the IBM OpenPages GRC
Platform Modules.

CommandCenter portal security

After installation, you can restrict which user groups are allowed to modify
reports. To grant CommandCenter administrative rights, create a group in the
OpenPages application or use an existing group, such as OPAdministrators. This is
optional.

OpenPages standard reports can be overwritten during an upgrade. If you want to
modify these standard reports, copy them to your personal folders. From your
folders, you can then change the reports and restrict access to them.

To restrict user access to administrative functions within the Cognos portal, use
IBM Cognos Administration. To prevent users from deleting, changing, or saving
reports, restrict access to the OpenPages reports that are in Public Folders. You can
also restrict users from running reporting tools, such as Report Studio, or from
modifying CommandCenter reports.

For more information, see the IBM OpenPages GRC Platform Administrator’s Guide.

Creating an open session command block for the OpenPages
data source

For IBM OpenPages GRC Platform to work, you must create an open session
command block for the OpenPages data source.

Procedure

1. In the Internet Explorer browser, type the following URL:
http://cognos_server_name/ibmcognos

2. Open IBM Cognos Administration:
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a. If the Cognos Welcome page is displayed, click Administer IBM Cognos
Content.

b. If the IBM Cognos Connection is displayed, click Launch > IBM Cognos
Administration.

On the Configuration tab, click Data Source Connections.
Click More next to OpenPages DataSource.

Click Set properties.

Select the Connection tab.

Beside the Open session commands, click Set.

In the XML database commands box, copy the following text:

<commandBTock>

<commands>

<sq1Command>

<sql>begin OP_SESSION_MGR.SET ACTOR_ID PRIVATE
(#$account.parameters.openPagesUserId#);end;</sql>
</sq1Command>

</commands>

</commandBlock>

Click OK to save your changes.
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Chapter 10. Post installation tasks

After installing the OpenPages GRC Platform, you can modify the installation
environment to improve performance, enhance security, or change default settings.
For example, you can tune the application servers or configure LDAP.

For information about SSL configuration, adding a member to a cluster, or
changing ports, see the IBM OpenPages GRC Platform Administrator’s Guide.

Configuring OpenPages to work on a single computer

For test and development environments, you can install IBM OpenPages GRC
Platform, Oracle database, the 32-bit Oracle Client, and Cognos Business
Intelligence on a single computer. However, some configuration is required.

About this task

You can install the IBMOpenPages GRC Platform on a single computer as for
predeployment testing or proof of concept demonstrations. For single computer
installations, ensure that the correct Oracle Client is used by each software
component.

If you install OpenPages GRC Platform on a single server, you must install two
versions of Oracle Client. Both the 32-bit and 64-bit versions are required. The
OpenPages application requires the 64-bit Oracle Client and the Cognos Business
Intelligence Software requires the 32-bit Oracle Client.

Procedure
1. Log on to the CommandCenter server as a user with administrative privileges.

2. Ensure that the ORACLE_HOME environment variable points to the 32-bit
Oracle Client.

3. Edit the PATH variable to add %0RACLE_HOME%\bin.
4. If set, remove the TNS_ADMIN variable.

5. From the command line, go to the OP_Home\CommandCenter\framework\conf\
directory.

6. Open the framework.properties file in a text editor and ensure that the
oracle.client.path property contains the location of the 32-bit Oracle client
bin directory.

7. Save and close the file.
8. Restart the CommandCenter service.
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After installing the OpenPages application, verify that the installation is working

as expected.

Use the following checklist to verify whether the installation is successful.

Table 40. Post-installation verification checklist

Task

Guidance

Review all installation logs for errors.

For log file locations and names, see
ﬁ

Verify that the database parameters are
correct.

Review the database parameters, such as
Character set=AL32UTF8 and
NLS_LENGTH_SEMANTICS=CHAR, to ensure that they
are correct.

Verify that a backup copy of the system
was made after installing.

If it does not exist, create a backup of your
system by running the OPBackup command from
OP_HOME\aurora\bin directory.

Verify that a compressed file was created with
the correct timestamp. The file is in the
OP_Home\openpages-backup-restore directory.

For information about on using the backup
utility, see the IBM OpenPages GRC Platform
Administrator’s Guide.

Confirm that the reporting schema and
framework generated successfully.

For more information, see f’Creating thel
[reporting schema and framework” on page 107.|

Confirm that base reports are functioning
as expected.

Log on to the OpenPages application and run
the AT1 Documentation CommandCenter report.

If single signon (SSO) is enabled, verify
that user accounts can access the
environment.

Log on to the OpenPages application with an
SSO user account.

If you use TeamMate, confirm that the
TeamMate loader-files are implemented
and working.

Test the integration from the TeamMate client.

Confirm that you can upload and
download sample attachments.

Log on to the OpenPages application and
upload and download a file attachment.

Verify that links in reports reference the
correct server address and use the correct
web URL parameters.

Run a report that uses OpenPages links. Select a
link and confirm that the target object is
rendered successfully in the OpenPages
interface.

For clustered environments, verify that
all servers can upload and download
attachments.

Upload and download files from both primary
and secondary application servers.
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Table 40. Post-installation verification checklist (continued)

Task

Guidance

For load-balanced environments, confirm
that backup scheduling is working.

Ensure that services on secondary servers
are stopped before backing up the
primary server. Ensure that services are
started post 7001 (port) availability on
the primary server.

On primary and secondary servers, verify
backup scheduling and process times.

Test that you can access the IBM Cognos
Business Intelligence portal.

Type the following web URL:
http://server_name/ibmcognos

Confirm that you can log on to the portal.

Confirm that you ran the
enable-session-sleep.sql script.

For more information, see f’Preventingl

concurrency conflicts for installations that use

Oracle databases” on page 117

After backup, confirm that object data is

Log on to the OpenPages application and create

created. sample Entity, Process, and Risk objects. Delete

these objects.

Related concepts:

[“Log files” on page 157|
Use the log files to help troubleshoot problems that occur during the installation.

Fix pack installations

IBM provides interim maintenance packages that contain updates to one or more
components in your IBM product. If a fix pack is available when you are installing
or upgrading, install it after you install the IBM OpenPages GRC Platform.

If a fix pack becomes available after you deploy OpenPages applications:
1. Stop all services.

2. Backup content and directory structures.

3. Install the fix pack in the same location as existing components.
4. Restart services

Fix packs are cumulative. When you install the latest fix pack, it includes updates
from all the previous fix packs.

Fix packs are available for download from (http:/ /www.ibm.com/
support/us/en).

Note: Fix packs are not stand-alone installations. You must install them on
computers that have IBM OpenPages components installed. Install the fix packs
that are appropriate for your product version.

Database server tuning

To improve performance, tune the Oracle database. You must change some of
default values for Oracle server parameters. Other changes are suggested in
environments where there are heavy user loads.
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Tuning the performance of the database instance

To improve the performance of the Oracle database instance, disable the Oracle
skip scan and set cursor sharing to force.

The Oracle skip scan feature splits a composite index logically into smaller
subindexes. In skip scanning, the initial column of the composite index is not
specified in the query. In other words, it is skipped. For larger databases where the
data changes frequently, skip scanning can be less efficient than a range scan.

The cursor sharing feature specifies how SQL statements are parsed. Issuing
many SQL statements that have literal values can result in many nearly identical
statements in the cache. The large result set can slow performance and cause latch
problems. Setting cursor sharing to force causes the SQL statements to be reused
if the text is similar except for the literal value.

Procedure
1. Log on to a computer with SQL*Plus and access to the database server.

Note: For AIX installations, use opuser user or another non-root user.
2. From the command-line, log on to SQL*Plus.

sqlplus sys/sys_password@SID as sysdba
3. At the SQL prompt, type the following command:

alter system set " optimizer_skip_scan_enabled"=false scope=both;
alter system set cursor_sharing = force scope=both;

4. Log out from SQL*Plus.

Memory tuning guidelines for Oracle databases

If your application is running in a heavy-load environment, consider allocating as
much memory as possible to the Oracle database instance.

The following table provides general guidelines for memory allocation on a system
with 4 GB of RAM or more.

Table 41. Memory Tuning Guidelines

For this... Allocate...

Operating system 1 - 4 GB of physical RAM

SGA Size 75% of remaining physical RAM to the SGA_TARGET
parameter.

Minimum allocation: 2048 MB (or 2 GB)

PGA Size 25% of remaining physical RAM to the
PGA_AGGREGATE_TARGET parameter.

Minimum allocation: 1024 MB (or 1 GB)

Example 1: Computer with 4 GB of RAM

If a computer has 4 GB of physical RAM:
* SGA (2 GB) and PGA (1 GB)
* 1 GB is available for the Windows OS
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Example 2: Computer with 8 GB of RAM

If a computer has 8 GB of physical RAM and you want 2 GB available for the
Windows OS, then 6 GB remains for allocation to Oracle. The remaining 6 GB can
be allocated to a single database instance:

* SGA: 4608 MB (or 4.5 GB, which is 75% of 6 GB)
* PGA: 1536 MB (or 1.5 GB, which is 25% of 6 GB)

Example 3: Computer with multiple database instances

Note: If you are planning to run multiple database instances on the same
computer, adjust the memory to ensure that concurrently running instances fit into
the available physical RAM. Using physical memory avoids swapping to disk.

For example, to run the OpenPages Repository and CommandCenter Repository
services on the same computer with 8 GB of RAM:

¢ 1 GB of RAM for the OS

¢ The remaining 7GB of RAM can be split between the OpenPages Repository and
CommandCenter Repository as follows:

— OpenPages Repository instance: 3 GB SGA + 1.5 GB PGA
— CommandCenter Repository instance: 1.5 GB SGA + 1 GB PGA

Admin server tuning

You can tune your admin server settings to improve performance.

Configuring the database connection pool on AIX computers

The OpenPages and workflow servers each have a pool of JDBC connections that
can be used by applications when connecting to the database. You must configure
the number of available connections in the pool. Depending on your situation, use
your previous settings or the number of named users as a guideline. These
connections are returned to the connection pool when the application disconnects
from the database.

Procedure
1. Open a web browser.

2. Enter the following URL to go to the IBM Integrated Solutions Console for the
OpenPages server.

http://0P_server _name:port/ibm/console/
The port is assigned during installation. By default the port used is 9060.

Note: Do not use 1ocalhost for the OP_server_name.
Expand Resources > JDBC.

Click Data sources from the list.

On the Data Sources page, click the data source.

ook w

On the data source page, under Additional Properties, click Connection Pool
Properties.

7. On the Connection Pools page, enter a value for the Maximum connections
and Minimum connections.

The default value for Maximum connections is 75 and for Minimum
connections is 1.
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10.
11.

12.

For an upgrade installations, enter the value set in your previous system
Click Apply.

To commit the changes to the master configuration, in the Messages box, click
Save and then click OK.

Log out of the Integrated Solutions Console.

Navigate to Integrated Solutions Console for the workflow server
http://workflow_server_name:port/ibm/console/

The port is assigned during installation. By default the port used is 9061.

Note: Do not use localhost for the workflow_server_name.

Repeat steps 3-10 to configure the database connection pool for the workflow
server.

Enabling simultaneous access to OpenPages applications and
Fujitsu Interstage BPM for a single user on AIX computers

By default, the IBM WebSphere Application Server does not allow a single user to
log on to the OpenPages application and the Fujitsu Interstage BPM console
concurrently. Some configuration is required to enable simultaneous access by the
same user to both applications.

Procedure

For OpenPages applications:

1.
2.

Open a web browser.

Enter the following URL in the IBM Integrated Solutions Console for the
OpenPages server.

http://0P_server_name:port/ibm/console/
The port is assigned during installation. By default the port used is 9060.

Note: Do not use localhost for the OP_server_name.

Expand Servers > Server Types.

Click WebSphere application servers from the list.

On the Application servers page, for each OpenPages server listed:
a. Click the application server you want to configure.

b. On the OpenPages-server-name page, click the Configuration tab.

c. Under Container Settings, expand Web Container Settings and then click
Web container.

. On the Web Container page, click Session management.
. Under Session tracking mechanism, click Enable cookies.

. Click Apply.

. To commit the changes to the master configuration, in the Messages box,
click Save.

i. Click OK to exit.

d
e
f. On the Cookies page, enter opsosa in the Cookie name field.
g
h

For Fujitsu Interstage BPM:

6.
7.

Open a web browser.
Type the following URL:
http://0P_server _name:port/ibm/console/
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8. Expand Servers > Server Types.
9. Click WebSphere application servers from the list.
10. On the Application servers page, for each OpenPages server listed:
a. On the OpenPages-server-name page, click the Configuration tab.

b. Under Container Settings, expand Web Container Settings and then click
Web container.

. On the Web Container page, click Session management.

. Under Session tracking mechanism, click Enable cookies.

. Click Apply.

. To commit the changes to the master configuration, in the Messages box,
click Save.

Click OK to exit.

C
d
e. On the Cookies page, enter opibpm in the Cookie name field.
f
g

=

Preventing concurrency conflicts for installations that use
Oracle databases

If two administrators both try to modify settings at the same time, errors might
occur. To help avoid concurrency errors, run the SQL enable-session-sleep.sq]l
script.

A concurrency conflict might result in the following error message:

Operation failed, security settings are being
concurrently modified by another administrator.
Please try again later.

Procedure

1. On a computer that has SQL*Plus and access to the database server, log on as a
user with SYSDBA permissions.

2. From the Installer DVD or from your network share location, copy the
/OP_version_Configuration/Database/ORACLE/INSTALL_SCRIPTS directory to the
local system.

3. Run the enable-session-sleep.sql script.
On a command line, use the following syntax:

sqlplus /nolog @sql-wrapper enable-session-sleep.sql <log file_name>
<connect_identifier> <sysdba_user_name>
<sysdba_user_password> <schema_owner_name>

Example:

sqlplus /nolog @sql-wrapper enable-session-sleep.sql enable-session-sleep.log
opx10g sys manager openpages

If the process completes successfully, a message is displayed.
If the script fails, check the log files for error messages.

Optional: Increasing the paging file size on Windows
computers
On computers that have 4 GB of RAM, the suggested paging file size is 8 GB.

Procedure
1. Click Start > Run and then type sysdm.cpl, and press Enter.
2. Click the Advanced tab, then in the Performance section, click Settings.
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In the Performance Options dialog box, in the Virtual Memory section, click
the Advanced tab, and then click Change.

Find the list of drives and select the drive that contains your paging file.

Note: If necessary, clear the Automatically manage page file size for all
drives box.

Under Paging File Size, select Custom Size.

Reset both the Initial Size and Maximum Size values to higher values.
Click Set.

Click OK to close the three open dialog boxes.

Optional: Increasing the paging file size on AIX computers
On computers that have 4 GB of RAM, the suggested paging file size is 8 GB.

Procedure

1.
2.

On AIX computers, open a shell as user with administrative privileges.

Type the following command to change the attributes of the paging space:
chps -s LogicalPartitions <PagingSpace Name>

For example, the following command adds four logical partitions to the pgspce
paging space:

chps -s 4 pgspce

OpenPages application server tuning

You can tune application server settings to control how the application server
provides services for running applications and their components. Each application
server instance contains interrelated components that must be properly tuned to
support the specific needs of your application.

Enabling LDAP

If you are installing OpenPages GRC Platform into an environment that uses
LDAP environment, you must enable LDAP. The Openpages module in the LDAP
configuration file, aurora_auth.config, determines whether LDAP is enabled. If
you have a load-balanced system, disable LDAP on the primary and secondary

servers.
Procedure

1. Log on to the OpenPages application server as a user with administrative
privileges.

2. Use your LDAP Directory Server to add users who require access to the
OpenPages application or to the OpenPages environment to the LDAP
authentication server.

For more information about the steps required to add OpenPages users to the
LDAP server, see your LDAP Directory Server.

3. Log on to the OpenPages application and create the same users.

4. Stop all OpenPages services.

5. Go to the directory where you copied the aurora_auth.config file.

6. Open the LDAP configuration file, aurora_auth.config, in a text editor.

7. Rename the Openpages module to something different, such as

Openpages_default..
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8. Depending on your LDAP server, rename the LDAP modules to Openpages

* If you are using a Microsoft Active Directory server, change the OpenpagesAD
module name to Openpages.

* If you are using a Sun One Directory Server, change the OpenpagesIP
module name to Openpages.

9. Specify the correct values for the following properties in the appropriate
module:

Table 42. Property settings and description

Property Description

provider.url IP address and port number of the LDAP
authentication server, in the
<protocol>://<ip_address>:<port> format.
Note: If you are configuring LDAP over SSL
(LDAPS), the protocol is Tdaps and the port
is the LDAPS port.

security.search.user.dn The fully qualified name of an
administrative user on the LDAP server.

security.search.user.credentials The password for the specified user

base.dn The top level of the LDAP directory tree
structure (Domain Name) on the LDAP
server.

If the users to be authenticated are in
multiple locations within your Active
Directory structure, list all locations
explicitly. Use the distinguished names of
the locations, each separated by a
semi-colon.

user.attr.id The attribute name of the user identifier.

Typically a common name (CN), uid, or
sAMAccountName.

For example, Openpages_default
{
com.openpages.aurora.service.security.namespace.AuroraloginModule
required debug=false;
bs
Openpages
{
com.openpages.aurora.service.security.namespace.LDAPLoginModule
required debug=false
provider.url="1dap://10.128.25.150:389"
security.authentication="simple"
security.search.user.dn="CN=Administrator,
CN=Users,DC=LDAPTesting,DC=T1ocal"
security.search.user.credentials="openpages"
base.dn="CN=Users,DC=LDAPTesting,DC=Tocal"
user.attr.id="CN"
bs

10. Save and close the file.

11. Log on to the OpenPages application and change the OpenPages
Administrator password to openpages.
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12. Restart all OpenPages services.

13. Log on to the OpenPages application as one of the users that you created in
the LDAP Directory Server.

Disabling LDAP

If LDAP is enabled on your system, the default Openpages module was renamed.
Either the OpenpagesIP or OpenpagesAD was renamed to Openpages. To disable
LDAP, change the name of the current Openpages module and change the name of
the default Openpages module back to Openpages.

Procedure

1. Log on to the application server as a user with administrative privileges.
2. Stop all OpenPages services.

3. Go to the directory where you copied the aurora_auth.config file.
OP_HOME\aurora\conf

Open the LDAP configuration file, aurora_auth.config, in a text editor.
Change the name of the Openpages_default module back to Openpages.
Change the name of the current Openpages module to something different.

No o~

Save and close the file.

Accessing OpenPages

To view the application login page for your installation, type the OpenPages URL
into your web browser.

For default installations, type the following URL in your web browser:
http://openpages_server:port/openpages

If you are using an SSL connection to access the OpenPages application, you must
have an SSL digital certificate. After configuration, type the following URL in your

web browser:

https://openpages server:ssl_port/openpages

120 1BM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide



Chapter 11. Starting and stopping OpenPages servers

IBM OpenPages GRC Platform runs only if all of the services are started. All of the
services for supporting software, such as the database server and Cognos Business
Intelligence, must also be running.

Important: If you are running OpenPages GRC Platform in a load-balanced
environment, you must start the admin server before you start any managed
servers in the cluster.

Procedure
1. Log on to the OpenPages application server as user with administrative
privileges.

2. Open a Command Prompt window, and go to the OP_HOME\bin directory.

3. Enter the following command to run a script that starts the OpenPages and
workflow (Fujitsu Interstage BPM) services:

StartAll1Servers.cmd

4. Enter the following command to run a script that stops the OpenPages and
workflow (Fujitsu Interstage BPM) services:

StopAliServers.cmd
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Chapter 12. Configuring clustered environments

To accommodate increased user loads, scale horizontally or vertically by adding
nodes to the OpenPages environment. When you scale, load balancing is required
to distribute the incoming requests across the nodes.

A node consists of an instance of the OpenPages application server and a
corresponding instance of the workflow server. Each node runs on a different port.

You can also scale the CommandCenter, the OpenPages reporting server, vertically
or horizontally.

Scaling the reporting server vertically

Scaling vertically increases the number of processes that are available to handle
requests. Depending on the load, scaling vertically might involve configuring
additional dispatchers

Scaling the reporting server horizontally

Scaling horizontally requires that you install additional report servers. Configure
the additional Cognos dispatchers to ensure that the incoming requests are
distributed across the multiple servers.

Load balancing configurations
To create a clustered OpenPages environment, install and configure each
OpenPages and CommandCenter instance as a stand-alone system. Then, configure

each system for load balancing.

You can deploy a hardware or software load balancer. The load balancer must
support session affinity and port-based URL routing.

Install the load balancer on the OpenPages application server or on an external
system.

Configuring an
system service

OpenPages cluster to run as a Windows operating

You can configure an OpenPages and workflow cluster on WebSphere Application
Server to run as services on the Windows operating system. When WebSphere
Application Server clusters run as a service, the cluster automatically restarts after
a failure. Also, cluster member processes remain active after you log out from your
Microsoft Windows system account.

Procedure
1. On the OpenPages administrative server, log on as an administrator.

2. Click Start > All Programs > Accessories, and right-click Command Prompt >
Run as Administrator.

3. From the command prompt, go to the WAS_HOME\bin directory, and run the
following command:
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wasservice -add OpenPagesDmgr -servername dmgr -profilePath
"<O0P_HOME>\profiles\OpenPagesDmgr" -wasHome

"<WAS_HOME>" -TogFile
"<0P_HOME>\profiles\OpenPagesDmgr\logs\dmgr\startServer.log"
-TogRoot "<OP_HOME>\profiles\OpenPagesDmgr\1ogs\dmgr

4. Run the following command:

wasservice -add <HOST_NAME>-OPNodel -servername nodeagent -profilePath
"<OP_HOME>\profiles\<HOST_NAME>-OPNodel"

-wasHome "<WAS_HOME>" -logFile
"<OP_HOME>\profiles\<HOST_NAME>-OPNodel\logs\nodeagent\startServer.log"
-TogRoot "<OP_HOME>\profiles\<HOST NAME>-OPNodel\logs\nodeagent

5. On each OpenPages application server, run the following command:

wasservice -add <HOST_NAME>-OPNodelServer<SERVER#> -servername
<HOST_NAME>-0PNodelServer<SERVER#> -profilePath
"<O0P_HOME>\profiles\<HOST_NAME>-0PNodel" -wasHome

"<WAS_HOME>" -1ogFile "<OP_HOME>\profiles\<HOST_NAME>
-0PNode1\10gs\<HOST_NAME>-OPNodelServer<SERVER#>\startServer.log"
-TogRoot "<OP_HOME>\profiles\<HOST_NAME>-OPNodel\10gs\<HOST_NAME>
-OPNodelServer<SERVER#>

6. Run the following command:

wasservice -add IBPMDmgr -servername dmgr -profilePath
"<WORKFLOW_HOME>\profiles\IBPMDmgr" -wasHome

"<WAS_HOME>" -TogFile
"<WORKFLOW_HOME>\profiles\IBPMDmgr\logs\dmgr\startServer.log"
-TogRoot "<WORKFLOW_HOME>\profiles\IBPMDmgr\1ogs\dmgr

7. Run the following command:

wasservice -add <HOST_NAME>-1BPMNode<SERVER#>

-servername nodeagent -profilePath

"<WORKFLOW_HOME>\profiles\<HOST NAME>-IBPMNode<SERVER#>"

-wasHome "<WAS_HOME>" -logFile

"<WORKFLOW_HOME>\profiles\<HOST NAME>
-IBPMNode<SERVER#>\10gs\nodeagent\startServer.log" -logRoot
"<WORKFLOW_HOME>\profiles\<HOST_NAME>-IBPMNode<SERVER#>\1ogs\nodeagent"

8. Run the following command:

wasservice -add <HOST_NAME>-1BPMNode<SERVER#>Server -servername
<HOST_NAME>-1BPMNode<SERVER#>Server -profilePath
"<WORKFLOW_HOME>\profiles\<HOST NAME>-1BPMNode<SERVER#>"

-wasHome "<WAS_HOME>" -logFile

"<WORKFLOW_HOME>\profiles\<HOST NAME>
-IBPMNode<SERVER#>\10gs\<HOST_NAME>-1BPMNode<SERVER#>Server\startServer.log"
-TogRoot "<WORKFLOW_HOME>\profiles\<HOST NAME>
-IBPMNode<SERVER#>\10gs\<HOST_NAME>-1BPMNode<SERVER#>Server"

9. Repeat steps 7 and 8 on each workflow server.

Removing Windows operating system services for OpenPages
and workflow servers

To remove OpenPages and workflow clusters that run as a service, use the
command prompt window to run commands on each server.

Procedure
1. On the OpenPages administrative server, log on as an administrator.

2. Click Start > All Programs > Accessories, and right-click Command Prompt >
Run as Administrator.

3. From the command prompt, go to the WAS_HOME\bin directory, and run the
following command:

wasservice -remove OpenPagesDmgr

4. Run the following command:
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wasservice -remove <HOST_NAME>-OPNodel
5. Run the following command for each OpenPages server:
wasservice -remove <HOST_NAME>-OPNodelServer<SERVER#>
6. Run the following command:
wasservice -remove IBPMDmgr
7. Run the following command:
wasservice -remove <HOST_NAME>-IBPMNode<SERVER#>
8. Run the following command:
wasservice -remove <HOST NAME>-IBPMNode<SERVER#>Server
9. Repeat steps 6 and 7 on each workflow server.

Clustered OpenPages Configurations

Some configuration tasks are required for clustered OpenPages environments.

Increasing the Oracle connection limit

In clustered environments, you must increase the number of users who can
connect to the database instance.

Procedure
1. Log on to the database server as a user with administrative privileges.

2. To start the Oracle Enterprise Manager console, open a web browser and enter
https://server_name:1158/em

3. Log on to the Oracle Enterprise Manager console by using the following
syntax: sys/password@sysdba.

a. For the User Name, enter sys.

b. Enter the password for the sys user.

c. From the Connect As list, select SYSDBA.

On the Oracle Enterprise Manager home page, click the Server tab.
Under Database Configuration, click Initialization Parameters.
On the Initialization Parameters page, click the SPFile tab.

N o o s

Locate the Processes parameter.

If necessary, use the search function by entering Processes in the Name field
and then clicking Go.

8. Enter a value in the Processes field.

In a clustered environment, for best performance allocate sufficient processes
for each OpenPages application instance, each corresponding Fujitsu
Interstage BPM instance, and each corresponding CommandCenter instance.

For a two-node OpenPages environment, use the following settings:

OpenPages
Configure 75 processes for each OpenPages instance.

Workflow server
Configure 35 processes for each associated workflow server.

CommandCenter
Configure 80 processes for each CommandCenter instance.

Database processing usage
Configure 60 processes for database connection processing and
background processes.
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By default, this setting is 250 processes and 280 sessions for a
two-node OpenPages environment. If you have two or more
application servers, increase the number of processes.

9. Click Apply.
You are prompted to restart the server.
10. To restart the server, select Immediate.

Configuring OpenPages applications to use a domain account
on Windows operating systems

In a clustered environment, the OpenPages application services access a file share.
The account that starts the services must have permissions to the file share.

About this task

By default, on Windows operating systems, services run under the LocalSystem
account. This account cannot access a shared drive on another computer. In a
horizontal cluster, configure the OpenPages application services on all application
servers to run under a domain account that has access the shared drive.

The following OpenPages application services must have permissions to the file
share:

* OpenPagesAdminServer
* OpenPagesServer#
¢ IBPMAdminServer
* InterstageBPMCS#

Procedure

1. Log on to each application server as a user with administrative privileges.
2. Open the Services control panel.

3. Stop the OpenPages services.
4

. For each OpenPages application service, right-click the service name, and select
Properties from the menu.

a. In the Properties dialog box, click the Log On tab.
b. Select This account.

c. Type a domain, account name, and password for at least one user who has
access to the shared drive.

d. Click OK to continue.

Configuring file share permissions on AIX or Linux operating
systems

For clustered OpenPages environments that run on AIX or Linux operating
systems, configure the same user name and password on all systems. File share
permissions are the same on all systems. If you are using a network file share
(NFS), ensure that users have read and write access to the file share.

Sharing a network OpenPages storage directory on Windows
operating systems

The OpenPages application installation includes a pointer to the OpenPages
storage location. The storage location is a directory where attached files and forms
that are associated with OpenPages objects are stored.
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If you pointed to a location on the local computer, you must change the pointer to
a shared network storage location. You can use the update-storage script to
change the storage directory to a shared directory on the same or another server.

If you specified a shared network storage location, this task is not required.
Before you begin

For installations that use an Oracle database, ensure that the SQL Plus utility is
available on the managed application server.

Procedure
1. Log on to a managed application server as a user with administrative privileges
and full access to the local server drives.
2. Open a Command Prompt window.
3. Copy the OP_version_Configuration directory from the Installer DVD or on
your network share location to the local system.
4. Copy the INSTALL_SCRIPTS directory to the local system.
* For Oracle databases, go to the OP_version_Configuration\Database\ORACLE
directory.
» For DB2 databases, go to the OP_version_Configuration\Database\DB2
directory.
5. For Oracle databases, go to the ORACLE\INSTALL SCRIPTS directory and run the
update-storage script:

sqlplus /nolog @sql-wrapper.sql update-storage.sql log file name TNS alias_name
OpenPages_schema_owner_name OpenPages_schema_owner_password

storage_type storage_server_name computer_name

OpenPages_storage_platform sharename
The following table lists the command-line parameters that must be passed to
the SQL wrapper script.

Table 43. Update storage wrapper script parameters for Oracle database

Variable name Description

log_file_name The location of the log file that is created by the script.

If a location is not specified, the log file is created in
the current working directory.

If a log with the same name exists in the same location,
the log is overwritten by the script.

TNS_alias_name The database connection identifier, such as TNS alias
name.
OpenPages_schema_owner_name The name of the OpenPages user, created during the

OpenPages application installation.

By default, openpages.

OpenPages_schema_owner_password | The password of the OpenPages user.

storage_type Enter either LFS for local file system, or UNC for
Universal Naming Convention or Uniform Naming
Convention.

storage_server_name The name of the server where the OpenPages storage is
located.

computer_name The name of the cluster administrator computer.
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Table 43. Update storage wrapper script parameters for Oracle database (continued)

Variable name Description

OpenPages_storage_platform The operating system on the server where the

OpenPages storage is located.

Enter Windows.

sharename The name of the shared OpenPages storage directory or

the mount point.

By default, openpages-storage

6. For the DB2 databases, go to the DB2\INSTALL SCRIPTS directory and type the
following command in the DB2 command line processor (CLP)
clpplus -nw <op_db_user>
<op_db_password>@<database_host>:<database port>/<database name>
@sql-wrapper update-storage <log-file> <database_server_name>
<database_port> <database_name> <op_db_user> <op_db_password> <storage-type>
<storage-server-name> <host_name> <os_type> <path-or-UNC-name>

Example: In the following example, openpages-storage is the UNC share name
of the storage location. The openpages-storage location is accessible to all
members in the cluster as \\testdbserver\openpages-storage.

clpplus -nw openpages/password@testdbserver:50000/0PX
@sql-wrapper update-storage c:\temp\upd-storage-output.log

testdbserver 50000 OPX openpages password UNC testdbserver testdbserver
Windows openpages-storage

Table 44. Update storage wrapper script parameters for DB2 database

Variable name

Description

op_db_user

OpenPages user name for accessing the OpenPages database.

op_db_password

The OpenPages password for accessing the OpenPages database.

database_host

Name of the DB2 server host computer that contains the
OpenPages database.

database_port

Port number of the DB2 database instance that is installed on the
database server. ForDB2, the default port is 50000.

database_name

Name of the OpenPages database.

log-file

The name of the log file that the script creates and writes
information to.

storage-type

The type of file storage to be used. Valid values are as follows:
e LFS (local file system)
¢ UNC (Universal Naming Convention)

Important: After you move from LFS to UNC, you cannot go
back to using LFS.

stomge—server—name

The name of the storage server.

host-name

The host name of the computer.

os-type

The type of operating system:

Use one of the following options:
* Windows
e Unix

path-or-UNC-name

The file path or UNC of the storage location.
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Sharing a network OpenPages storage directory on AIX or
Linux operating systems

The OpenPages application installation includes a pointer to the OpenPages
storage location. The storage location is a directory where attached files and forms
that are associated with OpenPages objects are stored.

If you pointed to a location on the local computer, you must change the pointer to
a shared network storage location. You can use the update-storage script to
change the storage directory to a shared directory on the same or another server.

If you specified a shared network storage location, this task is not required.

Procedure

1. Mount the storage folder on the admin server to the non-admin server.

a.

® oo o

Log on to the OpenPages managed server as the root user or a user that
belongs to the System group, and open a shell.

Go to the /etc directory, and open the hosts file in a text editor.
Add the IP address and name of each OpenPages managed server.
Save and close the hosts file.

Create a file with the name exports in the /etc folder.

Important: Ensure that you have full rights to the local installation
directory.

Open the exports file in a text editor and add the full path to the storage
folder.

/opt/OpenPages/openpages-storage

Export all file systems that are named in /etc/exports directory by using
the following command:

exportfs -a

The exportfs command maintains the current table of exported file systems
for NFS in the /var/1ib/nfs/etc file.

Restart the NFS server by using the following commands:

stopsrc -g nfs
startsrc -g nfs

The NFS server processes requests from the NFS clients.

Use following command to check that the openpages-storage folder is
exported and ready for mounting:

showmount -e

Ensure that the openpages-storage folder is listed.

2. Mount the storage directory from the admin server on the managed server.

a.

Log on to the OpenPages managed server as the root user or a user that
belongs to the System group.

b. Open a shell as a user with administrative privileges.

c. Go to the /etc directory.

e.

f.

Open the hosts file in a text editor and add the IP address and name of
each OpenPages managed server.

Save and close the hosts file.
Run the following command to mount the storage folder:
mount nfsservername mountpoint
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* nfsservername is the name of the OpenPages admin server and the location
of the openpages-storage directory on the admin server.

* mountpoint is the name and path of the openpages-storage directory on

the managed server.

Example:

mount aix61-1-5.openpages.com:/usr/OpenPages/openpages-storage
/usr/OpenPages/openpages-storage

3. For Oracle databases, use the following command to change the storage
directory that is used by the OpenPages application to a shared directory on

the application server:

sqlplus /nolog @sql-wrapper.sql update-storage.sql log file name TNS alias_name
OpenPages_schema_owner_name OpenPages_schema_owner_password

Storage_type storage_server_name computer_name

OpenPages_storage_platform sharename

The following table lists the command-line parameters that must be passed to

the SQL wrapper script.

Table 45. Update storage wrapper script parameters for Oracle database

Variable name

Description

log_file_name

The location of the log file that is created by the script.

If a location is not specified, the log file is created in
the current working directory.

If a log with the same name exists in the same location,
the log is overwritten by the script.

TNS_alias_name

The database connection identifier, such as TNS alias
name.

OpenPages_schema_owner_name

The name of the OpenPages user, created during the
OpenPages application installation.

By default, openpages.

OpenPages_schema_owner_password

The password of the OpenPages user.

storage_type

Enter either LFS for local file system, or UNC for
Universal Naming Convention or Uniform Naming
Convention.

S torage_server_name

The name of the server where the OpenPages storage is
located.

computer_name

The name of the cluster administrator computer.

OpenPages_storage_platform

The operating system on the server where the
OpenPages storage is located.

Enter Unix.

sharename

The name of the shared OpenPages storage directory or
the mount point.

The default mount point is openpages-storage

4. For DB2 databases, type the following command to change the storage
directory that is used by the OpenPages application to a shared directory on

the application server:
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clpplus -nw <op_db_user>
<op_db_password>@<database_host>:<database_port>;/<database_name>
@sql-wrapper update-storage <log-file> <storage-type>
<storage-server-name> <host-name> <os-type> <path-or-UNC-name>

Example:

clpplus -nw openpages/apassword@testdbserver:50000/o0px
@sql-wrapper update-storage /home/op/upd-storage-output.log
UNC aix1l aix1l Unix /usr/opdata/openpages-storage

Table 46. Update storage wrapper script parameters for DB2 database

Variable name

Description

op_db_user

OpenPages user name for accessing the OpenPages database.

op_db_password

The OpenPages password for accessing the OpenPages database.

database_host

Name of the DB2 server host computer that contains the
OpenPages database.

database_port

Port number of the DB2 database instance that is installed on the

database server. For DB2, the default port is 50000.

database_name

Name of the OpenPages database.

log-file

The name of the log file that the script creates and writes
information to.

storage-type

The type of file storage to be used. Valid values are as follows:

¢ LFS (local file system)
* UNC (Universal Naming Convention)

Important: After you move from LFS to UNC, you cannot go
back to using LFS.

S tOTIZgE-SETUET-Tl{ZmE

The name of the storage server.

host-name

The host name of the computer.

os-type

The type of operating system:

Use one of the following options:
* Windows

* Unix

path-or-UNC-name

The file path or UNC of the storage location.

Configuring IBM HTTP Server for load balancing

In a typical configuration that uses IBM HTTP Server for load balancing, IBM
HTTP Server is installed on a separate computer.

Web server plug-ins enable IBM HTTP Server to communicate requests for
dynamic content, such as servlets, to the application server. A configuration file is
generated for each plug-in.

Before you begin

If you are configuring the OpenPages environment for SSL, configure SSL before
you configure the plugin-cfg.xml file. For more information, see the IBM
OpenPages GRC Platform Administrator’s Guide.
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Procedure

1. Log on to the load-balancing server as a user with administrative privileges.

2. Copy the OP_version_Configuration directory from the Installer DVD or on
your network share location to the local system.

3. Create the web server instances for the OpenPages application and for the
workflow server.

a.

®oo0o
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Log on to the application server as a non-root user who has administrative
privileges.

In a web browser, type http://admin_server_name:9060/ibm/console

Click Servers > Server Types > Web Servers.

On the Web Servers page, click New.

On the Select a node for the Web server page, select the application server
from the Select node list.

Enter opapp in the Server name field.
From the Type list, select IBM HTTP Server and click Next.
On the Confirm new Web server page, review the settings and click Finish.

In the messages box, click Save to commit the changes to the master
configuration file.

In a web browser, type http://admin_server_name:9061/ibm/console, and
repeat step 3 to create a web server instance that uses ibpmapp for the server
name.

4. To create the plug-in for the OpenPages server instance, open a web browser
and type http://admin_server_name:9060/ibm/console.

a.
b.

Click Servers > Server Types > Web Servers.

Select the OpenPages server instance that you created and then click
Generate Plugin.

The plug-in is created and saved to the $IHS_HOME/Plugins/config/
webserver_name/ directory.

The webserver_name is the OpenPages server instance that you created.

To create the plug-in for the workflow server, In a web browser, type
http://WAS_server_name:9061/ibm/console

d. Click Servers > Server Types > Web Servers.

e. Select the workflow server instance that you created and click Generate

f.

Plugin.
Copy both plug-in files to the load-balancing server.

5. On the load balancing server, create a text file for the merged file.

a.
b.

Open the plugin-cfg.xml files for the OpenPages and workflow servers.

Copy the <Config> root element from one of the plugin-cfg.xml file and
paste into the new file.

Note: Ensure that there is only one <Config> element in merged file.
Copy the <Log> element from one of the two files, and if required, modify
the name, and paste into the new file.

Copy all the <VirtualHostGroup> elements from both files and paste into the
new file.

The <VirtualHostGroup> name must be unique. There must be only one
<VirtualHostGroup>.

Copy all <ServerCluster> elements from both the files and paste into the
new file and ensure that the names are unique.
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Ensure that the Server Name is unique across all clusters.

In the <Transport> element, ensure that the keyring and stashfile
properties use the same location for all the application servers in the merged
file.

Copy all the <URIGroup> elements from both files and paste into the new
file, and ensure that the names are unique.

Ensure that the names are unique.
Copy all the <Route> elements from both files and paste into the new file.

Apply any changes that you made to the names of VirtualHostGroup,
ServerCluster or URIGroup.

Save the new file.

Open the httpd.conf file and add or modify the following line to point to the
new merged plug-in file.

WebSpherePluginConfig
/usr/IBM/HTTPServer/Plugins/config/0P/merged file.xml

Ensure that the IgnoreAffinityRequests setting in the <ServerCluster> section
is set to false:

8. Save and close the file.

Configuring property files for load balancing on AIX operating

systems

Some configuration is required when using IBM HTTP Server as a load balancer in
a WebSphere Application Server environment.

Procedure

1. On the load-balancing web server, go to the /usr/IBM/HTTPServer/modules/
directory.

2. Open merged plug-in file (pTugin-cfg-merged.xml) in a text editor to make the
following changes:

a. Change the IgnoreAffinityRequests setting to true.

b. Change the ServerI0Timeout setting for all servers to a value that allows
sufficient time for the OpenPages application to respond to request from a
client.

c. For users to access the IBPM console and OpenPages simultaneously, in
each of the following Uri groups, change the cookie name.

For OpenPages change the cookie name to opsosa. For IBPM, change the
name to opibpm.
<UriGroup Name="default_host OpenPagesCluster URIs'">
<Uri AffinityCookie="opsosa" AffinityURLIdentifier="opsosa" Name="/opws/*"/>
<UriGroup Name="default_host_IBPMCluster_URIs">
<Uri AffinityCookie="opibpm" AffinityURLIdentifier="opibpm"
Name="/ibpmconsole/PortletWrapper/*"/>
d. Save and close the file.
3. Open the httpd.conf file in a text editor and make the following changes:

The default location of the file is /usr/IBM/HTTPServer/conf/httpd.conf.

a.

To load the required modules, add or uncomment the following lines

LoadModule negotiation_module modules/mod_negotiation.so
LoadModule proxy module modules/mod_proxy.so

LoadModule proxy_ajp_module modules/mod_proxy ajp.so
LoadModule proxy_balancer_module modules/mod_proxy balancer.so
LoadModule proxy_connect_module modules/mod_proxy_connect.so
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LoadModule proxy_http_module modules/mod_proxy http.so
LoadModule status_module modules/mod_status.so
LoadModule was_ap22_module modules/mod_was_ap22_http.so
b. Modify the ServerName setting to point to the host name where you
installed the IBM HTTP Web Server.

ServerName=MYSERVERNAME .DOMAIN.COM

c. Modify the ServerRoot setting to point to the installation location of the
Apache Web Server. For example,
ServerRoot=/usr/IBM/HTTPServer/htdocs

d. Add the AlTow from all attribute to each Directory element.

<Directory>

Options Indexes FollowSymLinks
AllowOverride None

Order allow,deny

Allow from all

</Directory>

e. Uncomment the parameter ExtendedStatus setting and set the value to On.
f. Set the location tags for server-status and server-info.
For example,

<Location /server-status>
SetHandler server-status
Order Deny,Allow

Deny from all

Allow from all
</Location>

<Location /server-info>
SetHandler server-info
Order Deny,Allow

Deny from all

AlTow from all
</Location>

4. Save and close the file.

Configuring property files for each OpenPages instance

You must edit the server properties file on each OpenPages cluster member to
point to the load balancer.

Procedure

1. Log on to the OpenPages cluster member as a non-root user who has
administrative privileges.

2. Go to the OP_Home/aurora/conf directory.
3. Open the aurora.properties file in a text editor.

a. Edit the application.url.path to point to the fully qualified domain name
of the load balancer.

application.url.path=http\://op-load-balancer.domain.com\:port
/openpages

b. Save and close the file.

4. Open each server_name-OpenPagesServer#-server.properties file in a text
editor.

a. Edit the url.path lines to point to the fully qualified domain name of the
load balancer.

url.path.workflow.admin=http\://op-load-balancer.domain.com\:
port/ibpmconsole
url.path.openpages=http\://op-load-balancer.domain.com\:port/openpages
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b.

Save and close each server.properties file.

Open each server_name-OpenPagesServer#-sosa.properties file in a text editor.

a.

b.

Edit the Application.url.path lines to point to the fully qualified domain
name of the load balancer.

application.url.path=https\://op-load-balancer.domain.com\:port
/openpages

Save and close each server.properties file.

Open each server_name-InterstageBPMCS#-server.properties file in a text
editor.

a.

b.

Edit the url.path lines to point to the fully qualified domain name of the
load balancer.

url.path.workflow.admin=http\://op-load-balancer.domain.com\:
port/ibpmconsole
url.path.openpages=http\://op-load-balancer.domain.com\:port/openpages

Save and close each server.properties file.

7. Restart the web server.

Customizing the load balancer for large data sets

For databases with a large data set, some OpenPages reports might timeout before
completion. If you experience problems with reports that are timing out, change
configuration settings in the IBM HTTP Web Server configuration file.

Change the following settings:

TimeOut

The number of seconds IBM HTTP Web Server waits to receive a GET
request, between receipt of TCP packets on a POST or PUT request and
between ACKs on transmissions of TCP packets in responses.

KeepAliveTimeout

The number of seconds IBM HTTP Server waits for a subsequent request
before closing the connection.

Note: A high value for the setting can cause performance problems,
especially if the higher timeout causes server processes to wait for idle
clients.

Procedure

1.
2.
3.

Log on to load balancing web server as a user with administrative privileges.

Open httpd.conf in a text editor.

Change the KeepAliveTimeout property to a higher value.
KeepAliveTimeout 1800
Add and then set the TimeQut property.

Ensure that the setting prevents timeout errors.

For example, TimeOut 1800

Save and close the file.
Restart IBM HTTP Web Server.
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Load balancing the OpenPages reporting server

CommandCenter uses IBM Cognos Business Intelligence, which can scale
horizontally. To scale CommandCenter vertically within the same environment,
increase the number of processes that are available to handle request. Depending
on the load, you can configure additional dispatchers.

To scale CommandCenter horizontally, install additional environments and register
the Cognos dispatchers. Incoming requests are distributed across the multiple
environments.

The number of dispatchers you need depends on the operating system, system
resources, the number of users, and other factors.

For more information about configuring dispatchers for your environment, see the
IBM Cognos documentation library].

Adding OpenPages servers to Cognos Application Firewall
safe list

By default, Cognos Application Firewall (CAF) is enabled. IBM Cognos Application
Firewall validates domain and host names to protect URLs that are created. IBM
Cognos Application Firewall considers domain names derived from the
environment configuration properties as safe domain names. Use the IBM Cognos
Configuration to add OpenPages application servers to the list of valid domains
and host names.

Procedure
1. Log on to the reporting server as a user with administrative privileges.
2. Start IBM Cognos Configuration.

3. In the Explorer pane, go to Local Configuration > Security > IBM Cognos
Application Firewall.

4. In the Properties pane, click the Valid domain names or hosts field and click
the pencil icon.

In the Valid domain or hosts dialog box, click Add.
Enter the names of all OpenPages application servers.
Click OK.

Save the configuration and restart the Cognos service.

© N O

If you use Windows Services to restart the Cognos service, the service is listed
as CommandCenter.

Communication Between CommandCenter Servers

If you install CommandCenter on more than one computer, you must configure the
distributed installations to communicate with each other

Configure the following communication paths:
* Configure the primary CommandCenter server as the default active server.

e All CommandCenter servers must know the location of the content store
database.

¢ All CommandCenter servers must know the location of the other
CommandCenter servers.

* All CommandCenter servers must use the same cryptographic settings.
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* All CommandCenter servers must have their system clock synchronized.

Configuring the primary CommandCenter server

In a clustered environment, one CommandCenter server acts as the primary server,
or default active server, and one or more CommandCenter servers act as secondary
servers.

Procedure

1.
2.

10.
11.

Ensure that CommandCenter is not running on any server.

On the reporting server that is designated as the primary server, start IBM
Cognos Configuration that you want to designate as the primary
CommandCenter server.

Tip: Use the computer with the highest processor speed for the default active
server.

In the Explorer pane, click Environment.

For the Gateway URI, change the localhost portion of the URL to the name
of the primary.

For the Dispatcher URI for Gateway, click Dispatcher URI for Gateway click
the pencil icon next to the Value box.

In the Current Values list, change the Tocalhost portion of the URL to the
name of the primary CommandCenter computer.

a. For each additional CommandCenter computer, click Add.

b. Change the Tocalhost portion of the URL to the name of each additional
CommandCenter computer.

c. Click OK.
For the Content Manager URIs, click the pencil icon next to the Value box.

a. In the Current Values list, change the Tocalhost portion of the URL to the
name of the primary CommandCenter computer.

b. For each additional CommandCenter computer, click Add.

c. Change the Tocalhost portion of the URL to the name of each additional
CommandCenter computer.

d. Click OK.
In the Explorer pane, click Security > Cryptography.

In the Properties pane, under CSK settings, ensure that Store symmetric key
locally? is set to True. The keystore must be created on the default active
CommandCenter computer

Click File > Save.
Click Actions > Start.

When the services start, this computer becomes the default active
CommandCenter computer.

Configuring secondary CommandCenter servers

In a clustered environment, configure one or more CommandCenter servers to act
as secondary servers.

Procedure

1.

Ensure that CommandCenter is running on the primary CommandCenter
server.
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2. On the reporting server that is designated as secondary server, start IBM
Cognos Configuration CommandCenter server.

3. In the Explorer pane, click Environment.
4. In the Environment - Group Properties pane, click Gateway URL

5. In the Value field, change the Tocalhost portion of the URL to the name of
the primary CommandCenter computer.

6. In the Environment - Group Properties pane, click Dispatcher URI for
Gateway.

a. Click the pencil icon next to the Value box.

b. In the Current Values list, change the Tocalhost portion of the URL to the
name of the primary CommandCenter computer.

c. For each additional CommandCenter computer, click Add.

d. Change the Tocalhost portion of the URL to the name of each additional
CommandCenter computer.

e. Click OK.
7. In the Environment - Group Properties pane, click Content Manager URIs.
a. Click the pencil icon next to the Value box.

b. In the Current Values list, change the Tocalhost portion of the URL to the
name of the primary CommandCenter computer.

c. For each additional CommandCenter computer, click Add.

d. Change the localhost portion of the URL to the name of each additional
CommandCenter computer.

e. Click OK.
8. In the Explorer pane, under Security, click Cryptography.

9. In the Properties pane, under CSK settings, set Store symmetric key locally?
to False.

Note: The keystore is created on the primary CommandCenter computer.
There can be only one keystore in a load balanced CommandCenter
installation.

10. In the Explorer window, under Security, Cryptography, click Cognos.

11. Under the Certificate Authority settings property group, set the Password
property to match the one that you configured on the primary
CommandCenter server.

a. Ensure that all other cryptographic settings match the settings that you
configured on the primary CommandCenter computer.

12. In the Explorer pane, under Data Access > Content Manager, click Content
Store.

13. Ensure that the values for the content store match the primary
CommandCenter computer

14. Click File > Save.
15. Click Actions > Start.

Configuring an Apache load balancer or proxy server

If you are using an external proxy server for load balancing, you must add a proxy
redirection directive to the httpd.conf file on the proxy server. Requests sent to the
proxy server are redirected to the server specified in the httpd.conf file.
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Procedure

1.
2.

4.

Log on to the load balancer server as a user who has administrative privileges.
Go to the Apache_Home\conf\ directory, and open the httpd.conf file in an
editor.

Add the following lines:

<Location /ibmcognos/>

ProxyPass http://primary_reporting server/ibmcognos/
SetEnv force-proxy-request-1.0 1 SetEnv proxy-nokeepalive 1
</Location>

Note: You must include the trailing forward slash in the ProxyPass directive
when specifying the Cognos virtual directory (/ibmcognos/).

Save and close the file.

Changing the CommandCenter host settings

You must update configuration files to use the CommandCenter server name and
port settings.

Procedure

1.

Log on to the OpenPages application server as a user with administrative
privileges.

Open a browser window and go to the OpenPages application by typing the
following URL:

http://0P_server name:port/openpages

Log on to the OpenPages application as a user with administrative privileges.
Under Administration, select Settings.

a. Expand the OpenPages > Platform > Reporting Schema > Object URL
Generator.

b. Click Host.
C. In the Value field, update the setting to point to the OpenPages server.

Note: If you use the CommandCenter in a load-balanced environment,
you must type the fully qualified domain name of the load balancing
server. If required, change the port.

Stop OpenPages services.
On the application server, go to the OP_Home\aurora\conf directory.

In the cognos.framework.refresh.servlet=http\://Tocalhost\:8080/crf-
refresher property, replace Tocalhost\:8080 with the reporting server name
and port.

cognos. framework.refresh.servlet=http\://ccserver\:8080/crf-refresher

In the cognos.server=http\://localhost:80/cognos8/cgi-bin/cognos.cgi
property, replace Tocalhost:80 with the reporting server name and port
number.

cognos.server=http\://ccserver:80/cognos8/cgi-bin/cognos.cgi
Add the following value to the Togout.url.cognos= property:

http\://CommandCenter_server_name\CommandCenter port\/cognos/cgi-bincognos.cgi?
b_action\=xts.run&m\=portal/lTogoff.xts&h_CAM action\=logoff

Example:
Togout.url.cognos=http\://ccserver\:8080/cognos/cgi-bincognos.cgi?

b_action\=xts.run&m\=portal/Togoff.xts&h_CAM action\=Togoff
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10. Save your changes and exit the editor.
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Chapter 13. Single signon integration for OpenPages
application server and the reporting server

IBM OpenPages GRC Platform can integrate into a number of single sign-on
solutions, such as CA SiteMinder. You can also configure the reporting server for
single signon.

Configuring OpenPages applications for single signon

Integrate single signon for IBM OpenPages GRC Platform applications by
configuring the settings in the OpenPages application interface.

Procedure

1. Start the OpenPages services.

2. Log on to the OpenPages application interface as a user with administrative
privileges.

3. Under Administration, select Settings.

4. Set the value of the Show Hidden Settings setting to true
a. Expand the OpenPages > Applications > Common > Configuration.
b. Click Show Hidden Settings to open its detail page.
c. In the Value field on the setting detail page, change the value to true
d. Click Save.

5. Set the value of the Session Attribute and Username Attribute settings:

a. Expand the OpenPages > Platform > Security > Single Sign On >
Implementations > Header-based.

b. Click Class Name to open its detail page.

c. In the Value field, enter
com.openpages.singlesignon.HTTPHeaderBasedModule.

d. Click Session Attribute to open the detail page.

e. In the Value field, modify the value to match the session attribute for your
single signon system.

The following examples show values for the Session Attribute parameter.

+ Using SiteMinder 6.0, the value of the Session Attribute parameter is
SMSERVERSESSIONID

« Using Tivoli® Access Manager 6.1, the value of the Session Attribute
parameter is iv_creds

f. Click Save.
g. Click Username Attribute to open its detail page.

h. In the Value field on the setting detail page, modify the value to match the
user name attribute for your single sign-on system.

The following examples show values for the Username Attribute parameter.
* Using SiteMinder 6.0, the value of the Username Attribute is SMUSER

* Using Tivoli Access Manager 6.1, the value of the Username Attribute is
iv_user

i. Click Save.
6. Enable single sign-on:
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7.

a. OpenPages > Platform > Security > Single Sign On > Implementations >
Header-based

b. Click OP to open its detail page.

C. In the Value field on the setting detail page, set the value to true.
d. Click Save.

e. Click SOX to open its detail page.

f. In the Value field on the setting detail page, set the value to true.
g. Click Save.

Reset the value in the Show Hidden Settings setting to false.

Configuring the single signon logout destination

To securely log out from an OpenPages application session where single signon is
enabled, configure the system to redirect the user.

Logging out of the OpenPages application does not automatically log the user out
of a single signon system. If you use Back in the web browser to reenter the
OpenPages application, your session is re-created. The session uses the existing,
valid third-party credentials.

Procedure

1.

oo~ 0D

Log on to the OpenPages application interface as a user with administrative
privileges.

Under Administration, select Settings.

Expand the OpenPages > Platform > Security.

Click Logout URL to open its detail page.

In the Value box, type a fully qualified URL.

Click Save.

Disabling OpenPages single signon

You must disable single signon registry settings before you upgrade OpenPages
GRC Platform. After the upgrade, you can re-enable the settings.

Procedure

1.

Al A

Start the OpenPages services.

Open a web browser and go to the current OpenPages application.
Log on as a user with administrative permissions.

From the Administration menu, select Settings.

In all versions, disable single sign-on as follows:

a. Expand the OpenPages > Platform > Security > Single Sign On.
b. Click OP to open its detail page.

C. In the Value field on the setting detail page, set the value to false.
d. Click Save.

e. Click SOX to open its detail page.

f. In the Value field on the setting detail page, set the value to false.
g. Click Save.
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Configuring single signon for a reporting server

If you are using a single sign-on system such as CA SiteMinder with the
OpenPages application, you must load an updated redirect JavaServer Pages (JSP).

Load the JavaServer Pages through the ObjectManager tool by using the
CommandCenter-integration-op-config.xml file. The file is located on the
OpenPages installation DVD.

Procedure
1. Log on to a computer that has SQL*Plus and access to the database server.

Note: For AIX installations, log on as the opuser or a non-root user who has
administrative privileges.

2. From the Installer DVD or on your network share location, copy the
OP_version_Configuration\loader-data\commandcenter directory to the local
system.

3. Go to the 0P_Home/bin directory.
4. Run the following command:

ObjectManager load config OpenPagesAdministrator password
path-to-loader-file CommandCenter-integration
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Chapter 14. IBM OpenPages GRC Platform uninstallations

Use the uninstallation program and available scripts to remove the IBM OpenPages
GRC Platform software.

Uninstalling OpenPages GRC Platform on Windows computers

To uninstall IBM OpenPages GRC Platform on Windows computers, stop the
services, remove the application from the WebSphere Application Server, and then
delete the profile.

To uninstall the workflow server, use the uninstallation program for Fujitsu
Interstage BPM. To remove databases, use the DROP command.

Uninstalling might not remove all installation files and the installation location
remains on your computer. You retain these files until you delete them.

Procedure
1. Log on to the OpenPages application server as user with administrative
privileges.
2. Open a Command Prompt window, and go to the 0P_HOME\bin directory.
3. To run a script that stops the OpenPages and workflow (Fujitsu Interstage
BPM) services, type the following command:
StopAliServers.cmd
4. Uninstall CommandCenter.
a. Log on to the reporting server as a user with administrative privileges.
b. Stop the Cognos service.
Use the IBM Cognos Configuration interface to stop the service, or run the
following command:
Cognos_HOME\bin64\cogconfigw.exe -stop -utf8 -Tog
c. To remove the Tomcat service, go the CC_HOME\apache-tomcat\bin directory
and run the following command:
net stop Tomcat6
Note: You can also use the Services in the administrative tools (Microsoft
Management Console) to stop the OpenPages Framework Generator service.
d. Restore the original Cognos files
* Copy cogstartup.xml file from CC_HOME\crn_backup to
COGNOS_HOME\configuration directory.
* Copy fm.ini file from CC_HOME\crn_backup to COGNOS_HOME\configuration
directory.
* Copy system.xml file from CC_HOME\crn_backup to COGNOS_HOME\
templates\ps\portal directory.
e. Delete the COGNOS _HOME\configuration\
OpenPagesSecurityProvider OpenPagesSecurityRealm.properties file.
f. Delete the following files from COGNOS_HOME\webapps\p2pd\WEB-INF\1ib

directory:
* aurora-tools.jar
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e op-cc-backup-security.jar
* OpenPagesSecurityProvider.jar
* opwebservices client.jar

5. Remove the WebSphere Application Server profile for the OpenPages and
workflow applications:

a. To list all the profiles on the server, go the WAS_HOME\bin directory and type
the following command:

manageprofiles.bat —1istProfiles

A list of the profiles is displayed. For example, on an admin server where
you deployed two servers, the following message is displayed:

[OpenPagesDmgr, op-0PNodel, IBPMDmgr, op-IBPMNodel, op-IBPMNode?2]
b. Run the one of the following commands to delete the profile.

* If other profiles exist that you do not want to delete, remove each profile
individually by running the following command:

manageprofiles.bat —delete —profileName profile

* If only OpenPages and workflow profiles exist, remove all profiles by
running the following command:
manageprofiles.bat —deleteAll
6. To remove the workflow server, run the uninstallation program for the Fujitsu
Interstage Business Process Manager.
Click Start > All Programs > Interstage Business Process Manager >
Uninstall, right-click Uninstall, and click Run as Administrator.
7. Remove the OpenPages GRC Platform, CommandCenter, and Fujitsu
installation directories.
8. Restart the computer.
Related tasks:
“Uninstalling OpenPages with an Oracle database before you reinstall” on page
165
In test or development environments, you might be required to uninstall

OpenPages GRC Platform or remove the OpenPages database in Oracle database
server before you reinstall. You must completely uninstall before you reinstall.

Uninstalling OpenPages GRC Platform on Linux or AIX computers

To uninstall IBM OpenPages GRC Platform on Linux or AIX computers, stop the
services, remove the application from the WebSphere Application Server, and then
delete the profile.

To uninstall the workflow server, use the uninstallation program for Fujitsu
Interstage BPM.

Uninstalling might not remove all installation files and the installation location
remains on your computer. You retain these files until you delete them.

Procedure
1. Log on to the OpenPages application server as user with administrative
privileges.

2. Go to the OP_HOME/bin directory.

3. Type the following command to run the script that stops the OpenPages and
workflow (Fujitsu Interstage BPM) services:
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./stopAl1Servers.sh

4. Uninstall CommandCenter.
a. Log on to the reporting server as a user with administrative privileges.
b. Stop the Cognos service.

Use the IBM Cognos Configuration interface to stop the service, or run the
following command:

Cognos_HOME/bin64/cogconfig.sh -stop -utf8 -log

c. To stop the OpenPages Framework Generator, type the following command:
CC_HOME/apache-tomcat/bin/catalina.sh stop

d. Restore the original Cognos files

* Copy cogstartup.xml file from CC_HOME/crn_backup to
COGNOS_HOME/configuration directory.

* Copy fm.ini file from CC_HOME/crn_backup to COGNOS_HOME/configuration
directory.

» Copy system.xml file from CC_HOME/crn_backup to COGNOS_HOME/
templates/ps/portal directory.

e. Delete the COGNOS_HOME/configuration/
OpenPagesSecurityProvider OpenPagesSecurityRealm.properties file.

f. Delete the following files from COGNOS_HOME/webapps/p2pd/WEB-INF/1ib
directory:

* aurora-tools.jar

e op-cc-backup-security.jar

* OpenPagesSecurityProvider.jar
* opwebservices_client.jar

5. Remove the WebSphere Application Server profile for the OpenPages and
workflow applications:

a. To list all the profiles on the server, go the WAS_HOME/bin directory and type
the following command:

./manageprofiles.sh —listProfiles

A list of the profiles is displayed. For example, on an admin server where
you deployed two servers, the following message is displayed:

[OpenPagesDmgr, op-0PNodel, IBPMDmgr, op-IBPMNodel, op-IBPMNode2]
b. Run one of the following commands to delete the profile.

* If other profiles exist that you do not want to delete, remove each profile
individually by running the following command:

./manageprofiles.sh —delete —profileName profile

* If only OpenPages and workflow profiles exist, remove all profiles by
running the following command:

./manageprofiles.sh —deleteAll

6. To remove the workflow server, go Workflow_Home/_uninst/ directory and type
./uninstall.sh

7. Restart the computer.

8. Remove the OpenPages GRC Platform, CommandCenter, and Fujitsu
installation directories.
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Related tasks:

“Uninstalling OpenPages with an Oracle database before you reinstall” on page|
165

In test or development environments, you might be required to uninstall
OpenPages GRC Platform or remove the OpenPages database in Oracle database
server before you reinstall. You must completely uninstall before you reinstall.
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Appendix A. Silent installations

Silent mode installations are useful when you install identical configurations across
several computers or when you install the same configuration frequently.

Use the property settings from another installation as input to run the silent
installation. Installation actions and results are recorded in a log files.

To silently install components
1. Create the response file to specify the installation settings.

To minimize errors, use the IBM OpenPages GRC Platform Administrative
Console interface to specify the installation properties.

Before you export the properties, validate them in the user interface.

Tip: Help for the properties in the response file is available in the OpenPages
Administrative Console interface. For each property setting, the corresponding
property ID is listed.

2. Run the corresponding silent mode command script by using the response file
as input.

3. Check the logs directory to ensure that the installation is successful.
Related concepts:

[“Log files” on page 157
Use the log files to help troubleshoot problems that occur during the installation.

Editing properties files to use as response files for silent installations

Use the IBM OpenPages GRC Platform Administrative Console interface to set or
change the properties for your selected deployment option.

Export or copy the properties to a properties file. The silent installation command
script uses the information in the properties file to deploy similar configuration
settings to another computer.

Before you begin
Ensure that the prerequisite software is installed and running.

To deploy OpenPages GRC Platform to WebSphere Application Server, ensure that
the prerequisite software is available:

* The OpenPages repository is created.

* IBM Cognos Business Intelligence is installed and running.
* The database client software is installed.

* WebSphere Application Server is installed.

For CommandCenter installations, ensure that the following conditions are met
* OpenPages application server is installed and running.

* IBM Cognos Business Intelligence is installed and the Cognos services are
running.

* IBM Cognos Configuration is closed
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e Database client software is installed.
* JAVA_HOME and the content store database environment variables are set.

Procedure
1. Log on as a user with administrator privileges.

2. Go to the directory where you extracted the IBM OpenPages GRC Platform
Administrative Console files, and run the opadminconsole file.

* On Windows computers, right-click opadminconsole.exe and click Run as
administrator.

* On Linux computers, type ./opadminconsole.

Note: You cannot run the OpenPages Administrative Console on AIX
computers. To install on an AIX computer, you must run the OpenPages
Administrative Console on a remote.

3. On the Properties panel, select the deployment option and modify the property
values to suit your environment.

4. Optional: If you plan to run the silent installation on the current computer, you
can verify the settings that you entered by clicking Validate Properties.

If there are errors, change the settings that require attention before proceeding.
5. After you validate the settings, click File > Export Properties File.

Alternatively, you can click Copy Properties to save the settings to the
clipboard. Then, you can paste the properties into the default response file in
the path\opadminconsole\silent_install directory.

The following table lists the response files for each OpenPages component by
operating system and database.

Table 47. Response file names for silent installations

Target

OpenPages operating
Response file component system Database
was_win_ora_deploy_server.xml OpenPages Windows Oracle

application server
win_ora_command center_deploy.xml CommandCenter | Windows Oracle
was_win_db2_deploy_server.xml OpenPages Windows DB2

application server
win_db2_command_center_deploy.xml CommandCenter | Windows DB2
was_linux_ora_deploy_server.xml OpenPages Linux Oracle

application server
Tinux_ora_command_center_deploy.xml CommandCenter |Linux Oracle
was_linux_db2_deploy_server.xml OpenPages Linux DB2

application server
Tinux_db2_command_center_depToy.xml CommandCenter |Linux DB2
was_aix_db2_deploy_server.xml OpenPages AIX DB2

application server
aix_db2_command_center_deploy.xml CommandCenter | AIX DB2

6. In the Export Install Properties dialog box, save the file.

7. Open the file that you exported in an editor and change settings, such as host
names.
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Ensure that the response file contains properties that are suitable for a similar
deployment on a different computer.

On the target computer where you plan to install, go to the
path\opadminconsole\silent_install directory and back up the default
response files.

Save the new response file to the path\opadminconsole\silent_install on the
target computer.

Results

The response file for your selected deployment option is ready for your silent
mode installation.

Related tasks:

[“Reusing property settings for similar deployments” on page 15§

Use a saved or exported property file as a template for similar installations. You
can import the saved property file to the current installation, or use the exported
file as response file for a silent installation.

Running the OpenPages Administrative Console in silent mode

The silent mode installation command uses a response file to set properties and
generate log files that record installation steps and results.

Before you begin

Ensure that the following tasks are completed:

The database instance for the OpenPages repository is created.
IBM Cognos Business Intelligence is installed and running.

The database client software is installed.

WebSphere Application Server is installed.

The deployment response file is updated to suit your environment.

About this task

Run the OpenPages Administrative Console in silent mode when you do not want
to specify configuration information about your environment interactively. The
deployment response file contains all environment-specific information that is
required to complete the installation in silent mode. Use the command-line prompt
to run the installation script and use the response file for input.

Procedure

1. On the computer where you plan to install silently, log on as a user with
administrative privileges.

2. Go to the path\opadminconsole\silent_install directory.

3. Ensure that the response file that you want to use for the silent installation
contains the settings that you need for the new installation.

4. Run the silent installation script (.cmd or .sh) file.

The following table lists the command script files for each OpenPages
component by operating system and database.
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Table 48. Script file names for silent installations

Target

OpenPages operating
Script file component system Database
was_win_ora_deploy_server.cmd OpenPages Windows | Oracle

application server
win_ora_command_center_deploy.cmd CommandCenter Windows | Oracle
was_win_db2_deploy_server.cmd OpenPages Windows | DB2

application server
win_db2_command_center_deploy.cmd CommandCenter Windows | DB2
was_Tinux_ora_deploy_server.sh OpenPages Linux Oracle

application server
Tinux_ora_command_center_deploy.sh CommandCenter Linux Oracle
was_Tinux_db2_deploy_server.sh OpenPages Linux DB2

application server
Tinux_db2_command_center_deploy.sh CommandCenter Linux DB2
was_aix_db2_deploy_server.xml OpenPages AIX DB2

application server
aix_db2_command_center_deploy.sh CommandCenter AIX DB2

Note: If you created your own batch file for silent installations, run it.
5. To determine whether the installation is successful, review the log files.

By default, the log file can be found in the path\opadminconsole\
silent_install directory.

The log directory name corresponds to the script name. For example, if you run
the was_win_ora_deploy_server script, the log directory is
was_win_ora_deploy server Tog.

Creating customized scripts for silent installations

If you plan to run the same silent mode installation frequently or in many different
environments, you can create script files.

The silent mode installation script uses a response file that contains information
about your environment. Create a response file before you create a silent mode
installation batch file. To minimize errors, use the OpenPages Administrative
Console interface to specify and validate the installation properties, and then
export the properties to the response file.

About this task

The silent mode installation script requires three parameter values:

e The SI_ACTION parameter is the deployment type, including the installation
component, target operating system, and database type.

¢ The SI_INPUT parameter is the response file name.
e The SI_OUTPUT parameter is the directory path of the generated log directory.

Procedure

1. Log on to the target computer where you extracted the OpenPages
Administrative Console installation files.
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2. Go to the path\opadminconsole\silent_install directory.

3. Edit the script file that corresponds to the silent installation.

The following table lists the command script files for each OpenPages
component by operating system and database.

Table 49. Script file names for silent installations

Target

OpenPages operating
Script file component system Database
was_win_ora_deploy_server.cmd OpenPages Windows | Oracle

application server
win_ora_command_center_deploy.cmd CommandCenter Windows | Oracle
was_win_db2_deploy_server.cmd OpenPages Windows | DB2

application server
win_db2_command_center_deploy.cmd CommandCenter Windows | DB2
was_linux_ora_deploy_server.sh OpenPages Linux Oracle

application server
Tinux_ora_command_center_deploy.sh CommandCenter Linux Oracle
was_Tlinux_db2_deploy_server.sh OpenPages Linux DB2

application server
Tinux_db2_command_center_deploy.sh CommandCenter Linux DB2
was_aix_db2_deploy server.xml OpenPages AIX DB2

application server
aix_db2_command_center_deploy.sh CommandCenter AIX DB2

4. Edit the SI_INPUT parameter to use the response file that you created.

set SI_INPUT=input_was_win_ora_server _deploy.xml

5. Edit the SI_OUTPUT parameter to specify the log directory name.

set SI_OUTPUT=output_was_win_ora_server_deploy

6. Review the contents of the script file.

set SI_ACTION=was_win_ora_deploy server
set SI_INPUT=input_was_win_ora_server_deploy.xml
set SI_OUTPUT=output_was_win_ora_server_deploy

call silent_install.cnd %SI_ACTIONS %SI_INPUT% %SI_OUTPUT%

7. Save the file.
8. Run the script.
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Appendix B. Troubleshooting problems

Troubleshooting is a systematic approach to solving a problem. The goal of
troubleshooting is to determine why something does not work as expected and

how to resolve the problem.

Review the following table to help you or customer support resolve a problem.

Table 50. Troubleshooting actions to prevent problems

Action

Description

Apply all known fix packs, service levels,
or program temporary fixes (PTF).

A product fix might be available to fix the
problem.

Ensure that the configuration is
supported.

Review the [software and hardware|

|1_"eg uirementé

Look up error message codes by selecting
the product from the [[BM Support Portal|
(http:/ /www.ibm.com/support/entry /
portal) and then typing the error message
code into the Search support box.

Error messages give important information to
help you identify the component that is
causing the problem.

Reproduce the problem to ensure that it
is not just a simple error.

If samples are available with the product, you
might try to reproduce the problem by using
the sample data.

Check the installation directory structure
and file permissions.

The installation location must contain the
appropriate file structure and the file
permissions.

For example, if the product requires write
access to log files, ensure that the directory has
the correct permission.

Review relevant documentation, such as
release notes, technotes, and proven
practices documentation.

Search the IBM knowledge bases to determine
whether your problem is known, has a
workaround, or if it is already resolved and
documented.

Review recent changes in your computing
environment.

Sometimes installing new software might cause
compatibility issues.

If you still need to resolve problems, you must collect diagnostic data. This data is
necessary for an IBM technical-support representative to effectively troubleshoot
and assist you in resolving the problem. You can also collect diagnostic data and

analyze it yourself.

Troubleshooting resources

Troubleshooting resources are sources of information that can help you resolve a

problem that you have with a product.

Many of the resource links provided can

also be viewed in a short video demonstration.

To view the video version, search for "troubleshooting" through either Google
search engine or YouTube video community.
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Support Portal

The IBM Support Portal is a unified, centralized view of all technical support tools
and information for all IBM systems, software, and services.

Use IBM Support Portal to access all the IBM support resources from one place.
You can adjust the pages to focus on the information and resources that you need
for problem prevention and faster problem resolution. Familiarize yourself with the
IBM Support Portal by viewing the (https:/ /www.ibm.com /blogs/
SPNA /entry/the_ibm_support_portal_videos).

Find the OpenPages GRC Platform content that you need by selecting your
products from the [BM Support Portal| (http:/ /www.ibm.com/support/entry/
portal).

Service requests

Service requests are also known as Problem Management Records (PMRs). Several
methods exist to submit diagnostic information to IBM Software Technical Support.

To open a service request, or to exchange information with technical support, view
fthe IBM Software Support Exchanging information with Technical Support page|
(http:/ /www.ibm.com/software/support/exchangeinfo.html). Service requests can
also be submitted directly by using fthe Service requests (PMRs) tooll

(http:/ /www.ibm.com/support/entry/portal /Open_service_request) or one of the
other supported methods that are detailed on the exchanging information page.

OpenPages Customer Center

The IBM OpenPages Customer Center provides specific information, updates, and
troubleshooting resources for IBM OpenPages GRC Platform.

To view OpenPages troubleshooting information, access the [(OpenPages Customer|
(http:/ /www.ibm.com/software/analytics/openpages/customercenter).

Fix Central

Fix Central provides fixes and updates for your system software, hardware, and
operating system.

Use the pull-down menu to go to your product fixes on [Fix Centrall
(http://www.ibm.com/support/fixcentral). You might also want to view [Getting|
started with Fix Central| (http:/ /www.ibm.com/systems/support/fixes/en/
fixcentral/help/ getstarted.html).

Knowledge bases

You can often find solutions to problems by searching IBM knowledge bases. You
can optimize your results by using available resources, support tools, and search
methods

You can find useful information by searching the information center for IBM
Cognos, but sometimes you must look beyond the information center to resolve
problems.

IBM Support Portal

The portal provides tools and information for all IBM systems, software,
and services. The IBM Support Portal provides you with access to the IBM

156 1BM OpenPages GRC Platform Version 6.2.1: Deploying to WebSphere Application Server Installation Guide


https://www.ibm.com/blogs/SPNA/entry/the_ibm_support_portal_videos
http://www.ibm.com/support/entry/portal/
http://www.ibm.com/software/support/exchangeinfo.html
http://www.ibm.com/support/entry/portal/Open_service_request
http://www.ibm.com/software/analytics/openpages/customercenter/
http://www.ibm.com/software/analytics/openpages/customercenter/
http://www.ibm.com/support/fixcentral/
http://www.ibm.com/systems/support/fixes/en/fixcentral/help/getstarted.html
http://www.ibm.com/systems/support/fixes/en/fixcentral/help/getstarted.html

electronic support portfolio from one place. You can customize the pages to
focus on the information and resources that you need for problem
prevention and faster problem resolution.

Find the OpenPages GRC Platform content that you need by selecting your
products from the [[BM Support Portall (http:/ /www.ibm.com/support/
entry/portal).

From the IBM Support Portal, you can search technotes and APARs
(problem reports).

IBM masthead search

Use the IBM masthead search by typing your search string into the Search
field at the top of any ibm.com page.

External search engines

Search for content by using any external search engine, such as Google,
Yahoo, or Bing. If you use an external search engine, your results are more
likely to include information that is outside the ibm.com® domain.
However, sometimes you can find useful problem-solving information
about IBM products in newsgroups, forums, and blogs that are not on
ibm.com.

Tip: Include “IBM” and the name of the product in your search if you are
looking for information about an IBM product.

Log files

Use the log files to help troubleshoot problems that occur during the installation.

You can review the log files for the current session individually or you can collect
them to review later.

Session directory

Logs that relate to the OpenPages application installation are created in the
path\opadminconsole\workspace\.metadata\.plugins\
com. ibm.openpages.config.install.ui\sessions directory.

The sessions directory might contain multiple log folders, each one starting with
ssn followed by a series of numbers. The bigger the number, the more recent the
session. You can use the modified date on the folder to identify the most recent log
files.

Silent installations

For silent installations, the log file is in the path\opadminconsole\silent_install
directory.

The log file name corresponds to the script name appended to _log. For example,
if you run the was_win_ora_deploy_server.cmd script, the log file is named
was_win_ora_deploy server Tog.

Log files exported from the user interface

If you encounter a problem that you cannot resolve immediately, you can click
Export in the Log view to preserve the information. The current property settings,
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the default settings, and a log file that contains deployment actions and results are
exported to a compressed file. The compressed file contains information that is
needed to troubleshoot installation issues.

Order of starting and stopping services

To restart the servers in an IBM OpenPages GRC Platform environment, you must
stop and start them in sequence. Restarting the servers in order ensures that the
OpenPages application server and IBM Cognos Business Intelligence can connect to
the database server.

Use the following sequence to stop the servers:

1. Stop the services on the Cognos BI reporting server.

2. Stop the services on the OpenPages application server.
3. Stop the services on the database server

Use the following sequence to start the servers:

1. Start the services on the database server.

2. Start the services on the OpenPages application server.
3. Start the services on the Cognos reporting server.

Reusing property settings for similar deployments

Use a saved or exported property file as a template for similar installations. You
can import the saved property file to the current installation, or use the exported
file as response file for a silent installation.

Procedure

1. Save the property settings from another, similar installation to a property file
by using one of the following options:

* Export the property file to the file system.
* Copy the properties and then save them to a file.

2. Import the property settings in the saved file to the current installation
deployment option, or use the saved file as input for a silent installation.

Related tasks:
[“Editing properties files to use as response files for silent installations” on page 149

Use the IBM OpenPages GRC Platform Administrative Console interface to set or
change the properties for your selected deployment option.

Manually creating the reporting tablespace and user for Oracle
databases

After you create the Cognos content store, you can manually create the content
store user and the content store tablespace.

This user must be able to create, alter, and drop tables, triggers, views, procedures,
and sequences, and have the CONNECT and RESOURCE roles.

Procedure

1. Log on to the reporting server as a user with administrative privileges.
Note: For Linux operating systems, log in as a non-root user.
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2. From the IBM OpenPages GRC Platform Installer version for WebSphere
Application Server or your network share location, copy the
OP_version_Configuration\Database\ORACLE\COGNOS directory to the local
system.

3. Log on to SQL*Plus by using the following command:
sqlplus system/system_password@oracle_tns_alias
To create the tablespace in the OpenPages database instance, enter the
oracle_tns_alias of the OpenPages database. oracle_tns_alias is the database alias
for the OpenPages database instance, as set during the Oracle database
installation. If necessary, you can retrieve this alias from the tnsnames.ora file.

If you created a separate database instance for the content store, create the
tablespace in the content store database instance. Enter the oracle_tns_alias of
the content store database.

4. At the SQL prompt, type the following command:

@cognosdbcreate.sql cognos_user cognos_password oracle_data_home
tablespace_name log_file

Table 51. Parameter descriptions for cognosdbcreate.sql script for Oracle databases

Script parameters Description

cognos_user Specifies the new user name for the content store database
cognos_password Specifies the password for the cognos_user

oracle_data_home Specifies the location of the Oracle data home directory for the

content store database instance.
On Windows operating systems: C:\ORACLE_BASE\oradata\SID

On AIX operating systems: ORACLE_BASE/oradata/SID

tablespace_name Specifies the name of the exported tablespace.

log_file Specifies the file name and location of the log file to create.

Installation issues and solutions

Error messages and log files provide you with information about errors that occur
during the installation process. Use the error messages and log files to determine
which part of the process failed.

Review common problem scenarios, recovery methods, and ways to get help if you
encounter a problem during software installation. You can diagnose problems
when the installation and configuration is unsuccessful.

SQLO0569N Authorization ID "user_name" does not uniquely
identify a user, a group or a role in the system error

The OpenPages Administrative Console might indicate the installation is
successful. However, you might see a message similar to the following text in the
session.log file:

SQLO569N Authorization ID "user_name" does not uniquely identify a user,
a group or a role in the system error

Ensure that on Linux and AIX operating systems, the user name for the OpenPages

or workflow database user account is not the same as the group name. For
example, opuser:opuser is not allowed.
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Tip: When you deploy OpenPages applications to WebSphere, ensure that you
review the session.log file for errors. After the installation is complete, you can
export the log files from the Log view in the OpenPages Administrative Console
interface. You can also view the log files related to the OpenPages application
installations in the path\opadminconsole\workspace\.metadata\.plugins\
com.ibm.openpages.config.install.ui\sessions directory.

OpenPages and software that is installed in a directory that
contains spaces

If you installed software that OpenPages uses into a directory with spaces, you
must use the Windows short file name convention for the home directory location.

For example, in the OpenPages Administrative Console, when you configure the
home directory for the WebSphere Application Server Home Directory, instead of
entering the C:\Program Files\IBM\WebSphere\AppServer directory, enter
C:\PROGRA™~1\1BM\WebSphere\AppServer.

Note: You cannot browse to an installation location that contains spaces.

Garbled characters are displayed on the OpenPages home
page when you log in for the first time

You might see garbled characters on the OpenPages home page
(http://server_name:port/openpages) if the DB2 database does not have sufficient
memory.

The following SQL errors are in the OP_Home\aurora\log files or the
OP_Home\bin\1ogs\ObjectManager.log file:

com.ibm.db2.jcc.am.SqlException: DB2 SQL Error:
SQLCODE=-20442, SQLSTATE=57011, SQLERRMC=null, DRIVER=3.64.104

To resolve the problem, increase the memory that is available to DB2 database by
running the following commands, one by one, as the database instance owner:
db2 connect to <database name> user <DBZ_instance_owner> using <password>

db2 update db cfg for <database_name> using APPLHEAPSZ 512 APPL_MEMORY 80000

db2 terminate
db2start

Reload the configuration data. For more information, see [“Manually loading the]
fconfiguration data after a new installation” on page 161 |

If the problem still exists, keep doubling the sizes for the APPLHEAPSZ and
APPL_MEMORY settings, up to 2048,000 or acquire more memory (RAM).

Example: APPLHEAPSZ 1024 APPL_MEMORY 160000

db2 connect to <database name> user <DBZ_instance_owner> using <password>

db2 update db cfg for <database_name> using APPLHEAPSZ 1024 APPL_MEMORY 160000
db2 terminate

db2start

Example: APPLHEAPSZ 2048 APPL_MEMORY 320000

db2 connect to <database_name> user <DBZ_instance_owner> using <password>

db2 update db cfg for <database_name> using APPLHEAPSZ 2048 APPL_MEMORY 320000
db2 terminate

db2start
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Manually loading the configuration data after a new
installation

The installation program for OpenPages GRC Platform automatically loads the
OpenPages GRC Platform data and enables user access to the standard Cognos
Business Intelligence reports. In limited situations, you can manually load the
level-0 schema.

Before you begin
OpenPages GRC Platform must be installed.

The OpenPages and workflow (IBPM) services must be running.
About this task

When you install the OpenPages application, On the Storage and Configuration
Information page, you are prompted to choose whether to load configuration data.

If you select No, and the default configuration is not already loaded, you must
manually load the level-0 schema and the CommandCenter data.

Procedure

To manually load the level-0 schema, use the following steps:
1. Log on to the OpenPages admin server as a user with administrative privileges.
2. Go to the OP_HOME/addon_module/loaderdata directory.
3. Make a backup copy of the following script file:
* For Windows installations, back up the schema_loader_properties.bat file.

¢ For AIX or Linux installations, back up the schema_loader_properties.sh
file.

4. Open the original schema_loader_properties file in a text editor.

5. In the following line, update the password for the OpenPages application Super
Administrator.

¢ For Windows installations:

SET OPXUserName=Super_Administrator_user_name
SET OPXUserPassword=#xx%ssx*

e For AIX or Linux installations:

OPXUserName=Super_Administrator_user_name
OPXUserPassword=+x*#xx*

The default user name is OpenPagesAdministrator.

The password for the OPXUserName user is masked by asterisks (***). Replace the
mask with clear text. After the default configuration data is loaded, you can
manually mask the password value with asterisks (***).

6. Save and close the file.

7. To load the default OpenPages GRC Platform configuration, run the following
script:

* For Windows installations, run the openpages-level0-loader-data.bat file.

Tip: Redirect the output to a log file so that you can conveniently track the
progress:

openpages-level0-Toader-data.bat > openpages-levelO-loader-data.log
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* For AIX or Linux installations, run the openpages-level0-loader-data.sh

file.

Tip: Redirect the output to a log file so that you can conveniently track the
progress:

./openpages-Tlevel0-loader-data.sh > openpages-level@-loader-data.log

The script takes awhile to finish loading the data. For example, the data might
take two hours to load.

8. Restart the OpenPages services.

Dropping the DB2 database for the OpenPages repository

In development environments, if you encounter problems when you try to create
the database objects for the OpenPages repository, you can run clean up scripts.
Use the scripts to drop the database and uncatalog the node.

Note: In most situations, uncataloging the node is unnecessary.

Procedure

1. Log on to the OpenPages application server.

2. Go to the location where you extracted the installation files.

¢ On Windows operating systems, go the following directory:

\WIN64-0P_version\OpenPages\Win64\
OP_version_Non_Embedded WAS_Oracle_DB2_WIN64\OP_version_Configuration\
Database\DB2\INSTALL_SCRIPTS

* On AIX operating systems, go the following directory:

/AIX64-0P_version/OpenPages/AIX64/0P_version Non_ Embedded DB2 AIX64/
OP_version _Configuration/Database/DB2/INSTALL SCRIPTS

* For Linux operating systems, go to the following directory:

\Linux64-0Pversion/OpenPages/Linux64/0P_version Non Embedded LINUX64/
OP_version_Configuration/Database/DB2/INSTALL_SCRIPTS

3. On Windows operating systems, start the DB2 command line processor by
typing db2cmd.

4. To drop the database, run the drop-opx-db-c1t script.

* On Windows operating systems, type the following command:

drop-opx-db-clt.bat <database-name>
<node-name> <instance.owner.username>
<instance.owner.password>

* In AIX or Linux operating systems, type the following command:

drop-opx-db-c1t.sh <database-name>
<node-name> <instance.owner.username>
<instance.owner.password>

Table 52. . Scripts to drop the database and to uncatalog the node.

Description

Script

Drop the
database

drop-opx-db-clt. (bat |sh) <database-name>
<node-name> <instance.owner.username>
<instance.owner.password>

Uncatalog
the node

db2-uncatalog-node. (bat|sh)
<node-name>
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Updating the services for multiple DB2 instances

DB2 database instances must be able to communicate through the network. If you
have multiple DB2 instances on the same computer, ensure that the SVCENAME
and listener port are configured. Otherwise, connection errors might occur.

To verify that the DB2 database instances are configured for network
communication:

* DB2SET must show TCPIP for the DB2COMM setting.

¢ The SVCENAME in the DBM configuration must show a valid TCP service
name and TCP port number.

If you changed either the DB2 registry (DBSET) or the Database Manager
configuration, ensure that you stop and restart DB2.

Procedure
1. Log on to the database server as the DB2 instance owner.

2. To reserve a TCP port for the service, append the information to the services
file.

On Windows, edit the %systemroot%\system32\drivers\etc\services file
On AIX or Linux, edit the /etc/services file.
To reserve TCP port 5500 for the service named db2c_opdb, append the
following line to the end of the services file:
db2c_opdb 5500/tcp

3. Update the database manager configuration.
db2 update database manager configuration using svcename 55000

4. Ensure that TCP communication is set for the database instance.

db2cmd -i -w

db2set DB2COMM=npipe,tcpip
db2stop

db2start

5. Stop and then restart the DB2 server.

db2stop
db2start

OP-03620: The Reporting Schema has not been instantiated

error

If you log on to the OpenPages home page, http://server_name:7009/openpages,
and have not created the reporting schema, an error message is displayed.

The default OpenPages application port is 7009.

A message similar to the following error message is displayed:

The Home Page cannot be viewed without a valid Reporting Schema.
Please contact your System Administrator. OP-03620:

The Reporting Schema has not been instantiated. Please instantiate it
before executing this operation.

To resolve the problem, disable System Admin Mode, and generate the reporting
schema.
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Procedure

1. In a web browser, open the OpenPages application:
http://openpages _server:port/openpages
Log on to the OpenPages application as a user with administrative privileges.
For System Admin Mode, switch from Disabled to Enabled.
From the menu bar, click Administration and select Reporting Schema.
Click Create.

After the create operation finishes, click System Admin Mode to switch from
Enabled to Disabled.

7. From the menu bar, click Administration > Reporting Framework >
Generation.

8. On the Reporting Framework Operations page, click Update.

9. In the Reporting Framework Generation window, under Framework
Generation, select the Framework Model and Labels and other options you
want for the relational data model.

10. Click Submit.
11. To view the progress of the update, click Refresh.

The Percent Complete column on the Reporting Framework Operations table
updates the percentage of completion.

ook~

“File path too long" error or other errors when extracting

installation files

When you extract compressed files from the installation media, you might see a
Error 0x80010135: File path too Tong error.

The error is caused when you use Windows Explorer or WinZip to extract files and
it encounters a file path that exceeds the maximum character limit.

To resolve this problem, use a decompression utility such as 7-Zip, that can handle
long file paths. Otherwise, extract the files to the root directory or to the c:/temp
directory.

Error updating password encryption module during the

installation

If a password encryption module error is displayed in the IBM OpenPages GRC
Platform Administrative Console after installation, update the password manually.

If the installation program encounters an encryption password algorithm error, the
following message is displayed in the user interface:
Error updating password encryption algorithm.

Please update the password encryption algorithm manually
after the installation.

For more information about manually configuring the password encryption

algorithm in the Update Password Encryption Algorithm (UPEA) tool, see the IBM
OpenPages GRC Platform Administrator’s Guide.
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Uninstalling OpenPages with an Oracle database before you

reinstall

In test or development environments, you might be required to uninstall
OpenPages GRC Platform or remove the OpenPages database in Oracle database
server before you reinstall. You must completely uninstall before you reinstall.

Procedure

1.

Log on a computer that has SQL*Plus as a user, such as SYSTEM, who has
database administration permissions.

Run the following SQL statements:

drop user <workflow_user> CASCADE;
drop user <openpages_user> CASCADE;
drop user <cognos_user> CASCADE;

Note: Drop the cognos_user if the OpenPages database and the Cognos content
store schemas are in the same Oracle database. If you use a separate database
for the Cognos content store, dropping the cognos_user is not required.

Run the following SQL statements to drop the default tablespaces and data
files:

drop tablespace AURORA including contents and datafiles;

drop tablespace INDX including contents and datafiles;

drop tablespace AURORA SNP including contents and datafiles;

drop tablespace AURORA_TEMP including contents and datafiles;

drop tablespace AURORA_NL including contents and datafiles;

drop tablespace AURORA_NLI including contents and datafiles;

drop tablespace AURORA_CLOB_DATA including contents and datafiles;
drop tablespace AURORA DOMAIN_INDX including contents and datafiles;
drop tablespace IFLOWDB including contents and datafiles;

drop tablespace IFLOWTEMPDB including contents and datafiles;

drop tablespace COGNOS including contents and datafiles;

Run the following script to drop the Oracle data pump storage directory.
drop directory <OP_DATAPUMP_DIRECTORY>;
Uninstall IBM OpenPages GRC Platform.

 For Windows operating systems, see [“Uninstalling OpenPages GR(|
[Platform on Windows computers” on page 145.|

« For Linux operating systems, see|”Uninstalling OpenPages GRC Platform|
fon Linux or AIX computers” on page 146

If required, remove environment variables that reference OpenPages GRC
Platform, or Cognos BI, or both products.

Restart the servers.
Remove existing OpenPages application or Cognos BI installation directories.

The following table lists examples of the installation directories for OpenPages
and Cognos BI components

Table 53. Example directory locations for OpenPages and Cognos Bl components

Location on Windows Location on Linux operating
Installation directory operating system system
OpenPages C:\OpenPages /opt/OpenPages
(OP_HOME)
Fujitsu Interstage BPM C:\Fujitsu\InterstageBPM /opt/Fujitsu/InterstageBPM
(Workf1ow_HOME)
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Table 53. Example directory locations for OpenPages and Cognos Bl

components (continued)

Installation directory

Location on Windows
operating system

Location on Linux operating
system

(Cognos_HOME)

CommandCenter C:\OpenPages\CommandCenter |/opt/OpenPages/
CommandCenter

(CC_HOME)

Cognos BI C:\IBM\cognos\c10_64 /opt/IBM/cognos/c10_64

9. Review the TEMP or TMP directories for temporary installation files that might

exist.

The location of temporary directories varies. The location depends on the
environmental variables that are set during the installation process.

For Windows operating systems, common temporary directory locations

include
e C:\temp

* C:\Users\<user_name>\AppData\Local\Temp
For Linux operating system, a common temporary file location is /tmp.

10. On Linux computers, remove any related remaining files and directories in the
home directory of the user who installed or uninstalled OpenPages.

Remove the .com.zerog.registry.xml file.
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service. This document may
describe products, services, or features that are not included in the Program or
license entitlement that you have purchased.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation

North Castle Drive
Armonk, NY 10504-1785
US.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing

Legal and Intellectual Property Law
IBM Japan Ltd.

19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

167



IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Location Code FTO

550 King Street
Littleton, MA 01460-1250
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only. This
information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.
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Copyright

Licensed Materials - Property of IBM Corporation.
© Copyright IBM Corporation, 2012, 2013.

US Government Users Restricted Rights — Use, duplication or disclosure restricted
by GSA ADP Schedule Contract with IBM Corp.

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written.

These examples have not been thoroughly tested under all conditions. IBM,
therefore, cannot guarantee or imply reliability, serviceability, or function of these
programs. You may copy, modify, and distribute these sample programs in any
form without payment to IBM for the purposes of developing, using, marketing, or
distributing application programs conforming to IBM's application programming
interfaces.

Trademarks

IBM, the IBM logo and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.

The following terms are trademarks or registered trademarks of other companies:

* Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

* Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

* UNIX is a registered trademark of The Open Group in the United States and
other countries.

* Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

A current list of IBM trademarks is available on the Web at “ |Co

Other product and service names might be trademarks of IBM or other companies.
E Eiright and|
ltrademark information|” at www.ibm.com/legal/copytrade.shtml.
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